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 W
elcome to Sports & Action Photography Made 
Easy, a bumper 228-page guide to taking better 
shots of anything that moves! From athletics to 
airshows, football to Formula 1, surfing to steam 

trains, taking great shots of speedy subjects presents the 
photographer with host of new challenges – you’ve really got 
to keep focused (quite literally) to get great action shots, as 
you’ll rarely get a second chance. So we’re here to make sure 
you don’t miss those not-to-be-missed photo opportunities! 

We kick off with the basics; lessons on the techniques you’ll 
need to employ to capture the action as it unfolds. You’ll learn 

the best focusing methods for pin-sharp 
shots, optimum shutter speeds to best 

capture a variety of sports, and when 
it’s best to freeze the action or 
deliberately blur it to convey the 
best sense of motion.

Next, join our Apprentice 
photographers as they get shown 

the ropes by seasoned pros – you’ll 
be amazed at the methods that 

different sports demand to best 
capture the action. 

Our Masterclass section challenges you 
with practical projects to capture a series of sporting scenes, 
from setting up the shots to post-processing. And we have 
a series of Photoshop tutorials to eke the very best out of 
each and every image once back home.

Finally, we test top kit for sports photography, from 
rapid-fire D-SLRs to telephoto lenses and monopods. 

If you enjoy this, check out our online bookstore at: 
www.myfavouritemagazines.co.uk/photography 

Bonus 
Many of our tutorials include videos  

that give you more detail on the  

techniques described, plus start images  

so you can follow each technique step by  

step. Download your bonus videos  

and images via  

www.bit.ly/dc180bonus
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Light, 
camera, 
action!
Summer is a great time to hone your sports and action 
photography skills – techniques that will also come in useful 
with kids, pets, and even gigs and other live events. So read 
on and get more from your digital camera!

8  Sports & Action Photography Made Easy
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T
aking photographs of static 
subjects is all well and good, but if 
you want to give your digital  
camera a proper challenge, try 

pointing it at something that’s moving. 
With a shifting target, you can really start 
to see the advantage of a digital SLR over 
a point-and-shoot compact.

Your digital SLR not only offers the 
necessary processing power to allow it to 
react and record fast-moving subjects, it 
also offers a wide range of quick access 
controls that enable you to turn any high-
octane action into a perfect still picture.

So over the following pages we’ll answer 
all your questions, showing you the core 

skills and tricks you need to keep up with 
the action – from which shutter speeds 
you should use, and when, to flash-fuelled 
effects that will really make your sports 
pictures stand out.

With the London Olympic Games soon 
to start and the Euro 2012 football 
championships on its way, too, now is the 
perfect time to sharpen up your sports 
shooting photography skills. 

And don’t panic if sport is not your bag, 
because the action techniques you’ll 
learn on the following pages can be just 
as useful for shooting all sorts of other 
subjects – everything from wild birds and 
classical musicians to funfairs.  

Sports & Action Photography Made Easy  9
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How do I choose the 
right shutter speed?
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W hen it comes to action shots, there are 
two approaches you can take. You can 
either try to freeze the moving subject 

in the frame so that it is as sharp as possible, 
or you can get it to look nicely blurred to create 
a strong sense of movement. With such 
contradictory approaches, it might seem 
that it doesn’t matter what shutter speed 
you use – because if the shot is not frozen 
sharply, it will by definition be blurred.

But setting the shutter speed is not that 
simple. With action photography, getting 
your pictures almost sharp just won’t do. If 
the shot is just a bit blurred it looks like a 
mistake. For these reasons, whether you want 
super-sharp or artistically blurred images you 
need to choose your shutter speeds carefully.

FasT or sLoW?
a question of athletic ability

sometimes it’s a creative choice, but often 
you choose slow shutter speeds through 
necessity. A blurred effect is a tempting 

option in low light conditions, when fast shutter 
speeds are hard to achieve.  

But the approach can also vary with the subject. In 
the shots of marathon runners below, a fast speed 
works well with the top athletes striding out at the 
head of the pack, while the slow approach proves 
more suitable for the slower-paced charity runners.

1/180 sec

1/6 sec

Do you really need to freeze the action? 
Or do you want a blurred effect? 1/6 sec, Iso100

1/80 sec, Iso1600

By going for a slower 
shutter speed, you can 
capture a real sense of 
movement in live shots

SLR skills
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sHuTTer speeds To Freeze THe acTIon
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What shutter speed do you 
need to get sharp shots?

Y ou might think that the shutter speed you need 
to freeze a moving subject would depend on how 
fast the subject is moving. But this is only one of 

the considerations. In fact, you will often need a faster 
shutter speed to capture a person running at 8mph 
than a plane travelling at 800mph. This is because it’s 
how fast the subject is moving across your camera’s 
viewfinder (and EOS sensor) that actually counts.

Therefore, the shutter speed needed to freeze action 
depends on four different factors: the focal length of 
the lens you are using – because the bigger it is in the 
frame, the more noticeable any movement becomes in 
the image; the subject’s distance – because this also 
affects how large the subject will appear within the 
frame; the subject’s actual speed; and the direction in 
which the subject is moving in relation to your camera. 

You are more likely to get away with using a slower 
shutter speed if a car is coming towards you than if it’s 
moving across the frame. In fact, you need a shutter 
speed that’s roughly four times as fast to freeze the 
action if the subject is moving horizontally across your 
field of vision, rather than travelling towards you or away 
from you. Subjects following a diagonal path across the 
frame need a shutter speed somewhere in between.

Use the table below to get an idea of the sorts of 
shutter speeds you’ll need to shoot a range of subjects. 
If in doubt, always use a shutter speed faster than you 
think you need. That way, you can always be sure 
that you’ll capture a super-sharp shot.

How slow do you go for blur?

W ith action subjects photographed in daylight, 
there’s always a range of shutter speeds that 
you can use to get creatively blurred shots. 

However, the range of speeds is limited. There needs 
to be enough blur to ensure that your creative effect 
doesn’t look like a mistake – and it can’t be too blurred, 
otherwise your subject will be unrecognisable.

As a rough rule, use a shutter speed that’s around 16 
times longer than the one you would use to capture the 
subject sharply. So, for a shot of a sprinter, you would 
use a shutter speed of 1/60 sec if you wanted a blurred 
shot – if you would have used a setting of 1/1000 sec to 
capture it sharply. Similarly, if you would need 1/125 sec 
to freeze the action, try a speed of 1/8 sec for blur. As 
is often the case, the exact amount of blur you use is a 
matter of taste. As results can be unpredictable, shoot 
lots of frames so you have plenty to choose from.

Back to basics

1Select the Aperture Priority 
option on your camera. 

2Lightly press the shutter 
release, so that the exposure 

settings appear in the viewfinder.

4Rotate the wheel behind the 
shutter button and the 

shutter speed (and aperture) will 
change one setting at a time. 
Rotate the wheel until you get 
the speed that you want.

5 If you can’t get a fast enough 
shutter speed, increase the 

ISO. Press the ISO button and 
rotate the front or rear dial 
(depending on the SLR you are 
using). Now repeat steps 3-5.  

There are many ways to set the 

speed, but here’s a good all-round 

option for daylight shots

How do you set  
the shutter speed?

  Exposure: f/2.8 at 1/640 
sec, ISO 200 Lens: Sigma 
70-200mm f/2.8

 exposure: 1/15 sec at f/8, 

Iso400 Lens: 140-560mm 

exposure: 1/1600 sec at f/5.6, Iso800 

Lens: 120-300mm f/2.8

sHarp suBjecT

creaTIve BLur

subject speed distance effective direction of movement 
    focal length across frame Towards camera diagonal
Runner 12mph 10m 200mm 1/1500 sec 1/350 sec 1/750 sec
Runner 12mph 20m 300mm 1/1000 sec 1/250 sec 1/500 sec  

Motorbike 50mph 30m 100mm 1/1000 sec 1/250 sec 1/500 sec
Motorbike 100mph 30m 100mm 1/2000 sec 1/500 sec 1/1000 sec
   
Aeroplane 500mph 2,000m 400mm 1/500 sec 1/125 sec 1/250 sec
Aeroplane 500mph 1,000m 400mm 1/1000 sec 1/250 sec 1/500 sec

3Look at the shutter speed in 
the viewfinder (it should be 

the number on the left). If it says 
250, it means that it is using a 
speed of 1/250 sec.
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How do I get 
my shots in 
sharp focus?
How to set the right autofocus mode for action

do I need THe moTordrIve To sHooT sporT?

However fast your reactions, there’s always a delay 
between firing the shutter on your digital camera 
and the picture actually being taken. That fraction 

of a second of delay is necessary to allow the viewing 
mirror to flip up and the shutter curtains to open.

This delay is so short that it’s not important when 
shooting many photographic subjects. However, it can be 
crucial when trying to capture fast-moving subjects. 

The trouble is that the subject will have moved in the 
interim – and this can play havoc with the autofocus – a 
picture that seemed sharp at the moment you took it is now 
out of focus. Fortunately, the vast majority of digital SLRs 
have a special focus mode that gets round this. 

In the case of the Canon we used here, the usual focus 
mode is called One Shot, which locks focus as soon as the 
camera thinks that the subject is sharp. 

When switching to the AI Servo mode, the camera 

constantly adjusts focus to keep up with the movement. 
Note that you can also use the AI Focus mode, which swaps 
automatically between the two focus modes by detecting 
whether the subject is moving or not).

With AI Servo mode (and AI Focus) the focusing also  
goes into predictive mode – calculating where the subject 
would have moved to in the split-second delay as the mirror 
rises and the shutter actually opens. It’s not magic – it  
really does work!

This focus mode usually performs at its best if you’re 
using all of your camera’s autofocus points. 

With multiple autofocus points in use, you have more 
chance of getting a sharp image, even if the subject 
moves through your frame.

The sequence below was shot at 5fps (frames per 
second) on a canon 30d set to aI servo autofocus

Ch
ris

 G
eo

rg
e 

&
 P

et
er

 T
ra

ve
rs

To guarantee success, try switching 

your sLr’s drive mode to a continuous 

setting. Your digital sLr can typically 

shoot a motordrive sequence at a rate 

of at least 3fps. 

most sports pros use this setting, 

because a choice of slightly different 

compositions can help to capture a 

better expression on an athlete’s face, 

or to snatch a dramatic moment.

But you can still miss the moment 

when shooting a rapid-fire sequence. If 

you use a shutter speed of 1/1000 sec, 

even with a top-speed 10fps burst 

mode, you’ll only be capturing 1% of 

what is actually happening – 99% of 

the action is unseen by the camera!

The other disadvantage is that most 

digital sLr cameras can only shoot in 

its top continuous mode for a limited 

number of shots. Beyond this, the 

camera literally stops and catches up 

with processing and writing the shots 

to the memory card. 

This buffer limit is reached sooner if 

you shoot in a raw format, so most 

photographers wanting to make use of 

a continuous drive mode will switch to 

using jpeGs instead. Typically, you 

could then shoot at 3fps for a full 9 

seconds (rather than just three 

seconds if you shoot in raw).

If you want to know how many shots 

you have left before the buffer memory 

fills up, just look at the number on the 

bottom right of the viewfinder. This 

tells you how many shots you have left 

before the camera needs to stop

However, when using a digital sLr’s 

motordrive there’s a danger that your 

camera will stop shooting just as the 

real action begins – so always use this 

facility with caution. You may not get a 

second chance to correct the problem, 

so get it right first time!
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How do I get 
my shots in 
sharp focus?

CriCket	 400mm
MotoCross	 100mm
rugby	 300mm
showjuMping	 200mm
skateboarding	 35mm
football	 300mm
surfing	 500mm

For this indoor soccer shot, we cranked up the Iso to 

get a fast enough shutter speed to capture a sharp 

shot of the action, ensuring that the camera was 

focused on the footballer’s face

exposure: 1/1000 sec at f/2.8, Iso1000

Lens: 135mm f/2

preFocusInG expLaIned
When should I switch to manual focus?

Why should you 
keep both eyes open?

most photographers close the eye 
that isn’t looking through the 
viewfinder when they take a shot 

so they can concentrate on the composition 
and exposure information. However, try 
getting used to keeping both eyes open – 
particularly when shooting action.
 Your second eye is useful for seeing 
things outside the frame. This can help you 
get better pictures, because you may see 
a better sight or stronger drama from the 
corner of your eye. It can also save your life 
– giving you advance warning that a car is 
about to drive towards you!
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Back to basics

You don’t need a long lens with all 

sports – but with many, the longer 

the lens, the more impressive your 

action shots become. It all 

depends on how close you can 

get to the action without 

standing on the field of 

play, or endangering 

yourself. The lenses listed 

in the table below offer 

focal lengths that are 

most useful for various 

sports when using popular 

entry-level digital sLr 

cameras. Those using 

models aimed at the 

professional market with 

larger sensors are likely to 

need to pick slightly  

longer lenses.  

What lens do I 
need for sport?

exposure: 1/800 sec at f/5.6, Iso100

Lens: 70-300mm f/4-5.6

autofocus works well with 
action subjects when set 
to one of the focus modes 

for moving objects – but it’s not 
foolproof. It will be faster with some 
lenses than others – and can be 
fooled by foreground objects that 
you don’t actually want to focus on. 

Switching to manual focus  
is a great idea with some action 
subjects, because you can use a 
technique called ‘prefocusing’. 

In many sports, competitors 
follow a predictable path around 
a circuit so you can focus on a 

point along this path before the 
subject comes into view. Because 
it’s hard to check precise focusing 
by looking through the viewfinder, 
it’s helpful to zoom in as far as 
possible before focusing manually 
(then zoom out for the composition 
you require). For this shot of a 
show-jumper, it was possible to 
focus on the top bar of the fence, 
then shoot as the horse and rider 
appeared. The same focusing 
distance can be used for a number 
of competitors. This is useful 
with motorsports.



SLR skillsXxxxxxx

How slow should 
I go after dark?
How to select a shutter speed for perfect night shots

subject shutter speed aperture Iso setting
Aerial fireworks 20 sec f/11 100
Fairground rides 10 sec f/11 100
Traffic 30 sec f/22 100
Floodlit football 1/180 sec f/4 1600
Lightning strike Bulb f/11 100
Stage show 1/60 sec f/4 400
Rock gig 1/125 sec f/4 1600

nIGHT-TIme sHuTTer speeds

The longer the shutter speed, the 

more stable your camera must be. 

With exposures timed in seconds, 

you need to avoid touching your 

camera as the shutter fires. Here’s 

a low-cost way to perform this 

trick with a canon sLr...

1 You can simply rest your 
camera on a solid surface, but 

to give yourself a free choice of 
camera angle you should attach 
your model to a sturdy tripod.

2To minimise vibration, set the 
camera to lift up the mirror 

ahead of the shutter actually 
opening. To do this, go to the 
Custom Function menu options.

3Find the Mirror Lock-up option 
(the Custom Function number 

varies from model to model). Now 
press Set, scroll down to Enable,  
and then press Set again.

4Set the Drive Mode setting to 
the Self-timer option (the 

stopwatch icon). When you press 
the shutter, let go of the camera 
entirely. The exposure will be 
taken after a two-second delay.

N
ic

ol
as

 R
an

da
ll

W hen shooting at night, the long exposures that 
are forced upon you by the low light conditions 
can help to create dramatic action pictures 

from the most ordinary scenes. 
A town high street or view from a motorway  

overpass can be turned into a sea of colourful trails 
created by passing cars. 

Because it’s essential to use a tripod to keep the 
static parts of the scene completely steady, there’s no 
need to worry about keeping the shutter speed short. 
In fact, it’s often best to make the exposure as long 
as possible to create the longest light trails. You can 
do this by ensuring the ISO is set to 100 and using the 
narrowest aperture that your lens allows (typically around 

f/22). This creates the longest light trails. To minimise 
the vibration as you press the shutter button it is worth 
investing in a cable release (or the alternative remote 
control available for cameras such as a Canon 400D). If 
you don’t have either of these handy, use the alternative 
approach in the Back to basics panel (left).

Although it is usually possible to set the shutter speed 
you want using your camera’s Aperture Priority mode, it’s 
sometimes easier to get the shutter speed you want for 
a particular effect using the Shutter Priority mode. Again, 
you simply use the main input dial behind the shutter 
button and the viewfinder display to select the shutter 
speed you want. A rough guide to the exposures (and 
ISO settings) you need are outlined in the table below...

  Exposure: 1/15 sec at f/5.6, ISO800 

Lens: 24-70mm 

easy ways to get 
shake-free shots

Back to basics

SLR skills

specIaL eFFecTs
What speed do you 
need for zoom bursts?

What do you do if you can’t get a shutter 
speed that’s fast enough to capture 
a sharp picture? You can go for an 

artistically blurred image or pan the lens so the 
background is blurred, but the subject is sharper. 
Alternatively, you could try a zoom burst (see example, 
left). This creates radial blur lines from the centre of 
the image outwards – a visual explosion that gives a 
feeling of movement to static subjects. You can add 
this effect using Photoshop, but it’s a fun trick to try 
as you actually shoot, and works well in low light or on 
dull days. For best results, set the shutter speed to 
between 1/8 and 1/30 sec. Start zooming the lens 
out from telephoto to wide-angle, and then press 
the shutter, so the focal length of the lens changes 
during the actual exposure. You can use a tripod for 
straighter radial lines, but you can get great results 
shooting handheld, too.

14  Sports & Action Photography Made Easy
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How slow should 
I go after dark?
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sHooTInG LIve perFormances
Getting set up for low-light gigs

 exposure: 1/30 sec at f/4, 
Iso800 Lens: 28-135mm 

f/3.5-5.6
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many sports and activities push digital photography 
to the limits simply because they take place in 
low light. While a blurred approach works well 

on occasion, such artistic images have a limited use. A 
blurred shot of an Olympic gymnast may look good in a 
gallery, but is less useful for the back pages of newspaper. 

To avoid this problem with indoor and night-time events 
– such as gigs where flash is prohibited – professional 
photographers use lenses with the widest apertures they 
can get hold of. A telephoto lens with an f/2.8 aperture 
option will let in four times more light than one with a 
widest aperture of f/5.6. 

But the first and most important thing to do in such 
situations is to ramp up the ISO. Over recent years, the low-
light performance of D-SLRs has improved considerably, 
with ISO settings of 6400 and above now commonplace. 
Don’t be afraid to use a high-ISO setting if it allows you to 
get the shutter speed necessary for a sharp shot of the 
musician, dancer or sportsman. Yes, these settings will 
create a noisier image, but a bit of 
grain is a small sacrifice in order 
to avoid getting a shot that fails 
because it’s blurred all over. 

specIaL eFFecTs
What speed do you 
need for zoom bursts?



When should I switch 
on the flash?

Use the strobe to shoot sports the wide-angle way

With most sports you’re too far away 
from the action for flash to be 
effective, so leave it switched off. But 

there are occasions when flash is a powerful 
tool for capturing a moving subject crisply. 

For shots of skateboarding, cycle races, 
or any other sport where you can safely 

shoot within three metres of the action, 
flash will fill shadows, brighten colours 

and freeze the action. 
Flash has a duration as 

short as 1/40000 sec in 
full auto mode at 

short subject 
distances, 

with a maximum burst length of around 1/850 sec (on 
full manual power). The maximum shutter speed you 
can use with a built-in or hotshoe flash is approximately 
1/200 sec, but if the flash is the main light source, the 
flash duration is the effective shutter speed.

If the ambient light and flash are lighting the subject 
significantly, the ambient light can create a ghost image 
around the subject, giving the shot a strong action feel.

Results are often good with the flash set to Through 
The Lens (TTL) mode and the SLR on Aperture Priority, to 
balance exposure for the foreground and background. 

Then use Exposure Compensation to lighten or  
darken the background (if necessary) and use flash 
Exposure Compensation to darken or lighten the 
flash-lit foreground.

normaL

second  
curTaIn sYnc

When should I use 
second curtain sync?

Your flash normally fires at the start of the 
exposure – as soon as the shutter is fully 
open. But with moving subjects, this can 

mean that the ghost image created by 
the ambient light looks odd – a blurred 
image of a cyclist can appear in front 
of a sharp flash-illuminated shot of 
his bike. It can almost seem as if the 
cyclist is going backwards!

To use this ‘ghost’ to give a better 
idea of the direction of movement of 
your subject, switch to second curtain 
sync and the flash will fire when the 
second of the two shutter curtains is about 
to close (and end the exposure).

Turn second curtain sync on using your SLR’s 
customisable functions mode or using the 
hotshoe flash controls. Second curtain flash 

works best if the movement follows an obvious path, 
such as a runner – it’s less useful with dancers 
or playing children, where they may be moving 
forwards or backwards – and the shutter 
speed is not too long. With first curtain 

flash, the strobe fires practically as 
you press the shutter. With 

second curtain, the flash 
fires later. With longer 
shutter speeds it is hard 
to predict what the subject 
will look like when the flash 
goes off (and the subject 

may have even disappeared). 
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exposure: 1/250 sec at f/13, 
Iso200 plus flashgun 
Lens: 17-40mm f/4
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W
hen it comes to outdoor photography, ‘If it 
moves, shoot it!’ is a great motto to follow. 
With a packed sporting calendar now taking 
place all-year round, we’ll teach you all the 

shooting skills you need to know to improve your action 
photography over the following 10 pages. 

We start off by explaining which type of lenses you’ll 
need to best capture the action in various shooting 
situations. We reveal tried-and-trusted techniques for 

capturing sharp action shots and show you how to pan 
like a pro. Then we round things off with some more 
advanced action-photography skills.

Although we’ve concentrated on sports events, action 
photography techniques aren’t necessarily restricted 
to sports. In our comprehensive guide, we also show 
you some cool methods for capturing creative shots of 
performers – and, of course, all these techniques can be 
applied to absolutely any subjects that move! 

Learn how to capture great action photos with our essential  
tip-packed guide to shooting sports with your digital SLR

A sporting 
chance at 
success

SLR skills SLR skills
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If you’re shooting in a stadium, think about getting some wide 
shots of the whole setting rather than just focusing on the 
sports or performers. You’ll need a really wide focal length 
around 10-12mm on a typical digital SLR, or around 16-17mm 
on full-frame cameras. Popular lens options include Canon’s 
EF-S 10-22mm f/3.5-4.5, Nikon’s AF-S DX 10-24mm f/3.5-4.5G 
ED, Tokina’s 11-16mm f/2.8, or Sigma’s 10-20mm f/3.5. These 
ultra-wides can also be used for dramatic shots of some 
extreme sports such as skateboarding and snowboarding.

1 Wide-angle zoom

3 Telephoto zoom
If you’re unable to get close to your subjects as they’re on the other side of 

the pitch – or because you’re high up in the stadium – there’s nothing 
worse then ending up with tiny shots of your subjects with big, 
boring backgrounds. You’ll need a telephoto zoom lens with a long 

maximum focal length if you are going to 
fill the frame with your subjects. If you’re 
by the side of the track, you may be able 
to get away with a 70-200mm lens (check 

out Canon’s EF 70-200mm f/4L IS or Nikon AF-S 70-
200mm f/2.8G ED VR II), but you may well need an even 

bigger super-telephoto zoom, such as Canon’s EF 100-
400mm f/4.5-5.6L, Nikon’s AF VR 80-400mm f/4.5-5.6 or 
the more affordable Sigma’s 120-400mm f/4.5-5.6 OS 
lens. See our table, right, for focal length suggestions for 
different action subjects.

If you’re photographing performers on stage, or sports 
where you’re fairly close to the sidelines, such as rugby, 
BMX bikes or even marathon runners on the street, you’ll 
find a midrange zoom will get you close enough to at least 
some of the action – while being able to get some of the 
surroundings in shot to add context. 

Midrange zoom lenses give you more choice of focal 
lengths without the need for changing lenses, or buying 
new ones. Consider fast midrange zooms like Canon’s 
EF 24-70mm f/2.8L, Nikon’s AF-S 24-70mm f/2.8G ED or 
Sigma’s 24-70mm f/2.8. A typical 18-55mm kit lens will 
be just fine, too.

What lenses do 
I need?
I t all depends on what you’re shooting! It really 

comes down to how close you can get to subjects, 
and how tightly you want to crop. Telephotos are 

the obvious choice – but there are other types of lens 
that can prove useful for sports…

10mm

70mm

300mm

SLR skills

2 Midrange zoom
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Image stabilisation (or IS) is readily 
available on lenses from budget to 
pro-level, and this is a good thing for 

photographers, as a lens with IS can help to 
nullify camera shake when shooting handheld, 
which means sharper results all round.

Canon’s EF-S 55-250mm IS, for example, 
has a ‘4-stop Image Stabilizer’, which 

means you can use shutter speeds up to 16 
times slower than normal and still capture 
shots without unwanted blur, such as 1/15 
sec instead of 1/250 sec. 

Some IS lenses have two stabilisation 
settings, one for normal shooting, and one 
for use when panning by correcting simply 
for vertical shake. 

F ast lenses refer to the wider-than-
average constant apertures found 
on more expensive lenses, such as 

a 70-200mm f/2.8 or f/4 lenses. They’re 
called fast lenses, as at an aperture of 
f/2.8 or f/4 you’re able to obtain faster 
shutter speeds – ideal for freezing your 
subjects’ action.

The wide apertures will also really bring 
your subjects out from their surroundings 

for more striking results. The other 
benefit of using these lenses is that 
their wide apertures (and therefore your 
exposure, such as f/4 at 1/500 sec) are 
constant through the focal length range, 
whether you’re shooting at 70mm or 
200mm: whereas with cheaper lenses 
the aperture will change from, say, f/3.5 
at its widest focal length to f/5.6 at its 
longest end.

I’m told I need a ‘fast’ 
lens? What is this? Tech TIp

Telephoto focal lengths capture a shallower depth of field than wide-angle ones. So, coupled with a wide aperture of around f/4 or f/5.6, it will give your shots that pro look, with blurred backgrounds to make subjects stand out in the scene.
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Ideal focal lengths
Try these lens settings with APS-C SLRs

Stadiums 10mm to 17mm
Skateboarders 18mm 
Runners 50mm 
Tennis 70mm to 100mm 
Football 200mm
Motorsports 250mm
cricket 300mm
Baseball 400mm

SLR skills

Is it really worth using 
an image-stabilised lens?
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how can 
I get sharp 
shots?

c amera shake becomes more of a 
problem the longer your lens’s focal 
length. If your shots are blurry, it’s 

likely that you’re using a shutter speed too 
slow for your telephoto focal length, so 
camera shake has reared its ugly head. 

As a general rule of thumb, to obtain 
sharp shots when shooting handheld with 
a non-IS lens, you need to at least match 

your lens’s focal length with your shutter 
speed – so if you’re shooting at a 300mm 
focal length, make sure you’re shooting at 
1/320 sec or higher. Increase your ISO to 
obtain faster shutter speeds. 

Also consider using a monopod or tripod 
to help steady your camera – as well as 
taking some of the weight of your hefty 
telephoto zoom lens.

As your action subjects are 
moving, your digital SLR may 
struggle to keep up if you’re using 

the standard autofocus mode. 
On a Canon, AI Servo (the Nikon 

equivalent is Continuous Focus) is 
designed to ‘follow focus’ moving 

targets – look through the viewfinder 
and position your AF point over your 
subject and half-press the shutter to 
continuously focus as you track it within 
your frame. Note, however, that unlike 
One-Shot focusing mode, AI Servo won’t 
beep when it achieves focus. 

Regardless of the subject that you are shooting, if you intend to the freeze the 
action, you’ll need a fast shutter speed. Typically, digital SLRs allow you to 
dictate the shutter speed, leaving your camera to then automatically set the 

aperture to obtain an accurate exposure. 
So what shutter speed should you use? The shutter speed you need will depend 

on how fast the subject is moving. The faster its actual speed, and the bigger it is in 
the frame, the faster the shutter speed will need to be. You will also need a faster 
shutter if the subject is moving across the frame, rather than simply heading straight 
towards you. Start off with a shutter speed around 1/500 sec and work up (or 

down) from there. Increase the ISO to 200, 400 or 800 as 
required, even when shooting in daylight, to ensure you 
get a fast enough shutter speed. 

how do I get crisper 
telephoto shots?

What autofocusing mode 
should I be using?

SLR skills SLR skills
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It sounds like your camera 
is set to an autofocus 
point selection mode, 

which means all the AF 
(autofocus) points are active 
and your D-SLR will then 
just focus on whatever is 
closest in the frame – not 
necessarily your subject if 
it’s further away. Instead, 
manually select a single 
AF point – start off using 
the central AF point as 
it’s generally the most 
responsive and accurate 
– and then you can decide 
what your camera focuses 
on, rather than the  
camera ‘guessing’ and 
getting it wrong. 

Use a continuous mode: it’s there to help 
you get more bites of the cherry and is 
ideal for shooting fast-moving subjects as it 

gives you more choice of pictures from a specific 
sequence of events. Once the motor drive mode is 
set, and you’ve half-pressed the shutter button to 
lock your focus, you simply hold down the shutter 

and your camera will take a rapid-fire succession 
of exposures until it fills the memory buffer. As 
an example, the Canon EOS 7D in High-Speed 
Continuous mode fires off 8fps (for 15 RAW files or 
126 JPEGs), the EOS 60D manages a 5.3fps burst 
(for 16 RAWs or 58 JPEGs), while the Nikon D7000 
weighs in at 6fps (for 15 RAWs and 31 JPEGs). 

I can’t get my subjects  
in focus. can you help?

I always seem to miss the 
action as it unfolds, any tips?

8FpS
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can you help me 
master panning?
Panning is a great way to capture a sense of movement in 
your action shots – by blurring the background, but keeping 
the subject sharp. Here’s how it is done: 

1/125 Sec

1/500 Sec

Use the Tv or S mode to set a slower shutter 
speed than you would normally need to freeze 
the action. What speed depends on how fast 
your subject is moving and your position in 
relation to them: are you on a fast or slow 
corner? Are they coming at you three-quarters 
on, or hammering past you down the straight? 

For most motorsports on a mid-speed 
corner, try shooting at around 1/125 sec and 

see how sharp your subject is and how much 
motion blur is in your background. Increase 
your shutter speed if your subject is too 
blurred, decrease your shutter speed if the 
background is too sharp.

Experiment with different shutter speeds 
for different events and different locations 
on the track – see the table, right, for 
suggested speeds.

There are two ways to focus when panning; autofocus (AF) or manual focus (MF). 
Autofocus can produce mixed results if you’re not at the right speed to follow the focus 
on your moving target. On the other hand, manual focus can produce more consistent 
results, but it takes practice and patience. If you are using Autofocus, focus on a part 
of the track that you know the car or bike is going to go over, then switch to manual 
focus mode to lock the focus. Frame widely, so that you have plenty of space to fit in 
the fast-moving vehicle. Use motordrive, then track your subject, pressing the shutter 
just before they hit your spot on the track.

The trick to panning is get a good spot 
trackside, with room to swing your big lens 
from left to right without anybody being 
in your line of vision. Take a wide stance 
and, moving in a 90-degree arc with your 
upper body, smoothly track the car/bike 
throughout and shoot continuously. Always 
remember to follow through the arc – avoid 
starting or stopping abruptly, otherwise the 
motion blur will be messy.

1 Get set for panning

2 pan and focus

3 Move your body

SLR skills SLR skills
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Motion blur is a great way to push 
your action photography by 
capturing creative shots of your 

moving subjects, be they race cars or street 
performers. First look for colourful subjects 
with contrasting coloured backgrounds. As 
with all action photography, how fast or slow 
you need to set your shutter speed depends 
on how fast or slow your subjects are moving. 
For this shot of street musicians in Morocco, 
we used a very slow shutter speed of 1/8 sec 
to capture their movement as they danced 
and played.  

how do 
I shoot 
motion blur?

1/8 Sec AT f/32

1/180 Sec AT f/5.6 
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Start with these speeds for perfect panning shots
Joggers 1/20 sec
cyclists uphill 1/30 sec
cyclists downhill 1/100 sec 
classic cars 1/50 sec
horses galloping 1/50 sec
Superbikes 1/250 sec
F1 cars 1/500 sec 
Drag racing 1/1000 sec

SLR skills
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One of the best ways of giving yourself a fresh challenge is to try 
photographing sports you have never shot before. But, whatever 
the event, trying a new photographic approach can work wonders 

for your portfolio. Here are five great tricks to try…

how can I advance  
my action skills? 

Pa
ul

 G
ro

ga
n

This is a brilliant and pretty simple way to add impact to action shots. 
Colourful subjects work best as the blast of colour and blur emphasises 
the sense of movement. Set a slow shutter speed of around 1/15 sec 
and choose a standard zoom lens. Zoom in and focus on your central 
subject, start zooming out before smoothly pressing the shutter button 
and zooming smoothly through the exposure. An alternative to creating 
this effect in-camera is to add the effect to your action shots in 
post-production using Photoshop’s Radial Blur command.

1 Zoom blur

Action photography doesn’t need to be all about bright colours and 
motion blur. Try your hand at creating a moody black-and-white shot 
instead. Think about your composition; perhaps go for a wider shot that 
shows your subjects in context and tells a story, rather than a tightly 
focused shot. Shoot in colour and convert your images to black and white 
in Photoshop, boosting the contrast if you like. Mono conversions work 
well on shots taken on dull days when the skies lack detail or tones.

2 Get creative with mono
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A great way to present action sports is to create a frame-by-frame 
sequence. Use a wide-angle lens to fit in the entire sequence of 
shots and a tripod so your D-SLR is in the exactly same spot for 
each shot. Use a manual exposure mode, with an aperture around 
f/5-6.3, upping your ISO as necessary to allow a fast shutter speed 
around 1/1000-1/2000 sec. Switch to a high speed continuous 
drive mode to capture as many frames per run/jump. Use 
Autofocus to prefocus on a spot in line with your subject’s path, 
then switch to manual focus to lock it in place. You’ll want 
approximately four shots to stitch together in Photoshop. 
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It’s always good to work on improving your compositional skills, so try 
moving around your subjects to find a different angle. A good trick to 
creating an unusual sports picture is to crop in really close – just 
showing part of the athlete’s body, as in this soccer shot. It can also be 
effective to go to the other extreme, and compose the shot so the 
competitor is very small in the frame. 

As long as you have permission – some sports and events don’t allow 
use of flash as it’s too distracting – using your flash can create some 
bright and colourful effects. Instead of using flash for freezing the 
action, combine it with a slower shutter speed to capture some creative 
blur to demonstrate a real sense of movement. Try a shutter speed of 
around 1/30 sec – depending on how fast your subject is moving – and 
set your aperture for the ambient light of your scene, using your flash to 
light your subjects. If you need your flash to project further, simply 
increase the ISO. Also try setting your camera to ‘2nd-curtain sync’ and 
your flash will fire right before the end of your exposure (rather than 
immediately after the exposure starts, as default with 1st-curtain sync) 
to create a trail behind your moving subjects.

5 cool compositions

3 Flash effects

4 create an action sequence

how can I advance  
my action skills? 

SLR SkillsSLR skills
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30 ideas for 
better

action photos
Learning how to capture the world in motion will enhance 
any photographer’s skills. We talk to three top action 
lensmen and discover the tricks of their trade 

C
apturing the moment is an 
idea that’s often associated 
with photography, but in no 
genre is it more crucial than 

action scenes. From the exhilaration 
of the sports person frozen in mid-air, 
to the dazzling light trails generated by 
cars whizzing past at night, the ability to 
capture a moment in time enables you to 
create pictures bursting with energy and 
drama. If you’ve ever tried your hand at 

action or sports photography you’ll know 
that capturing ‘the moment’ isn’t nearly 
as easy as it looks! And any pro will tell 
you that there’s much more to producing 
winning images than just big lenses and 
high-speed motordrives. 
 So what does it take? To help us 
answer this question we’ve enlisted the 
help of three of the biggest names in 
British sports and action photography 
– Olympic master Bob Martin, Guardian 

newspaper photojournalist Tom Jenkins 
and specialist car photographer Tim 
Andrews. Together, these master 
craftsmen have around 60 years of  
experience in their respective fields, and 
they’ve given up their biggest secrets to 
help you take better action photos. From 
learning how to anticipate ‘the moment’ 
and making your shots stand out, to the 
latest cutting-edge creative techniques – 
you name it, we’ve got it covered…
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Tim Andrew
Car photographer

Tom Jenkins
Sports photographer

Bob Martin
Sports photographer

Tim Andrew is a renowned 
freelance car photographer   
with over 20 years of experience 

shooting for adverts, brochures 
and magazines. Clients include 
Nikon, Mercedes, BMW, Nissan 
Europe, Peugeot and Classic 
Car magazine. 

Tom Jenkins is one of The 
Guardian’s finest sports 
photographers and has won a 

string of industry accolades, 
including Britain’s top sports 
photographer, Best Olympic/
Paralympic Portfolio and Best 
Sports News Picture.

With over 63 national and 
international awards under his 
belt, Bob Martin has earned his 

place as one of the world’s 
most respected and well-
known sports photographers. 
He specialises in advertising, 
corporate and editorial work.
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Martin

1 Look at the background!
You can capture the most amazing piece 

of action in the world but if you’ve got an 
awful background it’s never going to be a 
great picture. Frequently, I’ll sit where the 
action isn’t at a peak but the background is 
perfect, so if something wonderful happens, 
I’ll get a great picture. If I can’t get rid of a 
background, I might switch to a very long 
lens and that’ll help clean it up. 

2Hide it in shadow
Sometimes if you shoot backlit, the background 

is less noticeable – this is because with backlit 
subjects the sun’s normally coming from behind, so 
the background will be in shadow. It doesn’t work 
the other way round, though. 
 You can’t shoot when the subject is all in the 
shade and the background is in the sun, but so 
many people still try to attempt it!

3 Knowledge is power
If you understand the sport it makes it much 

easier to pick the moment. For instance, if you 
know about swimming, you’ll be able to predict 
roughly where the competitors are going to breathe 
during the 50-metre length – during the sprints they 
hardly breathe at all. You know with the sprints it’s 
better to go a little bit higher because there’s so 
much splashing you can hardly see them; with the 
long distance races, you can go for more dramatic 
angles lower down, looking into the swimmers’ 
faces because there’s less foam around. 

4 Use dynamic positions
Sometimes I take the kids to watch local rugby 

games and you see parents standing up along the 
edge of the pitch. They’re not getting down and 
looking up at the action, but you can get far more 
dramatic shots that way. You’re there to take 
pictures, not to look good. I’ve got a stepladder out, 
laid on my stomach in the middle of the world track 
and field championships – you name it. It’s worth 
seeking out overhead views, too – you can get some 
really great pictures at a rugby match from the 
grandstands looking down.

Leading sports photographer,  
Bob Martin, shares his tips for 
the best way to convey action

The long shadows in the photo above echo the footballer’s pose 
and add interest to the shot. These details make a difference
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5 Don’t forget the aesthetics
Some 20 years ago, if you got a shot of Linford Christie winning the 

100 metres with his feet off the ground you were pretty good. Now with the 
autofocus that the likes of Nikon and Canon have got, almost anyone can 
do that. For example, I can sit down with one of my teenage sons and give 
them a half-hour lesson and they’ll be taking action pictures. So it’s not 
good enough to turn up to an event and think ‘I’m just here to get them 
flying through the air’. Your shot needs to be more of a photographer’s 
picture. The artistry is crucial – the fact that you shoot action is a secondary 
thing. A lot of sports photographers haven’t caught onto that yet. 
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6Anticipate the moment
We all get lucky from time to time, but 

most of the time you get the shots because 
you’re concentrating. People have said to me 
that cricket must be fantastic to photograph, 
sitting out in the sun all day. If you sit there at a 
cricket match chatting to the chap next door 
and not following the match, you’ll have no 
good pictures. And you can’t just hit the 
motordrive every time they strike the ball: you’ll 
have run out of cards before the first wicket 
falls! Action can happen unexpectedly and so 
fast that you’ll have to be prepared to anticipate 
it. Sometimes you can tell just by the body 
language of the person that something’s going 
to happen. If the batsman has got to up his run 
rate, when he starts to knock the ball about 
you know something’s more likely to happen 
because he’s taking chances. 

7  Think different!
So many people just don’t think. Because 

all the other photographers are all in a row at 
the finishing line they’ll go and stand with all of 
them rather than looking for a different 
viewpoint. Don’t necessarily go where everyone 
else is standing! Just because the guys in 
charge have put the photo positions there for 
the pro’s point of view, it doesn’t automatically 
mean that’s the best place to stand. Of course, 
at some big events you might not be allowed to 
move to a different position, so you need be 
prepared to work with what you’ve got. 

8To burst or not to burst
In general, a good sports photographer 

will prefer to fire off one frame to pick off the 
moment he wants, even with a 10-frames-per-
second camera. For example, if you’re at a 
tennis match and you’re trying to get a shot of 
the racket on the ball and you motordrive it, 
you’ll waste thousands of frames. So, 
providing you understand your camera and 
the timing of it, you’re far better off just firing 
one frame. However, sometimes something 
happens that you weren’t expecting and the 
best thing to do is to hit the button and hold it 
down. For instance, if you’re at a soccer 
match and somebody suddenly scores a 
goal, you push the button down. It’s just 
another tool on your camera.

Action can happen 
unexpectedly and so fast 
that you’ll have to be 
prepared to anticipate it

Think creatively, and try to capture the sports action 
from a different angle – you could come away with a 
dynamic shot that provides a new perspective
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10 Patience is key
You must have patience to get good 

pictures. I’m pretty pig-headed and I’ll wait  
and wait in order to get a good picture. 
Sometimes I think it’s because I’m a bit thick 
so I don’t mind waiting, but that’s how you 
get the key moments. You look at soccer 
matches and a lot of people leave five 
minutes before the end to miss the traffic. 
How mad is that? At the end of the day, 
being good at action photography is never 
about just turning up and pointing the 
camera – it’s about hard, hard work. 
Generally, the people who work really hard 
get the best pictures every time.  

9 Don’t be afraid to tackle a    
wide angle perspective

Often you can’t get close enough to the action so 
that’s when you need the big lenses, but I also 
carry a massive range of other lenses to give me 
different perspectives. For example, if you can 
get close to the action at a sports event, you 
shouldn’t ever be afraid to shoot with a short 
lens! I really love shooting sport at wide angles 
because they capture the atmosphere in a far 
more effective way and give a sense of place, 
and it’s these elements that can make a good 
picture into a great picture. 
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The low and wide angle in this shot leaves the 
high jumper looking like a figure from a painting 
by Matisse. Action shots can be artistic!
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11Don’t let your nerves get the 
better of you beforehand

You do feel nervous before a major event – I still 
get butterflies in my stomach, but with experience 
comes knowledge of what can happen and the 
confidence of knowing that you can get those 
one-off shots. The best way to deal with nerves is 
to concentrate on your subject and keep fully 
focused. Try to blank out everything  – don’t let 
sounds or anything put you off, just keep looking 
through the viewfinder and keep concentrating.

12 Be philosophical 
Accept that you won’t always get the shot 

that you want. You have to be philosophical about 
it and never give up trying. Learn from the mistakes 
that you’ve made and work out if you could have 
done things better and, if so, come up with an 
alternative approach. Every time you shoot, 
remember that it’s a learning experience. 

13 Use the emotions of the 
players to tell the story

During a game or event I might want an expression 
on a particular player that goes along with the 
story. That’s why it’s imperative that you’re in tune 
with the players and able to read what’s going on 
at all times – you have to try to predict what the 
story is supposed to be telling. You also need to 
know who the big characters are, because they 
might give you better pictures than others. There 
might be a rugby match, for example, where a new 
player had come in that was a bit of a star, so I’d 
definitely want to keep an eye on what he’s doing, 
because that might be the story of the day. 

14 Put yourself in the right areas
With sport and action you can rarely 

predict what’s going to happen, but you might 
be able to use your experience to predict 
where it’s going to happen. If you keep 
putting yourself into the right positions, you’ll 
eventually be there to capture it. 

Tom 
Jenkins

Tom Jenkins has won a string 
of awards for his dynamic 
sports photography

Sport is all about winners and losers, so people’s 
emotions are a very strong ingredient in taking 
great sports pictures
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15 Freeze the action
Obviously the shutter speed that you need depends on what 

you’re shooting, but generally to freeze action I wouldn’t go below 
1/500th of a second. Also remember that if the subject is moving 
across your frame, you will need to choose a higher shutter speed 
than if it is coming straight at you.   
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17  Be at one with  
your camera

It’s essential that you’re familiar with  
your equipment. You have to know your 
camera inside and out, so it’s almost  
like an extension of your body. You   
can’t concentrate properly if you’re 
stopping to think ‘how do I change this?’, 
what setting to use and so on. It has to 
be automatic. Don’t let having to think 
about your camera settings get in the 
way of taking a good picture. 

18    Don’t limit yourself
You mustn’t be limited to   

just taking pictures in so-called ‘perfect’ 
light conditions. As long as you’re 
prepared and your camera is likewise, 
you can get the greatest pictures when 
it’s absolutely lashing it down! So, next 
time the clouds roll in, think that you 
might be able to make a really original, 
atmospheric picture out of it. 

19Action can be artistic
I’ve always believed that you can 

combine sport and action with fine-art 
black and white photography. I hate the 
fact that people might have the 

preconception that it can’t be as artistic 
as other types of photography. If you’ve 
got an open mind, there’s really no 
reason why action and sport can’t be as 
artistic as you want it to be! 

16  Backlighting can add impact
You can achieve striking effects by shooting into the sun. For 

instance, shooting into the light can produce very nice rim-lighting on 
people. Also, if a footballer jumps into the sunlight for a header – and 
loads of sweat flies off their head – that can be really nice when 
backlit because the light will catch the spray.

This shot of a golfer 
shooting into the sun 
has great atmosphere
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Tom uses the 12.1Mp D3 – one  
of Nikon’s flagship D-SLRs

20 Use the right tools for the job
You can capture action with any D-SLR, 

but for what I do I need a camera that responds 
very quickly, so I need a very low shutter lag, a 

quick shutter, a quick motordrive and fast 
autofocus. Having a large viewfinder helps, 
too. About four years ago, I totally swapped 
over from Canon to Nikon just because of the 

D3 – it was a tremendous camera. It was 
responsive, the lenses are very sharp and it 
could shoot in incredibly low light. I swapped to 
Canon in 2003 as I felt Nikon were behind them 
at that time, but now they’ve caught up and are 
pushing the boundaries. Going back to full-frame 
has been interesting but I’ve quite enjoyed it.  

SLR skillsSLR skills
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Tim 
Andrew

21  Develop the perfect swing
Panning is a bit like a golf swing – 

it’s a waste of time if you’re rigid. You tend 
to get sharper shots if you relax your arms a 
bit and don’t stick your eye right up to the 
viewfinder. For example, if you’re tracking an 
object that’s flying past and you want to 
shoot five frames, you should continue 
pretending to shoot well after it has gone 
past you and disappeared, and that will 
make your body flow correctly.

22 Practice makes perfect
The only real way to improve your panning 

success rate is by practising. You’ve got to be able 
to do it without thinking. With cars, my favourite 
panning speed is between about 1/15th and 
1/60th of a second. If it’s a person, bicycle or 
horse, you have to slow it down a bit more to get 
the same effect. You also need a slower shutter 
speed if you’re shooting with a wide-angle lens.

23    Use an ND filter
It can be hard to get a slow enough 

shutter speed to pan in daylight. If it’s a sunny 
day, nine times out of 10 I have to put a neutral 
density filter on, in order to give me those longer 
exposure times. I avoid stacking them because 
quality goes down and you get light bouncing 
around. If it’s a wide-angle lens, you also start to 
get vignetting. In that instance, I might have to 
wait until it gets darker. 

24    Choose the right background 
for your panning shots

When you’re out shooting pans of cars there are 
usually a ton of things in the way like hedges, 
wire, buildings and fences. The opportunity to do 
a clean pan is quite low and you have to search 
quite hard for the right conditions. You don’t want 
anything between you and the camera that hides 
the car. Beyond the car, you want either the 
ground to rise or a hedge or something in the 
landscape that will give you a good texture for 
the motion blur. If you’ve just got clouds and sky 
behind the car they don’t give much of an 
impression of speed. 

Car specialist Tim Andrew has 
shot for the likes of BMW, 
Peugeot and Mercedes-Benz

Look for features in the landscape that will give 
the pan a sense of real speed
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25  Find those unusual angles
Over the years I’ve used all kinds of contraptions to get me into 

more unusual and dramatic positions to photograph cars. These include 
a homemade aluminium bracket that I can hold out of a car window. It’s 
about 18 inches long and the camera’s mounted on the bottom. I’ll often 
dangle the camera down low so that it’s just a couple of inches off the 
tarmac. I’ll then use a Zigview right-angle viewer (www.intro2020.com) to 
frame the picture and a remote cord to press the shutter.  
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A Zigview monitor can make 
life easier when shooting 

difficult angles on the move

A wide-angle lens, tripod 
and suction mounts can 
get you unusual views 
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26 Try shooting from an 
overhead angle 

Shooting from overhead can produce 
interesting shots – I often use footbridges 
over dual carriageways or just climb up the 
banks of mountain roads and look down. 
You could even try panning from an 
overhead angle. Shooting through trees is 
a risky strategy from a success point of 
view, but the results can look fantastic. 
You need to make sure that the sharp shot 
is the one where the important part of the 
car isn’t obscured by the trees. In that 
circumstance, I would prefocus and use 
manual focus because the trees would 
confuse the autofocus.

The combination of the vintage car and the 
motion blur makes this shot look like a classic 
’50s magazine cover
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27 Try zoom panning
I often use an 18-200mm lens to 

zoom pan because it gives you a much 
more three-dimensional feel to an image 
than a normal pan. I’d go much closer to 
the road than for a traditional panning 
shot and follow the car all the way through 
from 200mm right through to 18mm and 
then back up. That way you get three 
shots in one – the car approaching a long 
way away, a wide-angle shot just as it 
goes past and then the rear shot. More 
images mean more options for when 
you’re selling to a client.

28   Shoot from a 
second car

A good way to get a dramatic front-on shot 
of a moving car is to shoot it from a vehicle 
driving in front. I use a rig now, but I used 
to crouch in the back of a hatchback with 
the back open and get the car to follow 
closely along a closed road. I’d use a 
pretty wide lens and as low a shutter 
speed as I could get away with, like 1/8th 
of a second. Unless you want the car to be 
completely blurred, you need to use flash 
to freeze the nose. Off-camera flash works 
best here – you should try to angle it so 
that it doesn’t freeze the road too much. 
However, don’t take risks getting this sort 
of shot. Always put safety first.

29The light 
fantastic

To capture the night 
shot with the light 
trails (shown above)   
I mounted the camera 
on a tripod and fixed it 
to the back of the car 
with suction mounts. I 
then pressed a radio-
controlled release as I 
drove the car. The trail 
of lights is vital so I 
was up to about 30 
seconds to capture 
them successfully. 
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30 Always try to be creative
There are only so many ways you can photograph a car 

or a bike, and nearly everything’s been done before. But each 
new situation and location will give you ideas and challenges, 
and it’s your reaction to those ideas and challenges that gives 
you the scope for creativity.  
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Planes, trains 
& automobiles
Speed up your camera skills with our guide to 
photographing anything motorised that moves!

S
teve Martin and John Candy in 
the 1987 comedy classic aren’t 
the only ones interested in 
planes, trains and automobiles 

– as these all make great photographic 
subjects. Whether photographing high-
speed F1 cars or sky-high Lancaster 
bombers, you’re almost certain to get 
dynamic action shots. 

However, photographing such fast-
paced subjects can be daunting, 
especially if it’s your first time. Their size, 

speed and movement often leads to 
shots with awkward compositions or poor 
focusing. Over the next 10 pages, we’ll 
explore how you can avoid the pitfalls 
of transport photography and achieve 
stunning images every time. We uncover 
the secrets of filling the frame, and 
making sure your focusing is perfect.

From picking the right lens to setting 
an appropriate shutter speed, we have 
everything you need to know to get crisp, 
clear, action-packed shots!  

SLR skillsSLR skillsSLR skillsSLR skills SLR skills
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planes

Propel your aviation photography to the next level

A sturdy tripod is essential for aviation 
photography, as it will increase your hit 
rate for sharp shots and prevent your 
arms from aching after carrying heavy 
lenses for hours. By kitting out your 
tripod with a gimbal head, you’ll not only 
get extra support, but it also enables 
you to move the lens up and down 
smoothly as you pan.

Get kit clever

1/200 Sec
Set your digital SLR to its shutter priority mode and it 
will be easier to switch between shutter speeds and 
maintain focus for different subjects. For fast jets, set 
your shutter speed to around 1/500 sec to freeze the 
action. For older planes and helicopters, go for 1/200 
sec to get smooth motion blur on the propellers.

A setup for success

1/500 Sec
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Improve your 
aeroplane photos
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Find your  
nearest airshow

Planes on the ground make interesting 
subjects, too, so when there’s a break in 
the action, make sure that you grab some 
static shots as well. Use a wide-angle lens and 
get close up to interesting features, such as 
the nose, cockpit or tip of the wing, to get a 
sense of size, scale and power.

Remember to 
shoot statics 
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You’ve got the lens, you’ve chosen your shutter speed and your 
digital camera is fixed firmly to a tripod – the final step in getting 
sharp shots is choosing your autofocus and drive modes. Canon’s 
AI Servo or Nikon’s Continuous Focus modes are great for tracking 
moving subjects and refocusing in an instant, while selecting 
a continuous shooting mode will give you a burst of shots that 
ensure you capture the aircraft at the apex of its movement.

Figure out your focus
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Chris George

The best place to photograph planes is at your 
local airshow. In the UK, the air show season 
starts in May and ends in October, with 
most events occurring over a 
weekend. A comprehensive list 
of aviation shows is available at 
www.militaryairshows.co.uk, but 
be sure to also check for 
details in your local 
newspapers.

Super-telephoto zoom
It’s hard to predict the flight path of aeroplanes as 
they speed across the sky, so a telephoto zoom 
lens will ensure that you fill the frame, no matter 
where the air display is heading. The Sigma 150-
500mm f/5-6.3 DG OS HSM has an excellent focal 
length range that covers all eventualities and high-
quality optical stabilisation that gives you sharp 
shots, even at the 500mm end.  
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Try experimenting with shutter speeds when you’re 
commuting. Fast city trains look particularly striking 
with slow shutter speeds (1/60 sec or less), 
because this adds motion blur to the shot, making it 
more dynamic. However, fast shutter speeds (1/200 
sec or more) that freeze the train in action can add 
detail and realism to an image.
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1/30 Sec

1/320 Sec

Put your locomotive photography back on track

TRaIns

SLR skillsSLR skills

Get great train shots

Photographing older trains without any steam makes shots 
look very flat and dull. Shoot on cold days with the steam 
engine at a gradient so the exhaust is emphasised. You 
may also want to defy conventional composition rules and 
position the train further into the frame, so the trail of 
steam takes on a more prominent position.

Getting steamy

control your 
shutter speed
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Whether you’re photographing fast-moving 
electric-powered trains or steam engines 
chugging slowly towards the station, you’ll 
want to choose the Raw file type to get the 
highest-quality photographs. If the lighting is 
poor when you’re shooting or you find that 
you’re losing detail in the train’s black metal 
finish and billowing white steam, then the 
advantage of Raw is that you can easily 
improve these colour, contrast and exposure 
problems later in post-processing.

Shoot in Raw for 
the best results

Unlike other forms of transport 
photography, capturing trains is a 
little more predictable. To get sharp 
shots every time, visualise the point 
where you want the train to be in 
your composition, and focus on 

that area of the tracks using one of 
the autofocus points. When you’re 
confident you’ve got the focusing 
spot-on, switch to manual focus to 
lock on this position and just wait 
for the train to arrive.

Fix your focus manually

 You may be forbidden from photographing inside 
stations for security reasons, so you’ll want to position 
yourself along the train’s planned route in order to get 
the shot. Try finding a bridge that goes over the tracks 
to get powerful front-on 
shots. To fill the frame 
and capture a train 
from side-on, use a 
telephoto zoom lens 
and shoot from a 
public pathway or road 
that runs parallel 
to the tracks.  

Use telephoto zoom 
lenses for top shots
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Midrange zoom
A midrange zoom lens, such as the Canon 
EF-S 18-135mm or Nikon AF-S 18-105mm, 
enables you to capture close-ups – as 
well as wide shots – of trains. To give a 
sense of location, be sure to zoom out 
and include as much of the scenery as 
possible, but if there are a lot of signs or 
pylons cluttering the landscape, zoom in 
for a tighter, cleaner shot.



To make race cars look more dynamic, pan with your camera to 
add a touch of motion blur. Set a shutter speed of around 1/60 
sec, prefocus on the spot that the car will drive past, then lock 
your lens in the manual focus position. When the car comes 
into view, track it through a smooth 180-degree arc until it’s left 
the frame. This helps to show the speed of the car and also 
blurs out distracting fences in the background.

Perfect your panning

The advantage of shooting cars and bikes as they 
come around a corner is twofold – corners slow the 
vehicle down, giving you more chance of getting a 
sharp shot, and they also give you a better sense of 
movement in your images. As a car takes a corner, 
the suspension dips to one side, allowing you to snap 
away as the car body shifts. When a motorcycle 
takes a corner, the rider hangs off the bike and leans 
in, adding an element of danger and excitement.

concentrate 
on corners 
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Get in the fast lane to improve your motor photography

aUTOMOBIles

capture fast-moving 
cars and bikes
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To capture any type of moving automobile, set your 
camera to TV or S mode and use a shutter speed 
above 1/500 sec to freeze the action. To increase 
your sharp shot hit-rate, try boosting your ISO, too. 
ISO400 is good for bright sunny days, but you may 
need to go as high as ISO1600 on dull, cloudy days.

choose your 
settings wisely

1/200 Sec

1/2500 Sec
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Cars and motorbikes are elegant subjects, so do the glossy paintwork and smooth 
curves justice by photographing them when stationary. Unlike bigger forms of 
transport, it’s easy to move an automobile to an attractive location, such as a long 
stretch of road or an industrial estate, so pick a good-looking backdrop and get low 
to emphasise the sleek lines of these mean machines!

Strike a pose
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A monopod is a key piece of kit for motorsport 
photographers. Smaller and lighter than a tripod, a 
monopod can be set up almost anywhere, making it 
easier for you to hold heavy lenses 
and pan smoothly. For more 
stability, go for one with three 
leg sections as opposed to 
the weaker four- or five-
section models.

Get in pole position
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Telephoto prime
You don’t always need a telephoto zoom 
lens for motorsports as the cars or bikes 
will pass in a similar position on the track 
every time. A 300mm focal length is an 
ideal lens for this because it enables you 
to position yourself at the side of the 
track, prefocus on the area where the 
automobiles are passing, then click the 
shutter when they fill the frame.  
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Some sports and events frown upon the use of flash as it can be 
distracting, but when you’re lucky enough to get the chance to use it, take 
advantage! Rally car racing and mountain biking are events where flash is 
welcome as it can help fill in shadows and add some atmosphere to the 
shot. When possible, try to take your flash off-camera because this will 
freeze the action without blowing out any important highlights.

Use flash when you can

Capturing motocross bikes in 
mid-air is much easier than it 
looks! The trick is to use a 
telephoto lens and to position 
yourself below or level to the riders 
to emphasise the sense of space. 
Also, remember to use a high 
speed continuous mode to capture 
a burst of shots and track the bike 
through its full range of movement. 
Often, the best shots are achieved 
just as they’re taking off or landing, 
as opposed to fully airborne.

Photographing transport leaves room for lots of 
creative possibilities. Try using a fisheye lens on 
parked cars to emphasise their smooth curves, 
or change your angle and get down low to the 
ground to give your image a grander sense of 
scale. Alternatively, invest in an infrared filter for 
your camera kit lens (or better still have an old 
D-SLR converted for infrared shooting) and try 
photographing mechanical machines in luscious 
green surroundings – you’ll be impressed with 
the gritty, surreal results! 

Up in the air!

Get creative
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Whether it’s boats, boards or bikes, here’s 
how to polish your high-speed SLR skills…

anyThIng else ThaT MOves!
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Get creative  
with action
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Getting your white balance spot-on will 
reduce the amount of time you spend 
editing your images. For outdoor car 
rallies, use a cloudy or daylight white 
balance presets, as these will warm the 
colours in your image for a natural finish. 
For indoor track cycling or a roller derby, 
use a fluorescent preset or customise 
the white balance to remove the cool 
colour temperature.

Wise about 
white balance

cloUdy WB

cUSToM WB

TUnGSTen WB

Which lens?

No matter what subject you’re 
photographing, you should 
always aim to get an 
interesting and harmonious 
composition. Think about 
leading lines to guide the eye 
in or using the rule of thirds to 
divide up an image for easier 
viewing. You should also try to 
fill the frame with your subject 
whenever possible, because 
this will create an image that 
really grabs attention.

concentrate on composition
FIll The FRAMe

RUle oF ThIRdS
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Fast telephoto zoom
Fast lenses, such as the Canon EF 70-200mm 
f/4L or Nikon AF-S 70-200mm f/2.8G, enable 
you to use wide apertures and fast shutter 
speeds to avoid camera shake in all lighting 
conditions. They’re great for photographing 
transport indoors, in low light, and are 
especially popular with photographers who 
need to use a shallow depth of field to blur  
the background at a messy arena or track. 
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The Photographer’s ApprenticeThe Photographer’s Apprentice

“He shoots!
He scores!”

Learn how to shoot like a striker as our Apprentice gets 
professional coaching at a Championship soccer match

The Photographer’s Apprentice The Photographer’s Apprentice
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THE APPRENTICE…
Name: Cliff Withers 
Camera: Canon EOS 450D
Cliff, 45, from Crowthorne, is MD of 
a circuit boards manufacturer and a 
keen amateur photographer. He bought 
his digital camera a year ago and 
enjoys taking action sports shots of 
gymnastics and judo, but his true love 
is football. Cliff’s been struggling to 
capture any decent footie photos – “My 
shots tend to be blurry, out of focus, or 
the composition is all wrong!” – so he’s 
asked us for some expert advice.  

John is a professional sports photographer 
– he was Bristol City FC’s photographer  
for 24 seasons and worked for the Bristol 
Evening Post for more than 35 years.  
John photographs football, as well as other 
sports including cricket, rugby, tennis and 
hockey, and is a spritely 67 years young. 
See his top football shots in the gallery  
at www.bcfc.co.uk.

THE PRO...
Name: John Kelland
Camera: Canon EOS-1D Mk III 

“He shoots!
He scores!”

The Photographer’s Apprentice
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Canon EOS-1D Mk I  

Sigma 17-35mm f/2.8-4 EX DG HSM

Canon EF 70-200mm f/2.8L IS USM

Canon EF 300mm f/2.8L IS USM

Canon EF 1.4x and 2x Extenders

Manfrotto 681B monopod

John uses the 
top-of-the-range 
Canon EOS-1D Mk III. 
Its highly responsive 
autofocus modes 

and fast-shooting ten-frames-per-second 
(fps) burst mode make it the pro sports 
photographers’ weapon of choice. John 
also carries this kit: 

Speed up your SLR 
“In Aperture Priority mode, Cliff’s exposures were 

consistent, so I suggested he shoot in JPEG instead of 

Raw to increase the amount of shots he could take with 

continuous shooting,” says John. “I’m confident my 

shots will be correctly exposed, so I don’t need the 

added detail of Raw or to enhance them in Photoshop. 

JPEGs are also quicker to edit and upload.”

Control your apertures
“I said Cliff should shoot in Aperture Priority mode and set his aperture 

as wide as possible (between f/4 and f/5.6 on Cliff’s lens) to create a 

shallow depth of field that would blur distracting backgrounds,” notes 

John. “In this mode his camera will adjust the shutter speed 

automatically as lighting conditions change to maintain the correct 

exposure. This was essential on a sunny day, with one side of the 

pitch in shadow.”

SHOOTING 
MODES 

IMAGE 
QUALITY

After ten minutes, John checked Cliff’s SLR techniques and suggested a few tweaks 

Is Cliff ready to shoot?
Technique assessment

KILLER KIT OF THE PROS #1
Monopod
All the pro photographers at the match used 

monopods. “Mine takes the weight 

of my big 300mm telephoto 

lens and keeps my SLR at a 

constant height, so it’s 

easier to quickly focus on 

players,” says John.  

“It also reduces camera 

shake, so I end up with 

sharper shots.”

The Photographer’s Apprentice The Photographer’s Apprentice
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Take control 
of focus 
“Cliff was getting mixed 

results using  

his camera’s AF 

(autofocus) Auto Point 

Selection, so I suggested 

to manually select the central 

AF point instead so he could 

choose which players to focus on, 

rather than letting his camera decide.”

Exposure: 1/4000 sec at f/3.5, ISO400  
Lens: 70-200mm f/2.8

“Your position on the pitch 

will have a big impact on 

your shots,” says John. 

“If you’re on the side and 

towards one end, you’ll 

have a good view of players 

running and a wide view of 

the goalmouth for any shots 

on target. However, for more 

captivating action shots 

of players coming straight 

towards your telephoto lens, 

get positioned behind the 

touchline, either side of 

the net.”

Get in position: 
walk the line 

 Cliff’s 
comment
“When the game 

started, it took  

me a while to get my 

eye in, but I eventually 

managed to get this 

nice action shot of the 

Middlesbrough player 

on the attack as two 

Bristol City players 

closed him down. 

I used a wide aperture 

of f/3.5 to blur the 

fans in the 

background, and by 

setting the ISO to 

400, I achieved a very 

fast shutter speed of 

1/4000 sec to help 

freeze the players’ 

movements.”  

The Photographer’s Apprentice

JOHN’S TIP
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Welcome to  
the dark side
“John sat us on the dark side  

of the pitch, which was in 

shadow, shooting with our 

backs to the sun,” says Cliff. 

“By not shooting directly into 

the sun, we could capture 

more evenly exposed football 

shots, because the sunlight 

was falling on the players and 

crowds behind them.” 

CLIFF’S TIP

The pain and 
the passion 
“John encouraged me to look for 

photo opportunities outside of 

the main action – shots that help 

capture the story of the game,” 

reports Cliff. “Try capturing 

players being given yellow or red 

cards, or going down injured, and 

a goalkeeper’s expression after 

letting in a goal.”

CLIFF’S TIP

KILLER KIT OF THE PROS #2
Fold-up stool
Take the weight off your feet with a fold-up 

stool (ours cost £5 at a camping shop). “As 

well as being relatively comfortable to sit on for 

90 minutes, a stool will put you lower to the ground 

so you’ll reduce the amount of unwanted foreground and 

background turf in your shots,” says John. “You’ll also be low enough 

to not block the view of the paying fans sitting behind you!”

The Photographer’s ApprenticeThe Photographer’s Apprentice
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 Cliff’s comment
“This shows the advantage of sitting at the end of the pitch behind the 

touchline; I was able to get photos of players as they ran straight towards my 

camera. Using a fixed 300mm telephoto lens at f/4, I could knock the 

background out of focus. I cropped the image into a square in Photoshop to 

keep the focus on the two main players.”

Exposure: 1/1000 sec at f/4, ISO400  
Lens: 300mm f/4

Keep shutter speeds swift
“Even though it was a bright and sunny day, 

I recommended to Cliff that he bump up his 

ISO,” says John. “I always keep my ISO on at 

least 400 to make sure I have really quick 

shutter speeds (at least 1/1000 sec) for 

capturing the fast pace of the game and 

players’ movements.”  

JOHN’S TIP

EXPERT INSIGHT

SLRs typically have three main autofocusing (AF) modes: 

One-Shot AF, AI Focus AF and AI Servo 

AF, the last of these being best 

for sports. “It will 

continuously track moving 

targets even as their 

focusing distance 

changes,” says John. 

Note that in AI Servo 

the autofocus won’t 

beep, even when 

focused and locked on. 

Football focus

The Photographer’s Apprentice

Sports & Action Photography Made Easy  59



The Photographer’s Apprentice

60  Landscape Photography Made Easy

        

How to improve 
your strike rate 
To increase Cliff’s 

chances of capturing that 

short-lived moment when 

a player shoots or heads 

the ball, John got him to 

switch his D-SLR’s Drive 

mode to high-speed 

continuous shooting. 

Cliff’s camera produces a 

modest 3.5 frames per 

second (fps) while John’s 

pro-level D-SLR fires off 

ten fps. “This gives me a 

bigger choice of shots 

from a particular 

sequence of play so I can 

then pick the best one,” 

says John.

JOHN’S TIP

Capture the 
celebrations 
Capturing the joy and delight 

on players’ faces as they 

celebrate after scoring a goal 

is another enjoyable aspect of 

football photography, as Cliff 

explains: “John emphasised  

to me the importance of not 

only getting photos of players 

shooting, but also of them 

celebrating afterwards, too!”

CLIFF’S TIP

KILLER KIT OF THE PROS #3
Fast lenses
Cliff was struggling to keep up with the action 

with his budget Tamron 70-300mm f/4-5.6 lens, 

so we lent him our Sigma 70-200mm f/2.8 and 

Canon EF 300mm f/4L IS lenses – both more 

affordable equivalents of John’s top-end Canon 

lenses (the EF 300mm f/2.8L IS and EF 70-

200mm f/2.8L IS lenses – pictured). Not only do  

they have 

constantly wide 

apertures (f/2.8 and 

f/4), which meant faster 

shutter speeds for Cliff, but their autofocusing is 

quicker and more accurate, both of which helped 

Jumpers for 
goalposts
Bristol City and Middlesbrough 

play in the Coca-Cola Football 

League Championship – the 

second tier of English footie, 

below the Premiership big  

boys – but, as John explains,  

“You can apply all of these 

great camera techniques to 

any level of football; be that 

Sunday league games or your 

kids having a kick-about at  

the local park.”

JOHN’S TIP

The Photographer’s ApprenticeThe Photographer’s Apprentice
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EXPERT INSIGHT

Pro SLR focusing 
functions

 Cliff’s comment
“I had been trying all day to get a shot of some aerial combat, but even though I diligently watched the ball 

from goal kicks and corners, and focused on players where the play was about to land, it took until the second 

half for me to capture a player in midair, heading the ball. I’m quite pleased with this action shot, though!”  

 Exposure: 1/640 sec at f/4.5, ISO400  
Lens: 70-200mm f/2.8

One of the many benefits of using a 

pro D-SLR like the Canon 

EOS-1D Mk III is the built-in 

Custom Functions, which 

are designed to make 

your life easier. “To 

help me achieve 

focus on fast-moving 

footballers, I use the 

‘Auto Focus/Drive AF 

Expansion with 

Selected Points’ 

Custom Function,” 

reveals John. “This 

enables surrounding AF 

points and increases the size 

of the focusing zone around the 

central AF point, which increases my 

chances of getting sharp action shots.”

The Photographer’s Apprentice



The Photographer’s ApprenticeThe Photographer’s ApprenticeThe Photographer’s Apprentice

62  Landscape Photography Made Easy

-

 Exposure: 1/4000 sec at f/3.5, ISO400  
Lens: 70-200mm f/2.8

Cliff’s comments
“It was a fun day out, rounded off by this 
shot of the Bristol City striker belting in his 
second goal in the final minutes. Shooting 
at f/3.5, I’d zoomed in with the 70-200mm 
to a focal length of around 140mm, 
which has helped to blur the fans in the 
background just enough to isolate the two 
players in the scene. I love the exertion 
displayed on the striker’s face.”  

John’s verdict
“Cliff was an excellent Apprentice. He seemed 
very willing to listen to my advice and then 
put it into practice, as this winning shot ably 
demonstrates. By being positioned low to the 
ground on his stool, he’s reduced the amount 
of grass in the foreground [1]. He’s used a 
wide aperture of f/3.5, which has succeeded 
in blurring the background nicely [2], and with 
his ISO at 400, and resulting rapid 1/4000 sec 
shutter speed, he’s managed to capture the 
Bristol City player Nicky Maynard mid-strike 
[3]. This also proved to be the pivotal moment 
of the match, as this was the goal that beat 
then top-of-the-league Middlesbrough (the 
final score was 2-1)!”

1

23
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“Now I can 
tackle sports 
photography!”

THE APPRENTICE…
Name: Amanda Hinchcliffe
Camera: Canon EOS 5D 

Amanda is a 45-year-old management 
consultant from North Yorkshire who’s loved 
photography for over 20 years. She’s been 
using her digital SLR to photograph her son 
playing county-level rugby. “The pictures 
I’ve taken are okay, but I know they could 
be so much better with the right coaching,” 
she said. “So I’m hoping Chas can help me 
develop my skills!”

The Photographer’s Apprentice The Photographer’s Apprentice
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Learn how to improve your sports  
shots as seasoned rugby photographer 
Chas Williamson helps our Apprentice  
to really raise her game
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“Now I can 
tackle sports 
photography!”

Name: Chas Williamson
Camera: Canon EOS-1D Mk II

Chas has been a professional sports 
photographer for 14 years and Bath 
Rugby’s official photographer for 
the past six years. He runs his CW 
Sports photo agency from Exeter and 
regularly supplies images to national 
newspapers. Go www.cwsports.co.uk 
to see his stunning portfolio, which 
captures the spirit of top-level rugby  
– domestic and international. 

THE PRO...

The Photographer’s Apprentice
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Is Amanda ready  
to tackle pro rugby?

Technique assessment

Chas got Amanda to practice taking shots of Bath 
Rugby during their pre-match warm-up. He then 
suggested a few improvements…

SHOOTING ON AUTO MODE?

USING ONE-SHOT AUTOFOCUS? TRY USING AI SERVO

TRY SHOOTING IN TV MODE

“Amanda was shooting in Auto mode so she didn’t know what to change when 

her shots weren’t sharp – a frequent problem when using her telephoto zoom 

lens,” says Chas. “I got her to switch to the Shutter Priority (Tv) mode to control 

shutter speed so that her camera worked out the correct aperture. I told her to 

increase ISO to maintain a shutter speed of around 1/1000 (or better still, 

1/2000 sec or above) to get sharp, well exposed action shots.”

KILLER KIT OF THE PROS #1
Check out the sidelines of any big sports venue 
and you’ll see rows of pros with big pro telephoto 
lenses. Chas is no different, but favours fixed 
focal length over telephoto zooms. “I always take 
my 300mm and 400mm f/2.8 telephoto prime 
lenses,” he says. “I can zoom in close to the 
action for exciting compositions, plus their f/2.8 
fixed apertures mean I can use higher shutter 
speeds to freeze the action and blur backgrounds 
to focus on the players. These lenses are 
expensive, but I’ve made my money back tenfold 
over the years, thanks to photos I’ve sold.”

“Amanda didn’t realise she could select a different autofocus (AF) mode,”  

says Chas. “We switched her AF mode from the standard One Shot to AI Servo, 

which is perfect for shooting fast-moving sports because the autofocus 

automatically changes as the focusing distance alters. This is essential if you 

want your camera to keep up with the pace of rugby – or any other ball sports, 

such as football.”

Don’t shoot in Auto

Pick the right autofocus

Warm up with  
the teams!
Chas took Amanda to 
photograph the teams as 
they warmed up. “I always 
shoot the pre-match warm-up 
because you can get some 
great shots, plus it’s good 
practice. By doing this you’ll 
be ready to fire off shots and 
capture some cracking 
photos when the game kicks 
off. This also gives you time 
to ensure your kit’s working.”

CHAS’S ADVICE

CHAS’S ADVICE
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For rugby shoots, Chas carries two 
Canon EOS-1D Mk II bodies – a pro 
sports photographer’s camera of 
choice with a lightning-fast 10fps 
burst mode. He also packs this kit: 

Canon 70-200mm f/2.8L IS USM

Canon 400mm f/2.8L IS USM

Canon 300mm f/2.8L IS USM

Canon 1.4x Extender teleconverter

Manfrotto monopod

 Amanda’s comment
“This was early on in the game and with 

Chas’s direction I’d been trying to read the 

game to anticipate where the ball would go 

next – watching key players such as both 

scrum halves and fly halves. I also 

discovered you shouldn’t just follow the 

ball and photograph whoever’s in 

possession. It’s best to stay neutral 

because some of the best shots could 

be of the opposition.”

Go-faster glass! 
 “I soon realised my everyday 100-400mm 

lens wasn’t ‘fast’ enough for sports photos, 

with a minimum aperture of f/5.6 at 400mm. 

Even at a high ISO, I couldn’t get fast 

enough shutter speeds  for sharp 

sports shots. So Chas lent me 

his 300mm f/2.8 lens for the 

day. I could shoot at f/2.8 and 

obtain fast shutter speeds 

between 1/1000 and 1/2500 

secs. Chas later 

recommended buying a 

70-200mm f/2.8 lens. Canon’s 

USM model costs £900, or it’s 

£650 for the Sigma version.”

AMANDA’S TIP

“Amanda was using her 100-400mm f/4.5-f/5.6 lens, 

but when zooming in at 400mm her shutter speed was 

too slow, at around 1/250 sec,” notes Chas. “She 

wasn’t following the rule of matching shutter speeds 

to focal lengths to capture sharp shots. To 

recap, always make sure your shutter 

speed is faster or at least equal to your 

focal length. If you zoom in to 300mm, 

make sure the shutter speed is above 

1/300 sec. Open up the aperture. If 

you’re using your widest aperture – say 

f/5.6 – and can’t select a fast-enough 

shutter speed, then increase the light 

sensitivity, or ISO. Shooting at ISO400 or 800 is fine 

with today’s SLRs, as they reduce ugly digital noise.”   

Shutter speeds 
and focal lengths

EXPERT INSIGHT
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“I like to think of sports photographers as camera assassins who 

don’t miss their targets,” says Chas. “Pretend your camera is a 

machine gun, aim and fire off enough rounds to 

kill each player! Switch to your camera’s 

fastest drive (burst) mode. I always shoot on 

the high-speed drive on my 1D Mark II, which 

shoots 10fps. Amanda’s full-frame 5D can 

still capture 3fps. Start firing early and 

then keep shooting continuously 

through each phase of play so 

you don’t miss any of the 

fast-paced action.”

Be a camera assassin
EXPERT INSIGHT

“Chas told me to check shots on my LCD, and make sure they were sharp 

by zooming in. He also told me to check exposure by calling up the 

histogram, and then to adjust the Exposure Compensation up or down. I 

found it was easy to nudge a dial or button when moving around the pitch, 

kneeling down and firing off masses of shots. So check your settings 

regularly, or you could end up with lots of disappointing photos.”

KILLER KIT OF  
THE PROS #4
Teleconverters offer a cheap 

way to boost the focal length of 

your lenses. “With a 1.4x 

teleconverter the effective focal 

length of my 70-200mm lens at 

200mm becomes 280mm, but 

the aperture drops from f/2.8 to 

f/4,” says Chas. “The weight of 

the big lenses means I 

have to keep 

tightening the 

screws, so  

I always bring  

a screwdriver!”

Check your LCD and settings regularly
AMANDA’S TIP

KILLER KIT OF 
THE PROS #3
“You’ll need a reliable pair of 

waterproof over-trousers when shooting 

sporting events because you’ll be 

kneeling a lot in muddy and damp 

conditions. By kneeling down you also 

get more dynamic compositions and 

your shots won’t be filled with boring 

grassy pitches,” says Chas. “Wear a 

warm hat and decent boots, too.”

KILLER KIT OF 
THE PROS #2
“It’s impossible to hand-hold 

my 1D and big lens for an 80-minute 

rugby match,” says Chas. “To take the 

strain and stay mobile, you’ll need a 

decent monopod – I use a sturdy 

three-section Manfrotto model. A 

monopod also makes it easier to pan, so 

you can capture the action across the 

pitch. Plus, they keep your shots sharp!” 

The Photographer’s Apprentice
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 Amanda’s comment
“I tried to focus on capturing the 

energy of the tacklers. I shot with 

my back to the sun as Chas told  

me to, so I didn’t get overexposed 

backgrounds and underexposed 

players. I wish the background 

wasn’t so cluttered, though.”

 

Shoot JPEG
“I’ll shoot 500 to 1,500 shots per 

match, and I could miss a shot if I was 

shooting in Raw,” notes Chas. “My SLR 

will struggle to keep up as it tries to 

process all those big images. So in this 

case, JPEG is better. I also need to 

email batches of shots to press 

agencies at full time, so I don’t have 

time to process Raw files and convert 

them to JPEGs. Plus, I know what I’m 

doing by now. I ensure I get my 
exposures right when I am shooting 
JPEG, so I don’t need to shoot in Raw 
and rely on Photoshop to rescue any 
poor shots.”  

EXPERT INSIGHT

Take winning shots
“When shooting rugby games, many 

people feel they should photograph 

scrums and line-outs. While these can 

make for classic rugby photos, they 

don’t necessarily make for great action 

shots because you’ll be trying to fit up 

to 16 players into the frame, with them 

all ending up small and insignificant. 

It’s better to focus on small numbers 

of players, such as the front row (see 

the top image, right). You’ll end up with 

a photograph with much more impact 

and emotion.”

CHAS’S ADVICE
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KILLER KIT OF THE PROS #5
Chas uses an Apple Mac laptop because it’s light, reliable 

and easy to use under pressure when he’s processing images 

for the press after the final whistle. It’s a well-built aluminium 

Apple G4 PowerBook with a 15-inch screen that enables him 

to view images clearly, plus it’s fast and powerful enough for 

batch-processing hundreds of JPEGs. See www.apple.com for 

details of the newer and more powerful MacBook and the 

slender MacBook Air laptops now available. Chas also uses a 

Griffgear (www.griffgear.com) hood to shield the screen so he 

can view images mid-game on sunny days.

Chas uses Photo Mechanic  

to browse his match images. 

“There’s no faster software 

than Photo Mechanic for 

browsing and tagging big 

batches of high-res images,” 

he says (go to www.

photomechanic.com to try  

or buy the software). “Most  

of my JPEGs will only ever 

require cropping, a saturation 

boost and a little sharpening 

in Photoshop afterwards.”

EXPERT INSIGHT

Pro software
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 Amanda’s comment
“I was pleased to get this energetic shot because the 

speed of this Bath vs London Wasps game was  

frenetic. I shot it just as the players were still in the 

sunny side of the pitch in the second half.”

It’s not all about action
Take advantage of quiet moments during a match and use the 

time to take some candid photos. “Starts and ends of matches 

are great times to capture the emotions of teams before and 

after battle,” says Chas. “Amanda caught an unobtrusive shot 

of the Wasps players in a pre-match huddle. I also like the shot 

she took of rugby balls in the sun. After all, the whole game 

revolves around this object!” 

Thinking about 
turning pro?
Chas has some pearls of 

wisdom. “Never give your 

photos away for free, as it’s 

not fair on other pros. And 

why not earn money to buy 

better camera kit! To gain 

pitch-side access at 

professional rugby games 

you need to be accredited 

to the Aviva Premiership. 

You’ll need to build up your 

skills first anyway, so learn 

how to take cracking photos 

at your local rugby club first. 

Obviously ask the club’s 

permission beforehand. 

Start off sending your shots 

to local newspapers, or to 

the rugby club, who can use 

shots on their website or in 

match programmes.”

While Chas chooses  

to shoot rugby, the same 

principles apply to soccer 

photography. Don’t expect 

to start off shooting 

Arsenal, build bridges with 

your local football teams…

EXPERT INSIGHT

CHAS’S ADVICE
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“Amanda learned quickly and did really well, keeping up 
with the speed of photographing a professional match.  
I love this shot because she’s managed to fulfil three 
important criteria. [1] She’s frozen the conflict brilliantly 
and brings you into the frame using a wide aperture  
of f/2.8 to blur the crowd. [2] The image captures the 
emotion of the game in the brilliant facial expressions of 
the players. [3] This was also a salient part of the game, 
because the Bath player Andrew Higgins (in midair) and the 
Wasps player Josh Lewsey (who’s just caught the ball) had 
both recently scored. It was a shame Bath lost!” 

Chas’s verdict

“Throughout the day and the match, Chas stressed the 
importance of capturing the energy as well as the emotion 
of the game. With this shot I think I’ve managed to do both. 
I focused on the Wasps player catching the ball and tried to 
fill the frame with him. It was partly luck that I caught the 
attacking Bath player in midair too, although using Chas’s 
300mm lens, my exposure was good and sharp at f/4, 
1/3200 sec and ISO320. The image didn’t need much editing 
– just a crop in Photoshop for a tighter composition.”  

Amanda’s comment

2 13
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“Surf’s up
 dudes!”

Find out how to perfect your surfing photography as our 
Apprentice gets wet in the waves at Newquay with top 
watersports pro photographer Roger Sharp 
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Name: Richard Owen
Camera: Canon EOS 7D
Richard is a 40-year-old magazine editor and keen 
amateur photographer and surfer. Born in North 
Wales, Richard did a photography foundation course in 
Wrexham back in the late ’80s, and he’s more recently 
rediscovered his love for photography after investing 
in a new D-SLR. His love of surfing has inspired him 
to ask for our help to capture more dynamic surf 
photography with his camera.  

THE APPRENTICE…

Name: Roger Sharp
Camera: Canon EOS 7D

Roger is a 39-year-old professional surfing 
photographer and editor of Carve, the UK’s 
biggest and best-selling surfing magazine (www.
carvemag.com). Originally from Somerset, he’s 
been into surfing since he was 15 years old, 
and a pro photographer for past 11 years. Roger 
is now based in London, and regularly travels 
around the world to photograph the big surf – 
more at www.surfphoto.co.uk.

THE PRO...
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After fitting Richard’s camera inside his spare underwater housing, Roger explained how to lock his exposure 
and focus so he didn’t have to worry about camera setting when swimming and shooting in the big waves…

Is Richard ready to catch the waves?

Manual exposure
“Once I’ve taken a meter reading off my hand 

(as it’s the same tone as the surfer), I’ll lock my 

exposure in Manual mode,” says Roger, “In 

sunny conditions, I want a fast exposure to 

keep up with the action, as well as good depth 

of field for sharpness across the frame, so 

around 1/1600 sec at f/8. For this I got Richard 

to up his ISO to 400; on most recent D-SLRs, 

this will result in minimal noise issues.”

Manual focus 
“Using an ultra-wide-angle lens means you’ll 

obtain lots of depth of field anyway, and even 

when shooting with a middle aperture of f/8, 

shots will be sharp from foreground waves to 

background waves behind the surfer,” says 

Roger. “To make sure, I got Richard to lock his 

focus just inside infinity to make sure his surf 

shots would be sharp, from the front to the 

back of the scene.”

Technique assessment

KILLER KIT  
OF THE PROS #1
Wetsuit for 
the waves
Even in the warmer 

months, from California 

to Cornwall, the 

temperature of the sea will 

warrant a wetsuit if you want to stay 

warm. “Don’t forget, you’re likely to be out in 

the waves taking photos for a long time, and 

without a suit, hypothermia could kick in 

quicker than you think,” warns Roger. Hire or buy 

the best wetsuit you can afford.

KILLER KIT OF THE PROS #2
Underwater D-SLR housing

For close-to-the-action surfing shots, you’ll need 

a waterproof housing. Roger uses the 

high-quality pro-level Aquatech (£2,000, 

www.camerasunderwater.co.uk) and SPL 

(£1,075, www.splwaterhousings.com) 

housings, in a custom fit for his Canon EOS 

7D. More affordable options include the 

Hama DiCAPac WP-DSLR1 (£150, www.

hama.co.uk), which comes in one size to fit 

most makes of D-SLR with wide or standard 

zooms. Also check out Ewa-Marine housings, 

around £275 (www.camerasunderwater.co.uk).
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 Richard’s 
comments
“It was fun (and quite 

challenging!), being bashed 

about by the waves while 

keeping hold of my camera in 

the underwater housing. Once 

I got settled into a rhythm, 

I was able to follow the surfers 

and the swell. For this shot 

I was mere metres away from 

surf pro Alan Stokes, and I love 

the intimacy and froth of the 

waves – it really pulls you in 

and makes you feel close to 

the action.”  

Exposure: 1/1600 sec at f/8; ISO400  
Lens: 30mm f/1.4

Two step prep for underwater housings
“For the first time, try out your 

housing without your camera in 

to check it’s set up right and 

totally waterproof! Then fit your 

D-SLR inside and give it a rinse in 

shallow water 

and fully 

submerge to 

check if there 

are any leaks 

– check seals 

and screws are 

all secure if not.

With dome ports, 

lick (yes, lick!) 

the outer lens 

window – this 

stops seawater 

clinging to the 

outside and 

ensures it’s drip-free, to stop the 

splashes ruining your shots. Then 

you’re ready to swim out into the 

waves and get shooting!”

Weather and wave watch
Planning ahead is the key to the success of 

your surf photoshoots, Roger reveals, “For 

surf pictures you ideally need three things: 

good waves, good weather, and a good 

surfer or two! I check www.magicseaweed.

com as it gives the best indication, telling 

you wind strength and direction and swell 

levels.” Avoid strong onshore winds as it 

ruins the waves, rendering them faceless 

and unrideable for surfers.

ROGER’S TIP

ROGER’S TIP
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EXPERT INSIGHT

Buying underwater housings
Design and build

1 Is the D-SLR waterproof 

casing ergonomically 

designed? How long does it take 

to set up and are you able to 

reach all of your camera’s buttons 

and dials from the outside? Does 

the casing have a ‘port’ to 

accommodate your lenses and 

ensure the best optical quality? 

Ports are often sold separately.

Going deep?

2 Top-end underwater housings 

will keep your D-SLR dry at 30 

metres-plus below the surface – 

but if you’re not into deep-sea 

diving, and only plan to use your 

D-SLR when snorkelling or for surf 

photography, consider a more 

basic option. 

100% waterproof

3 High-spec underwater 

housings are only as good as 

their seals. If you damage the 

O-ring inside the seals you’re likely 

to start letting water in and do 

serious damage to your camera!

KILLER KIT OF THE PROS #3
Fisheye or ultra-wide-angle lens

“Tokina’s 10-17mm f/3.5-4.5 AT-X DX is the current 

surf photographers’ ultra-wide-angle lens 

of choice when using the crop-factor 

cameras,” reveals Roger. “It’s 

sharp and reliable and doesn’t 

distort shots too much, either. 

However, I had to modify the 

built-in lens hood with a 

hacksaw so it fitted inside my 

underwater housings!”  
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 Richard’s comment
“This surfer was carving a nice turn, so I was happy to get a 

shot with a good dynamic body position in the bag. But he 

appeared too small in the frame as I was quite far away. 

Thanks to my camera’s 18-megapixel sensor, cropping the 

image in half still leaves me with a very usable photo that’s 

big enough for A4-size or equivalent prints. As I cropped I 

repositioned the rider using the rule-of-thirds overlay grid to 

position him surfing into the space.”  

Exposure: 1/1600 sec at f/8; ISO400  
Lens: 30mm f/1.4 

UNCROPPED CROPPED

Safety first!
It’s dangerous floating around in the waves with surfers whizzing 

past your head, so don’t attempt surf photography in big waves 

unless you’re a strong swimmer or, better still, an 

experienced surfer who understand the waves. 

“Start out with a 100mm lens to shoot in 

the water from a safe distance,” 

suggests Roger, “then, as your 

confidence grows, try shorter focal 

lengths. Finally, only when you’re 

ready to be less than a metre 

from the surfer in the barrel, go 

with the fisheye lens…”

ROGER’S TIP
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Sports & Action Photography Made Easy  79



The Photographer’s Apprentice

Take your pick from a high-speed sequence!
“Shoot using your camera’s 

high-speed continuous drive mode to 

give yourself more chance of taking a 

winning shot,” advises Roger. “On my 

7D, it rips off eight frames per 

second, giving me more shots of a 

single surfing sequence, from which 

I can then pick the best photo.”

Roger favours the semi-pro Canon 
EOS 7D as it’s light and fast, ideal 
for using in a sea housing, the 
crop factor extends telephoto 
lenses, and it’s great for video 
capture, too. He also uses the 
following lens and kit:

ROGER’S TIP

Tokina 10-17mm f/3.5-4.5 AT-X DX

Sigma 30mm f/1.4 EX DC HSM

Canon EF 85mm f/1.8 USM

Canon EF 200mm f/2.8L USM

Canon EF 300mm f/2.8L IS USM

Canon EF 600mm f/4L IS USM

Aquatech and SPL underwater 

housings

Manfrotto 695CX monopod

Manfrotto 190CXPRO4 tripod 

Manfrotto 501HDV pro video head

The Photographer’s ApprenticeThe Photographer’s Apprentice
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 Richard’s comment
“For this shot from the waves, Roger suggested I get 

more creative and go wider to try and include some 

of the mainland to add context and create a sense 

of the location near the cliffs. I love the scale, with 

the surfer smaller in the frame, and the big expanse 

of blue sky with white clouds. The surfer’s body 

shape and the line of the waves leading into the 

rocks also really makes this shot work.”

Exposure: 1/1600 sec at f/8; ISO400  
Lens: 30mm f/1.4

Pick your moment 
“The sea can be a busy place, with many surfers jostling 

for position on the best waves, or swimming out while 

others are riding the waves,” warns Richard. “When 

shooting, try and pick out good individual riders and avoid 

other surfers in your shots as they’ll distract from your 

main surfer subject and spoil your shot!”

RichaRd’S TiP

Fast memory cards
“Initially I was using my own cheapo memory card but found 

that, when shooting in Raw on my 7D in High-speed 

Continuous drive mode, I was hitting the buffer all too 

quickly, which meant I had to wait – and miss some great 

photo opportunities. I switched to a Lexar Professional 

300x UDMA CompactFlash card and the difference was 

incredible; no more delays!”

RICHARD’S TIP
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Check the 
histogram
“Shooting surfers in black wetsuits 

against bright white frothy waves 

can be challenging, so I always 

refer to my histogram when 

reviewing my shots to check 

exposures to see if any 

highlights are clipped. If they 

are, I then dial in negative 

exposure compensation to 

darken them,” says Roger.

KILLER KIT OF 
THE PROS #5
Carbon fibre monopod
“As I travel around the globe 

chasing the waves, I’m 

constantly on planes, so I 

need light and compact kit. 

My Manfrotto 695 carbon 

fibre monopod (around £165) 

is light and, thanks to its 

five-section setup, compact 

for tucking away in bags, plus 

it’s strong enough to support 

by big lenses to take the 

weight and ensure I get 

shake-free surf shots.”

KILLER KIT OF THE PROS #4
Fast telephoto prime lens
For shooting surfers from the beach you’ll need a long telephoto 

lens. “I use a pro 300mm f/2.8 lens that’s super-fast to focus 

and super sharp,” says Roger, “On my 7D, with its 1.6x crop 

factor, the 300mm has an effective focal length of 480mm; more 

than enough reach to fill the frame with wave action.”

ROGER’S TIP
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 Richard’s comment
“I was shooting most of my shots in 

horizontal (landscape) orientation, so I 

tried a few shots in vertical (portrait) 

format and scored this gem! I like the 

rider’s trailing hand, and the out-of-focus 

seawater in the foreground and 

background really draws the eye towards 

the surfer. I also left space in my 

composition for the surfer to ride into.”

Exposure: 1/1000 sec at f/6.3; ISO200  
Lens: 150-500mm f/5-6.3

Lens 
switching
“Roger reminded me 

that camera kit doesn’t 

like sand or seawater,” 

says Richard, “so he 

simply said to avoid 

changing lenses on the 

beach. It’s an obvious 

thing to point out 

perhaps, but Roger 

emphasised the 

importance of taking 

good care of your kit 

– and how a little sand 

or seawater inside a 

lens, or worse, inside 

your D-SLR body, could 

cause major problems.”

EXPERT INSIGHT

The Canon EF 300mm f/2.8L IS II that Roger uses, and the 

Nikon equivalent AF-S 300mm f/2.8 G ED VR II, both sell for 

as much as £5,000, so consider looking on eBay for 

second-hand 300mm f/2.8 lenses – visit 

the seller and try before you buy and you 

won’t go far wrong. Other more 

affordable telephoto lens options are 

300mm f/4L (Canon and Nikon both 

make one for around £1,000) or consider Sigma’s 300mm 

f/2.8 EX DG HSM (around £2,200). Alternatively, consider 

a telephoto zoom, like the Sigma 150-500mm f/5-6.3 DG 

OS HSM (around £850) that Richard was using.  

Pro lens envy

RichaRd’S TiP
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[1]

[3]

[2]

Exposures: 1/1600 sec at f/8; ISO400
Lens: 30mm f/1.4

Richard’s comment
“I managed to grab this shot while swaying 
about in the waves, framing and shooting 
quickly before the wave crashed on top of 
me! Stokesy was an amazing surfer and 
was able to pull some very impressive tricks 
off medium-sized waves, which I’ve tried to 
capture here. There are a couple of drips 
on the underwater housing port over the 
seawater in the foreground, but I don’t think 
that spoils my shot too much!”  

Roger’s verdict
“Richard had a good eye for a great surfing 
shot! He’s captured nice sidelight from the 
sun [1], highlighting the surfer to draw him out 
of the surroundings. A fast 1/1600 sec shutter 
speed has captured the burst of movement 
of the wave as Stokesy pulls off a 180-degree 
aerial [2]. Strong framing of the subject 
(following rule of the thirds) has the surfer 
pointing back into the space for a balanced 
composition [3]. Good work!”
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Want to shoot motor sports but find that it’s all just a 
blur? Learn how to take better racing car shots as our 
Apprentice gets pro tuition at Brands Hatch

“My photos have 
gone from the 
 pits to the 
  fast lane!”

The Photographer’s Apprentice
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Name: Drew Gibson
Camera: Canon EOS-1D Mark II 

Drew, 24, is a full-time photographer  
for the world-renowned motor sports 
photo agency LAT Photographic. He 
regularly travels the globe to shoot 
Formula 1 races, as well as British 
Touring Car Championship events. Drew 
also won the MSA Young Photographer 
of the Year Award in 2007.

THE PRO...

THE APPRENTICE…
Name: Lee Woodhams 
Camera: Canon EOS 400D

Lee is a 29-year-old motor sports fan 
from Dorset. He’s a full-time electrical 
engineer and is also a part of the HPM 
Hyundai World Cars service crew. He 
often photographs motorsports, but 
needs help with his mode settings, 
exposure and panning techniques when 
shooting at events.  

The Photographer’s Apprentice
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Is Lee ready to go flat out?
Technique assessment

Drew assessed Lee’s settings while practising in the pits, and recommended a couple of changes…

Canon’s EOS-1D is massively popular 

with motorsports photographers 

because it offers a fast drive mode 

paired with a bullet-proof build. Drew 

uses a 1D Mk II, for its 8.5fps shooting 

speed, and a full-frame 1Ds Mark II. He 

also carries the following lenses:

Canon EF 16-35mm f/2.8L USM

Canon EF 50mm f/1.4L USM

Canon EF 70-200mm f/2.8L IS USM

Canon EF 200mm f/1.8L USM

Canon EF 500mm f/4L USM

Canon EF12 extension tube

Lee was using 
Tv Mode 

SHOOTING IN  

Tv MODE?

Keep control in Manual mode
“Lee had been using the Shutter Priority (Tv) mode,” says Drew. “But this 

mode can produce unpredictable results if cars are darting in and out of 

shadows, if a white car comes into shot, or if you’re shooting directly 

towards or away from the sun through a corner. Shooting in Manual gives 

you total control, because you dictate the aperture and shutter speed for 

consistent exposures.”

Shoot with Raw back-ups 
“Lee was shooting high-res JPEGs, but I encouraged him to switch to 

JPEG+Raw” says Drew. “That way, if you get the shot in the bag the JPEG is 

ready to go with minimal processing time. But if a shot you wanted is under- 

or overexposed, you have the Raw file to use as a backup to rescue in 

Photoshop. I rely on JPEG+Raw because I have to process images quickly to 

get them onto our website for the press.” 

SHOOTING jPEGS?TRy SWITCHING  

TO MANuAL
TRy SHOOTING 

jPEG+RAW
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 Lee’s 
comment
“Drew talked a lot about 

the first corner being a 

great spot for photos. The 

drivers really go for it to 

get into pole position, and 

as they’re bunched 

together there’s the 

potential to capture any 

drivers being bumped or 

crashing off the track. 

There weren’t any 

first-corner spills in the 

races we shot, but I did 

manage to get this image, 

which tells the story of 

the race. The three 

drivers are fighting hard 

for first place.” 

KiLLeR KiT oF THe PRos #1
Extension tube
“I always carry an extension tube,” says 
Drew. “It takes up little space in my bum 
bag and is great for converting my 50mm 

f/1.4 lens so I can use it to take 
close-ups of car badges and 

details. I also use it for 
shooting close-up portraits 
on my 200mm f/1.8 lens. 
It only costs £70, so it’s a 
cheap and convenient way 

of converting your existing 
lenses for macro 

photography.”

“Positioning yourself so you can get 

a ‘straight on’ composition of the 

action has three main benefits,” 

says Drew. “Firstly, because the cars 

are racing towards you it means 

they’re coming into the frame, not 

past it, which gives you slightly more 

time to take your shots. Second, if 

the cars were whizzing past you at 

right-angles you’d need to pan to 

keep up with their speeds, which 

results in a blurred background 

(more on that later). Third, by 

shooting straight on you can 

compose the shot and let the action 

come to you. This means you can 

hold your body position as still as 

possible, which freezes the action 

and any crowd movement in the 

background.”

your position  
and compositions

“I usually get to events at least two hours 

before the first race so I can prepare 

ahead for the day’s shoot. This also 

means I have time for candid shots in 

the pits before the warm-up laps. You 

don’t always need a press pass to gain 

access, though. There are usually times 

on the day when the public can walk 

around the pits to take photos. Also, 

make sure you get a race schedule 

straight away so you can carefully plan 

your day. Get to your first spot on the 

track before the drivers do any warm-up 

laps, as you may get some cracking 

shots before they start racing flat-out. 

This also gives you a chance to get your 

eye in and your D-SLR techniques down, 

ready for the main races.”

DREW’S TIP

EXPERT INSIGHT

Before the racing begins

  Exposure: 1/640 sec at f/2.8, ISO200  
Lens: 70-200mm f/2.8
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  EXPERT INSIGHT

Lee’s EOS 400D has three autofocus (AF) 

modes: One Shot, AI Focus and AI 

Servo (called Continuous Focus 

on Nikon cameras). “Lee was 

shooting in the standard One 

Shot AF mode when we 

began at Brands Hatch,” says 

Drew. “I suggested he switch 

to AI Servo when shooting 

moving targets such as racing 

cars. On this AF mode his camera 

automatically adjusts as the 

focusing distance changes.”

Choose the best 
autofocus mode

KILLER KIT OF THE PROS #2
Travelling light
Drew doesn’t like to carry big camera 

bags. Instead he carries his equipment 

over each shoulder and uses a bum bag 

for accessories. “All I need is my 16-35mm 

f/2.8 and 50mm f/1.4 lenses, an 

extension tube, a 1.4x 

teleconverter, spare  

memory cards and a 

chamois leather cloth to 

protect and wipe my camera 

or lenses if it rains,” he says.

DREW’S TIP

“Grab a map of the race  

track and get a feel for where 

will be good spots for photos. 

Work out whether you need to 

be inside or outside the track. 

Corners are great because the 

cars come in a little slower – 

which is easier for shots – slide 

around, then accelerate out of 

the apex – which is good for 

blurred panning photos. Do 

your prep well before the races 

begin, because working out 

how long it takes to get from 

one corner to another can be 

the difference between 

capturing all the action or 

missing half of it!”

working out logistics

Panning and slow shutter speeds
DREW’S TIP

“Panning is a great way to emphasise 

speed, enabling you to blur a little or a 

lot of the moving car. When shooting in 

manual focus, with your lens at  

a focal length of around 70mm to 

100mm, start off by shooting at 1/100 

sec and adjust the aperture for a 

correct exposure. As your timing gets 

better, start dropping the shutter 

speed. The slower the shutter speed, 

the more blur you can achieve on the 

cars and in the background.”
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 Lee’s comment
“Drew was helping me with my panning technique on a tighter, slower 

corner for this shot. He said autofocus is intelligent, but unpredictable 

and slow for motor sports. By switching to manual focus, I could pre-focus 

on the racing line and just press the button when the cars passed by. 

After gaining confidence with my panning, I could also look at composition 

– this shot works better because the car has space to drive into.”

When you’re photographing 

motorsports, you need to take  

a number of shots in quick 

succession if you want to 

capture the action – Drew got 

Lee to switch his Drive mode 

from Single Shooting to 

Continuous Shooting. You’ll 

also need to carry more 

CompactFlash cards, because 

you’ll be taking lots of shots. “Lee’s 

400D captures 3MB JPEGs and 

10MB RAW files,” says Drew, “but I 

need to carry higher capacity cards 

as my 1D produces higher-res 

images, and larger file sizes.”

Setting your  
camera for speed

LEE’S TIP

Fill the frame
“Drew told me to compose my 

shots so that I photographed  

a ‘suggestion’ of the race. He 

told me to zoom in for a more 

explosive composition and to 

concentrate on just two or 

three cars.” 

  Exposure: 1/50 sec at f/20, ISO100  
Lens: 17-85mm f/4-f/5.6 

EXPERT INSIGHT
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Always be ready to capture the action – and that 

includes the crashes! Lee was faster off the mark 

than Drew, capturing this crash because he was 

focusing on the corner with a telephoto zoom 

lens and a shutter speed of 1/100 sec, while 

Drew was taking panning shots using a wide-

angle lens. “Lee wasn’t able to focus quickly 

enough or up the shutter speed to get the shots 

sharp,” says Drew, “but he still did really well to 

capture the one big crash of the day!”

The sky’s  
the limit
“As soon as the sky 

becomes a factor in 

your photos, you’re 

presented with an 

added complication: do 

you expose your shots 

to get detail in the 

motorsports and track 

background, or in the 

lighter sky? You can 

avoid the problem 

completely, simply  

by composing shots 

without any sky in 

them. By doing this the 

brighter sky doesn’t 

complicate your 

exposures.”

DREW’S TIP

KILLER KIT OF THE PROS #3
500mm f/4L telephoto prime
Brands Hatch is one UK race circuit that 
enables photographers to get close to 
the track, so you don’t need a massive 
telephoto lens to achieve tight 

compositions. “Access at a lot of other

circuits isn’t so accommodating, and that’s when 
a big telephoto lens is essential,” says Drew. 
“I prefer fixed focal length lenses for high quality 
photos, and my 500mm f/4 lens enables me to 
fill the frame, capturing some stunning action 
shots even though I’m a distance from the cars.”
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 Lee’s comment
“I’m particularly pleased with this shot of the 

Porsches, because I picked my composition and 

exposure without any guidance from Drew. I shot this 

on a 70-200mm f/2.8 lens at f/4.5 and at a shutter 

speed of 1/500 sec because this was a fast corner, 

but if I’d shot it at around 1/250 sec the cars would 

have had a little motion blur. I’d like to have caught 

more of the corner in the top left, too.”

Exposure Compensation
“Drew suggested I shoot one stop underexposed so the cars’ windows wouldn’t appear 

too bright and, more importantly, I could see the drivers inside. To make your exposure 

one stop darker when shooting in Manual on a 400D, click the top dial three times to 

the right, selecting a faster shutter speed and therefore a darker exposure.”  

  Exposure: 1/500 sec at f/4.5, ISO100 
Lens: 70-200mm f/2.8

LEE’S TIP
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“Lee has captured a great action shot that I’d have been 
pleased to get myself! The strongest part of this image is 
the composition [1] – the ‘S’ shape of the track running 
through the frame draws the eye right through the line of 
cars and really tells the story of the race. using Manual 
mode and a slow shutter speed has enabled Lee to give 
the cars a sense of speed and movement [2]. By taking 
control of his exposure, Lee has been able to maximise the 
late afternoon sunshine to produce vibrant and contrasting 
colours. Finally, by panning, Lee has given the image a 
focal point in the red vauxhall – it’s sharp in the frame and 
stands out from the rest of the field [3].”

Drew’s verdict

“Interestingly, this was one of the last action shots I 
took on the day. I’m pleased that I used all I’d learned 
from Drew and put it all together to capture this great 
shot. I love the composition with the orange Honda’s 
blur leading you into the shot, the sharpness of the red 
vauxhall central to the frame, and the three slightly out-of-
focus cars exiting top right.” 

Lee’s comments
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Sports & Action Photography Made Easy  95

  Exposure: 1/125 sec at f/9, ISO100 
Lens: 70-200mm f/2.8 
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Name: Dan Milner
Camera: Canon EOS-1D Mk II

Dan’s the man when it comes to 
winter sports photography. A pro for 12 
years, he’s been senior photographer 
for Snowboard UK magazine for the 
past eight years, and also regularly 
contributes to over 15 ski and 
snowboard magazines around the 
world. British-born Dan, 41, has been 
based in Chamonix in the French Alps 
for the past eight years. View his great 
portfolio at www.danmilner.com.

THE PRO...

THE APPRENTICE…
Name: Greg Watts
Camera: Canon EOS 400D

Greg, 39, is from Oxford, but spends  
a lot of time skiing and working in the 
French Alps. He started out with a film 
SLR but upgraded to an D-SLR two 
years ago. He wants to learn how to 
take exciting action shots of winter 
sports in the mountains, but so far he 
hasn’t had much success. 

The Photographer’s Apprentice
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“So that’s 
how you 
freeze the 
action!”
Learn how to master winter sports photography as experienced pro 
Dan Milner shows some cool techniques in the chilly French Alps 
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Ditch the tripod
“Contrary to popular belief, you don’t need to use a tripod to 

capture cracking action shots,” says Dan. “As we’re shooting 

at 1/1000 sec (see below) we’ll easily get pin-sharp shots of 

the action when shooting handheld. This also gives you much 

more freedom: you can track your rider on the snow or in 

midair and move from spot to spot to improve composition. 

Plus, it’s one less heavy item to lug around the mountains.”

Use Shutter Priority mode
“I normally shoot in Manual, but I didn’t want to confuse Greg 

by giving him too many things to think about today. For 

amateur photographers like Greg trying their hand at action 

sports, the Shutter Priority mode is perfect for keeping the 

shutter speed fast enough to capture fast-moving sports. 

I got Greg to set his camera at 1/1000 sec and told him to 

leave it there for the first few shots.”SWITCH TO Tv MODE

Is Greg’s camera set  
up for action sports?

Technique assessment

Dan got Greg to set his camera up as he normally would for winter 
sports photos, and then suggested a few improvements…

DAN’S ADvICE

As well as his stalwart, rapid-fire 

Canon EOS-1D Mark II N, Dan also 

carries a full-frame Canon EOS 5D  

and the following top lenses:

Canon 17-35mm f/2.8L

Canon 28-70mm f/2.8L

Canon 70-200mm f/2.8L

Canon 15mm Fisheye f/2.8L

DAN’S ADvICE

Telephoto zooms
“A quality telephoto  

zoom lens is essential for 

capturing fast action. My 

70-200mm f/2.8 lens enables 

me to use rapid shutter 

speeds between 1/1000 and 

1/2000 sec, and also to crop 

in tight for more dynamic 

shots while I’m stood safely 

on the side of the ski runs,” 

says Dan. “I encouraged Greg 

to use his Tamron 18-250mm 

f/3.5-6.3 telephoto zoom 

(below) so he could use it to 

create better compositions.”

98  Sports & Action Photography Made Easy

The Photographer’s Apprentice

TRy SHOOTING HANDHELDUSING A TRIPOD?

SELECTED THE P MODE?

The Photographer’s Apprentice



The Photographer’s Apprentice

The Mount Everest-ready 

Rab (www.rab.uk.com) 

goose-down filled 

Neutrino jacket was 

ultra warm, even high 

up the mountain when 

it was very windy and 

snowing. Price: £180.

What to wear 
on the slopes

Greg’s comments:
 “From my first set of shots, Dan helped me to 

produce this gem. I pre-focused on the spot where pro 

snowboarder Johno was going to hit and I tried to 

compose the shot to obey the rule of thirds, too. Dan 

told me ‘a good action photo tells a story’. In this case, 

Johno has slammed hard into a steep turn in 

powdered snow, leaving a tell-tale wake behind.”

EXPERT INSIGHT

DAN’S ADvICE

Make your snow 
whiter than white
When shooting snow your camera will  

try and make the whites grey, because 

it thinks the shot will be overexposed. 

“To combat this problem you need to 

put your Exposure Compensation up to 

+1 stop,” says Dan. “This will ensure 

the snow in your shots is exposed as 

white, not grey.”

Pre-focusing for 
capturing action photos
“You can’t always rely on your camera’s 

autofocus mode to be quick enough  

to capture the action, especially if  

you can’t track the subject with an 

autofocus point before you take the shot. 

Switch to manual focus on your lens and 

then pre-focus on a spot in the snow where 

you know where your subject is going to 

hit. Use your zoom lens to zoom 

in on the point, focus 

accurately and then pull 

out again to frame the 

shot. All you have to do 

then is time it right and 

press the shutter as 

they fly past!” says Dan.

It goes without saying that you’ll need 

to wrap up warm when temperatures 

drop below freezing. Padded and 100% 

windproof clothing is a must when 

you’re shooting winter sports… 

Don’t forget your shades or 

goggles, because it’s mighty 

bright when the sun’s 

bouncing off the snow. Wear 

high factor sunscreen, too.

Rab’s weather-resistant  

Trail Pants (£65) protected our legs. 

Warm, grippy footwear is also a 

must. We hired these for €30 a 

week. Even in snow three-feet 

deep we didn’t get cold toes. 

We also wore an Outdoor 

Designs’ (www.outdoor designs.

co.uk) Power Beanie (£12) to 

keep our heads and ears warm, 

a Chili Tube neck snood (£15) 

and two layers of gloves: a thin 

base layer silk glove (£12)  

so we could still feel our 

camera’s button, and Kona Grip 

Convertible mitts (£25) that 

flipped up/down.
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Like all good pros, Dan is an advocate of 

shooting in Raw format. He got Greg to 

switch from JPEGs. “It’s good practice  

to shoot Raw anyway, and even more so 

in snow because you may need to 

adjust your white balance as well as 

boosting your levels, saturation and 

contrast to enhance snowy backdrops. 

The most professional way to do that, 

and to end up with realistic results, is to 

shoot in Raw,” says Dan.

DAN’S ADvICE

The Photographer’s ApprenticeThe Photographer’s Apprentice
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It’s all a matter of timing!
GOOD – BUT TOO EARLy GOOD – BUT TOO LATE PRO CHOICE

EXPERT INSIGHT

“I use AI Servo autofocus (AF) 

mode as it’s great for shooting 

moving subjects when the 

focusing distance keeps 

changing,” says Dan. “Note that 

the AF doesn’t beep, even when 

it’s focused on a subject. Also put 

your camera in its highest speed 

burst mode – 3fps on Greg’s  

camera – and hold down the 

shutter button to increase your 

chances of a sharp action shot.”

AI SERvO AUTOfOCUS BURST MODE

Greg’s comment
“This was the only time Dan got me to drop the shutter speed 

down from the magic 1/1000 sec, because we needed to pan 

from right to left to freeze the skier in action, as well as creating 

a blurred background to add a sense of movement. I got this 

‘panning for gold’ shot at 1/80 sec,” says Greg. “I also used AI 

Servo autofocus.”

 Dan added: “Panning is also great for blurring unwanted 

backgrounds, such as the ugly orange netting on this ski run 

and in the background of Greg’s shot. Panning is also a clever 

technique that allows you to photograph skiers who aren’t 

moving that fast, and make them look like they’re pros going 

flat-out down the mountain by adding a blurred backdrop.”

“I’ll do this next time I photograph my wife cruising down the 

mountain!” laughs Greg. 

EXPERT INSIGHT

Autofocus and burst mode

A fraction too late. Ideally, a shot in-between this 

and the previous shot would be perfect. The max 

3fps offered by Greg’s camera was a bit slow. A 

higher-spec camera, with 6fps on high-speed 

burst, would give twice the amount of shots.

We weren’t too sure about this shot, because 

the rider has all-but-disappeared, but for Dan 

this is the best of the three. His trained eye can 

tell that the rider’s just carved a big fat turn, 

and he loves the overall composition.

We liked this photo, with Johno’s dynamic 

body shape and a good composition, but  

the shot is actually premature. As Dan, who 

has an experienced eye, explained, “The 

rider has yet to make the steep turn.”
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EXPERT INSIGHT

“Greg was struggling to capture an energetic shot of 

Johno skiing past,” says Dan. “He was shooting 

horizontal (landscape) and Johno was too small within 

the frame (below). I suggested switching to vertical 

(portrait) because a skier will only get taller, not wider, in 

the frame. Greg swapped and captured this great image 

(right) straight away.”

Horizontal and 
vertical compositions

Always carry 
spare batteries 
“When temperatures really 

drop, battery power is 

drastically reduced to the 

point where they go dead. 

They’re not actually fully 

drained, just too cold to 

work,” says Dan. “I avoid this 

problem on cold shoots in 

the snow by keeping a warm, 

spare battery or  

two in my inside jacket 

pocket that I can swap if 

necessary. When the cold 

battery warms up you’re 

good to use it again.”

DAN’S ADvICE

KILLER KIT Of 
THE PROS #1
“When shooting in the snow and 
towards the sunshine, you have a 
much higher chance of glare and 
unwanted light getting into your 
lens,” says Dan. ”I told Greg to 
always use a lens hood to help 
him avoid this problem and to 
control only the light he wants 
reaching his lens and camera’s 
sensor. It worked for me!”

The Photographer’s ApprenticeThe Photographer’s Apprentice
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GREG’S TIP

Zoom in on your LCD
“When reviewing photos on your LCD, use the zoom 

button to go in close and check the action, not the 

background, is sharp,” says Greg. “A common mistake 

I was making was to focus on background mountains 

or trees, rather than the snowboarder.”

EXPERT INSIGHT

Greg’s comments:
“I’m chuffed with this shot of Johno doing a classic 

move. I used manual focus and pre-focused on the top 

lip of the snow ‘pipe’. By using my Tokina 12-24mm f/4 

wide-angle lens to get down low and close (about  

one metre from Johno) I captured this intimate,  

nicely composed action shot.”

Our pro snowboarder
Johno Verity, 28, is one of Britain’s best pro 

snowboarders. Originally from Wiltshire, he’s now 

based in Chamonix and is sponsored by Atomic 

boards, Animal clothing, 

Vans boots and 

Adidas eyewear.

Directing the shoot
“As a photographer, you need to take control on 

action shoots and tell your subjects where you need 

them to ride past, jump from and whether to make a 

left or right turn to get the shot you’re after,” says 

Dan. “Having discussions with Johno and showing 

him our shots on our LCDs helped to build trust 

between us all as well.” 

The Photographer’s Apprentice
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Greg’s 
verdict
“Before I’d spent the day with Dan 
I really struggled to capture any 
decent sports shots on the slopes. 
But with Dan’s advice and guidance 
I had great success, and I am 
particularly pleased with this shot 
of Johno in midair. Using my Tokina 
12-24mm f/4 wide-angle I was able 
to get in close for a dramatic view 
from below as Johno jumped over 
the top of us! By shooting 1/1000 
sec at f/6.3, and ISO100, I was able 
to freeze his movement nicely, and 
with the Exposure Compensation 
at +1 stop I still kept good detail in 
the snow. I’m really chuffed with 
the result!” 

“Greg had a fairly good eye for an 
action shot but needed some help 
with setup, composition and pre-
focusing. In this shot he’s nailed 
all three – it’s a stunning shot of 
pro snowboarder Johno getting 
some big air off this snowy drop-
off. His decision to take the shot 
from below is bang on [1], as is his 
composition with Johno captured 
perfectly in midair in the top-right 
third [2]. Using manual focus, he’s 
also pre-focused in the ideal spot 
[3], ready to shoot Johno as he 
grabs his board in a nice ‘hand-
grab air’ move.” 

Dan’s 
verdict

1

2

3
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Greg’s comment:
 “Dan helped me get this cool midair action shot just before the sun 

set. Because it was darker he got me to use a little fill-in flash, which 

meant dropping the shutter speed to 1/200 sec.  

I really like the explosive composition.”

The Photographer’s Apprentice
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“The need 
 for speed!”   

Name: Adam Duckworth
Camera: EOS-1D Mk IV

Based in Northampton, 44-year-old Adam 
is a hugely experienced award-winning 
photographer and ex-editor of motorcycle 
magazines. He’s been professional since  
1987, concentrating on motorbike and 
motocross photography, and has shot at 
tracks all over the world for top magazines and 
newspapers. Visit www.adamduckworth.com. 

THE PRO...

The Photographer’s ApprenticeThe Photographer’s Apprentice

Learn how to capture high-octane motorsports 
shots as our Apprentice gets pro tuition at a 
British Superbike race at Brands Hatch… 
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THE APPRENTICE…
Name: Gary Lambert
Camera: Canon EOS 7D

Gary is a 37-year-old Quality Engineer from 
Eastbourne. He’s been a keen photographer 
for the past ten years, having bought his first 
D-SLR, a Canon EOS 300D, in 2004. Last year he 
bought a Canon EOS 7D, and really got hooked on 
motorsports photography after taking photos at 
the Grand Prix at Silverstone. 
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Technique assessment

Is Gary ready to shoot the action?

Autofocus modes
“Gary was using the AI Focus AF 
(autofocus) mode, which switches 
between One-Shot and AI Servo AF,” 
says Adam. “I got him to stick to using  
AI Servo AF as it’s the autofocus mode 
specifically designed for shooting 

Shooting modes
“Gary was getting mixed shots shooting 
in Shutter Priority (Tv) mode ( so I 
encouraged him to shoot in Manual for 
full control and consistent results,” 
explains Adam. “I always take a meter 
reading off the grey race track before 

moving targets like motorsports. 
Once you’ve focused, you can track 
your subject. But note the beep 
doesn’t go off when your D-SLR 
achieves focus, like it does when 
using One-Shot.”

the bikes start, setting a shutter 
speed around 1/400 sec, then 
simply dial in an aperture (in this 
case f/8) until the marker is in the 
middle on the Exposure Level 
Indicator for a good exposure.”

MANUAL CONTROL! 

TRACK AND SHOOT!

Canon EOS 5D Mk II spare body

Canon EF 500mm f/4L IS

Canon EF 400mm f/4 DO IS

Canon EF 70-200mm f/2.8L IS

Canon EF 24-70mm f/2.8L

Canon EF 85mm f/1.2L

Canon EF 24mm f/1.4L

Canon EF 16-35mm f/2.8L

3x Canon 580 EX II Speedlites 

Pocket Wizard Flexes and Minis

As well as using the rapid-fire 

pro Canon EOS-1D Mk IV  

(see right), Adam uses the 

following pro lenses and kit:

Top shooting spots
Adam stressed to Gary the importance of getting 
a good position as without it you won’t be able to 
take good motorsports shots. “I usually have a 
press pass for race days, which means closer and 
clear access to the track,” says Adam, “But today 
I was able to prove to Gary that with a bit of 
forethought, and studying the map of the track, it 
was possible to get a good position trackside with 
the general public, and without an obstructed view 
of the track for a clean shot.”

ADAM’S TIP

After Gary had photographed a few laps of the bike racing, Adam suggested a few ways to increase his success rate…
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EXPERT INSIGHT

Learning how to pan is an essential skill for motorsports 

photography, here’s how it’s done by the pros: “Stand 

trackside, feet about a shoulder-width apart and make 

sure you have room either side of you to swing your 

elbows from left to right,” says Adam. “Start off with a 

shutter speed around 1/500 sec – depending on the 

riders’ speed – and work down to 1/160 sec as your 

panning skills progress. With your D-SLR in AI Servo AF, 

you need to track the rider in your frame as they race 

through the entire corner. Position your selected AF 

point over the their helmet/front of the bike, gently 

squeezing the shutter button to shoot continuously 

before, during and after they exit the corner, swivelling 

in a smooth 180-degree arc as you shoot.  

Exposure: 1/400 sec at f/8; ISO100
Lens: 70-200mm f/2.8

 Gary’s comment
“This was shot early in the day 

inside Druids Bend. Following Adam’s 

sound advice, I shot in Manual mode 

and set a slower shutter speed of 

1/400 sec and panned to capture 

motion blur in the background and a 

sense of speed. I dialled in +2/3 

stop of Exposure Compensation to 

brighten up shot, and used a longer 

focal length of 200mm to fill the 

frame with action. The section of 

kerb reflected in the rider’s visor also 

helps bring the shot to life.”

Potential pitfalls to avoid…
The whole shot, and crucially the 

main motorsports subject, is slightly 

underexposed. 

 The subject has been plonked in the 

centre, and there’s too much empty 

foreground and background in frame, making 

for a dull composition.  

KILLER KIT OF  
THE PROS #1
Pro camera body
“I use the pro sports 
photographer’s Canon weapon of 
choice, the EOS-1D Mk IV.  
Its 10fps shooting mode means I 
have a greater choice of shots 
and increased chance of 
capturing the action,” says Adam, 
“The 1D also has a 1.3x crop 
factor sensor, filling the middle 
ground between the full-frame 
pro 1Ds and 5D, and 1.6x crop 
factor D-SLRs like the 7D and 
50D.” The 1.3x crop factor or 
‘lens magnification’ extends the 
length of telephoto lenses to help 
you get that little bit closer to the 
racing, while still leaving 
wide-angle focal lengths wide 
enough for bigger action shots.

3

4

1

2
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Panning techniques

 The focal length (around 90mm) is too 

short, which means the subject is too 

small in shot, and so the viewer can’t engage 

with the subject. 

 A very fast shutter speed of 1/1000 

sec is fine for freezing the action, but 

rather than capturing a sense of movement, 

this has left the subject looking static.
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KILLER KIT OF 
THE PROS #3
Monopod
Big telephoto lenses 

require either big 

muscles or a big 

monopod. “It makes 

sense to use a monopod 

as it takes the weight of 

my big pro lenses, plus 

with Manfrotto Neotec 

quick-release legs – you 

just extend and lock – 

and a fully manoeuvrable 

Manfrotto 484 RC2 

head, I’m able to shoot 

and pan with more 

accuracy,” says Adam. 

“The monopod also 

keeps my camera and 

lenses rock-steady for 

sharper shots.”

Crop factor benefits
Many consumer and semi-pro D-SLRs, like Gary’s Canon EOS 7D, 

have APS-C-sized sensors with a 1.5 to 1.6x crop factor – when 

measured up to full-frame digital sensor cameras like the Canon 

EOS 5D or Nikon D800. When using telephoto lenses this crop 

factor ‘extends’ the effective focal length (EFL), getting you closer 

to your subjects for more dynamic, intimate images. As Gary says, 

“A 400mm lens on my EOS 7D has an EFL of a massive 640mm 

(1.6x 400mm). Considering the Canon EF 600mm f/4L IS monster 

lens will cost over £7,000, I can invest in a 400mm lens instead 

and still get closer.”

GARY’S TIP

KILLER KIT OF THE PROS #2
Diffractive Optical lens
The sports photographer’s must-have telephoto prime lens. For over 

five grand you get the latest lens tech: the clever ‘Multi-layer Diffractive 

Optical (DO) Element’ optics means the EF 400mm f/4 DO IS USM lens 

is smaller and lighter than comparable lenses, as Adam says, “So it’s 

easier to lug and manoeuvre around when tracking and shooting 

fast-moving motorsports. I hired mine from www.theflashcentre.com 

for the weekend – renting is definitely worth doing as you can try out 

top kit for a minimal fee.”

Beautiful backgrounds 
“Throughout the day, I reminded Gary 

to be aware of what’s going on behind 

the bikes,” says Adam, “and to plan 

ahead to avoid having messy or 

distracting backgrounds, thereby 

helping keep the focus on the bikes.”
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EXPERT INSIGHT

Longer reach

Exposure: 1/640 sec at f/6.3; ISO100 
Lens: 300mm f/4

“From the same spot as Hot Shot #2, Gary used my mighty EF 400mm f/4 DO IS 

to get closer still. No cropping needed this time!” smiles Adam. “Using a faster 

shutter speed of 1/1000 sec, he obtained a wide aperture of f/4.5, while 

shooting at the longer focal length of 400mm has 

helped to capture an even shallower depth of field 

– crucially this has knocked the outer kerb and 

background grass further out of focus (compared to 

the 300mm lens), helping to maintain focus on 

bikes. The 400mm telephoto has also compressed 

the perspective further, giving the impression the 

bikes are right on top of each other for a more 

dramatic racing action shot.”   

The Photographer’s Apprentice

“We found a gap in the fences for a clear view from the outside of Druids Bend for 

this shot. I borrowed a 300mm f/4L lens for a tighter composition. As I wasn’t 

panning so much, I used a fast shutter speed of 1/640 sec to get a sharp result. 

I love the way the bikes are fighting for the lead around the corner. The brightly 

coloured barriers in the background were distracting so I cropped the image, 

positioning each bike on imaginary lines at one-third and two-thirds into the frame.”

 Gary’s comment
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Get close up!
Once Adam has got his traditional race shots in the bag, he 

then has the freedom to experiment with slower shutter 

speeds, and to get more creative with his compositions. “I like 

close-up action shots, tightly framed and focused on just the 

riders as they’re cornering hard,” says Adam. “I still pan for 

these shots as the suggestion of blur on the track in the 

background reminds the viewer the 

rider’s moving fast.”

ADAM’S TIP

Varied compositions
A common beginner’s mistake is to only shoot in the landscape  

(or horizontal) format when composing their motorsports shots,  

and as Adam says, “Although it generally makes sense to shoot 

landscape-shaped shots as motorbikes are longer than they are 

tall when riding past, I 

encouraged Gary to also 

try portrait (or vertical) 

format shots, which work 

well when bikes are 

coming straight at you.”

ADAM’S TIP
 Gary’s comment

“I was really starting to enjoy using the EF 400mm f/4 DO 

by this stage; its fast-and-accurate autofocus was helping 

me to capture turbo-charged shots like this. Out of the 

sequence I captured on my 7D shooting at 8fps, I 

preferred this one for its fortunate spacing of the riders 

either side of leader. Using a wide aperture and long focal 

length of 400mm meant I could focus on the front rider, 

and knock the trailing riders out of focus neatly. I tried to 

go for a tighter composition, staying aware of background 

for a clean action shot.”  
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Exposure: 1/640 sec at f/4.5; ISO200
Lens: 400mm f/4

Don’t spray and pray!
Although Adam utilises his 1D Mk IV’s 

rapid-fire 10fps continuous shooting mode, 

he explained to Gary the importance of not 

just firing off hundreds of shots and hoping 

for the best. “I encouraged Gary to use his 

7D’s 8fps burst rate wisely. Think about 

when to press the shutter button, ensuring 

your focusing is spot-on, rather than 

spraying and praying!” smiles Adam.   

ADAM’S TIP

Hitting the buffer
“I’d chosen the Raw+JPEG image 

quality setting – as I’m not 100% 

confident processing Raw files, so 

I wanted the JPEG versions too. 

However, this not only meant my 

camera was hitting the buffer 

quicker when internally processing 

multiple images to my memory 

card after a burst of shots, I was 

also filling up 8Gb cards very 

quickly with my 22MB Raw and 

6MB JPEG images,” says Gary.  

“In the end I switched to just Raw 

to save time and space!” 

GARY’S TIP
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Adam’s verdict
“What a cracking shot! Gary’s composition has a clean 
backdrop, with a nice hint of track to add context [1]. He’s 
filled the frame with the action [2] plus he’s positioned 
himself well to get a good three-quarter angle on the rider 
[3]. Best of all, he’s captured the bike’s nose rising off the 
track [4], adding essential emotion that makes this high-
octane shot work so well.”

Gary’s comment
“At this stage my confidence was starting to grow, and my 
panning and timing was improving, enabling me to capture 
this shot of the racer powering out of a corner! I love the 
way the rider is tucked up over the top of his bike to stop 
the front end coming up too high, and I’ve even captured 
the exhaust heat haze.”  
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  Exposure: 1/125 sec at f/9, ISO100 
Lens: 70-200mm f/2.8 
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Name: Jakob Ebrey
Camera: Canon EOS-1D Mk III

Macclesfield-born Jakob, 33, runs 
Silverstone-based Jakob Ebrey 
Photography, the UK’s leading 
national motorsports photography 
agency. He’s the official British  
Rally Championship photographer  
and also shoots many other high-
profile motorsports events. More  
at www.jakobebrey.com 

THE PRO...

Name: Dave King
Camera: Canon EOS 40D
Trucker Dave is 57 years old and 
hails from Essex. He’s been taking 
photos since he was 15, and used to 
help out pro photographers at Arena 
Essex Raceway shooting all sorts of 
motorsports in the ’80s. Now using 
a D-SLR, he asked for our help to 
improve his sports action shots.

THE APPRENTICE…

The Photographer’s Apprentice

116  Sports & Action Photography Made Easy

The Photographer’s Apprentice

“Let’s get 
down and

dirty!”



The Photographer’s Apprentice

Getting muddy has never been so 
much fun! Our Apprentice shoots a 
leg of the British Rally Championship 
alongside a top pro photographer

The Photographer’s Apprentice

Sports & Action Photography Made Easy  117

dirty!”



The Photographer’s Apprentice

Technique assessment

KILLER KIT OF THE PROS #1
Armour and protection
“My kit is always getting knocked about as I’m racing 
around trying to keep up with the rallies; I’m constantly 

heaving the gear in and out of cars and switching 
cameras,” says Jakob, “so to protect my 

camera bodies I’ve covered them with 
Camera Armor and my lenses with 
neoprene covers.” You’ll find armour for 
bodies at www.cameraarmor.com, 
and www.wildlifewatchingsupplies.co.
uk sell neoprene covers for many 
telephoto lenses.

Fail to prepare…
“As the old saying goes, ‘fail to prepare, prepare 

to fail…’” laughs Jakob. “Photographing rally is 

all about logistics. Arrive early, get a race 

schedule and race map, and plan ahead 

– where are the good spots and what time will 

the best drivers be in these areas? What 

about access? Can you walk or do you need to 

drive? Where’s the next stage, and where can 

you park? Plan out your day and then you can 

focus on your photography.”

JAKOB’S TIP

Manage your ISO
“To make sure Dave’s D-SLR is letting him set a good and fast shutter speed 

I got him to manually increase his ISO,” says Jakob. “It was a dull day, so we 

were shooting at ISO400 and 800 for most of the day. If you don’t increase 

your ISO, even shooting on your lenses widest aperture (such as f/2.8 or 

f/5.6) won’t achieve a resulting fast enough shutter speed.”

Is Dave poised for perfect action pictures?
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Set Shutter Priority mode

 Dave’s comment
“I pulled this one out of the sequence (all shot 

at 150mm focal length) as the car is a good size 

in the frame, and I felt it’s the most dynamic, 

with the driver fighting to keep the car in a 

straight line after powering through the water. 

There’s enough splashes flying out of the wheel 

arches to create a real sense of speed and, 

thanks to Jakob’s suggestion, I’ve managed to 

get a sharp shot of the car using the AI Servo 

autofocus mode.”

“Taking control of your shutter speed is critical when shooting rally in 

action,” advises Jakob, “so I got Dave to use Shutter Priority (Tv) mode, so 

he could set his shutter speed while his camera takes care of the 

aperture. I generally want a shutter speed of 1/250 to 1/500 sec to freeze 

the action, unless I’m panning for motion blur.”

Safety first
“When photographing rally, whether 

you’re a pro or amateur, the most 

important rules are to never turn your 

back on the cars, don’t get too close to 

the track, know where you’re going to run 

if the cars crash off the track in your 

direction, and avoid danger zones, like 

the end of fast straights!” says Jakob. “I 

never kneel while shooting, either, as it’s 

faster to run out of the way if standing. 

Rally can be unpredictable, but use your 

common sense, stand well back with a 

telephoto lens, and you’ll be safe.”

JAKOB’S TIP
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Exposure: 1/250 sec at f/8; ISO400
Lens: 70-200mm f/4

High-speed 
sequence

“Jakob encouraged me to 

use my camera’s 

high-speed continuous 

shooting mode as it 

enabled me to shoot 

at up to 6.5fps 

(frames-per-second) 

to increase my 

success rate. I’ve not 

used it much before and 

was amazed how fast my 

camera fired off a succession 

of shots!” smiles Dave. “This 

enabled me to get several shots of each 

car at each part of the track and then pick the 

best image. Jakob reminded me that you still 

need to use a fast shutter speed, otherwise the 

fps rate will drop.” 
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DAVE’S TIP
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Exposure: 1/350 sec at f/4.5; ISO400
Lens: 70-200mm f/4

 Dave’s comment
“For this shot we’d positioned ourselves on a 

tight, muddy corner, hoping to get some good 

shots of cars power sliding. Using a fast 

shutter speed of 1/350 sec meant I could 

capture the car at the moment the driver put 

the power down mid-corner. Cropping has 

improved the shot immensely, as the original 

had the car looking quite lost and too central 

in the frame. It’s also removed a distracting 

tree and fence from the foreground.”

KILLER KIT OF THE PROS #2
Flash for action
Unlike some action sport events, when 

photographing rally from the track side, 

it’s fine to use flash. “I often use flash on 

bright days when I want to fill in the 

shadows on the ‘dark’ side of the cars. 

Using my 70-200mm f/2.8 lens and 

sticking with Shutter Priority mode, I set 

my flash manually as I want to expose for 

the car not the whole scene, usually 

around 1/2 power on sunny days. I’ll also 

use high-speed sync so it will still fire properly  

when using a fast 1/500 sec shutter speed.”

NO FLASH

wITH FLASH

Jakob favours the sports 

photographer’s Canon of 

choice, the EOS-1D, and carries 

two 1D Mk III bodies equipped 

with lenses, and a 1D Mark II N 

backup, plus the following 

range of kit:

Canon EF 15mm f/2.8 Fisheye 

Canon EF 17-40mm f/4L USM

Canon EF 70-200mm f/2.8L USM

Canon EF 200mm f/1.8L USM

Canon EF 300mm f/2.8L IS USM

Canon EF 1.4x Extender

Two Canon Speedlite 580 EX II flashguns 

Yongnuo CTR-301P and Pocket Wizard flash triggers

Manfrotto 055XDB tripod and 222 joystick head

JAKOB’S TIP

Go telephoto! 
On Dave’s crop-factor camera, his 70-200mm 

telephoto zoom lens created an EFL (effective focal 

length) of 112-320mm. “But Dave was using more of 

the 70mm end of the lens. I encouraged him to 

move back and use the lens fully zoomed in at 

200mm (EFL 320mm). Combined with a wide 

aperture (eg f/4) it will further blur backgrounds to 

really help the rally cars stand out from their 

surroundings for added impact,” says Jakob.
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KILLER KIT OF THE PROS #4
Super-fast telephoto lens
Jakob’s secret weapon for shooting rallies in dark 
forests is his old Canon EF 200mm f/1.8L USM lens. 
“It’s super-fast, enabling me to achieve fast enough 
shutter speeds when light levels are too 
low for my 70-200mm f/2.8. At 
f/1.8, it’s over a stop faster – 
and two stops faster than 
cheaper f/4 lenses. Even 
at f/1.8 it’s super-
sharp, too. It’s also a 
brilliant portrait lens, 
and I often use it in the 
paddock after races.” 

KILLER KIT OF THE PROS #3
Memory card backup
One of the benefits of top-end pro cameras 

is that you can record images to two 

memory cards simultaneously. “I use two 

cards together to instantly back up my shots in 

case a card fails or gets damaged,” advises Jakob. “It’s good 

working practice and I just can’t afford to let big clients 

down because of a faulty memory card.”
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Exposure: 1/30 sec at f/19; ISO400
Lens: 70-200mm f/4

 Dave’s comment
“After we’d got the sharp ‘freeze the action’ shots of 

cars splashing through the water, we moved position and 

started getting creative with some side-on panning shots 

to capture a little motion blur. I focused on the front of 

the car and got down to 1/30 shutter speed to really blur 

the surroundings. This car is actually hitting the second, 

smaller water splash, and I love how the water spraying 

up accentuates the sense of speed.”

Panning for perfection
“When panning to capture motion blur of the 

cars, set a shutter speed around 1/60 sec, 

face side-on to the track and pre-focus on 

the spot the car will drive past, then lock to 

MF. Now track the car through a 180-degree 

arc, shooting continuously and ‘following 

through’ smoothly after you stop shooting.”

Showing off the landscape
“Rallies are held in some of the most 

picturesque spots in the world, so it 

makes sense to show off a suggestion of 

the landscapes and locations that the 

cars are racing in,” says Jakob. “Go wider and 

include more of the surrounding scene in your 

shots. Try vertical and horizontal compositions, 

and try following the ‘rule of thirds’ and 

positioning cars in the corner of your frame for 

more dramatic images.”

JAKOB’S TIP

DAVE’S TIP

The Photographer’s ApprenticeThe Photographer’s Apprentice
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KILLER KIT OF THE PROS #5
Use at least two camera bodies
“Generally I’ll have my 70-200mm lens on one D-SLR body and 
my 300mm on the other camera body. This means I’m ready for 
most shots, plus it saves switching lenses in dusty rally stages,” 
says Jakob. “I also use my old 1D Mk N with a wide-angle lens 
and stick it on a tripod close to a corner so I can fire it remotely 
– two shots for the price of one!” 

Jakob’s top rally photo tips
what’s in the background?

“Your background will make or break your action shots. 

Be on the lookout for clean and empty areas behind 

tracks, making sure that, when cars appear, you will be able to 

shoot away without anyone behind the cars – marshals are 

great at ruining shots with their distracting hi-vis jackets!”

[3]

[4]

[1][2]
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EXPERT INSIGHT

Fill the frame

 “A little space around cars and giving them room to 

‘drive into’ the frame is fine, but don’t capture too 

much dead space and then plonk them in 

the middle. Instead, aim to fill the frame with 

the action. This also means your backdrop 

will be more out of focus – shots where the 

car is closer to the camera and filling the 

frame has a less distracting background.” 

Best view

 “Shooting cars coming straight at you 

means you can’t see enough of the car 

to get a sense of movement. Position yourself 

to get a view of cars so they’re slightly side-on – ideally 

fishtailing out of a corner with a little mud spray for more 

dramatic action shots.”

Reflections in windscreens

 “The only slight flaw with this shot, compared to the 

one above, is that the windscreen has reflections of 

the tree above, so you can’t see the driver and co-driver – 

but you can’t have everything! Knowing where you need to 

stand to capture all of the above and to ensure a clear 

windscreen takes years of experience.”
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 Dave’s comment
“This shot was taken near the end of the day when the 
sunlight was low and shadows were long. we knew the 
cars would get a little airborne off the bridge on the edge 
of the forest, so we positioned ourselves ready for action. 
I shot this at 200mm and pre-focused on the bridge for a 
sharp shot – the cars appeared on the bridge too fast to 
be able to track them. Although I liked the wider, vertically 
composed shot of this jump, I preferred this horizontal, 
tighter shot as you can see the car better – you can even 
see the driver’s focused expression on his face!”  

Jakob’s verdict
“Dave was a great sport on the day and really did well to 
get so many top shots, including this one. He’s timed his 
shot well to capture all four wheels (just) off the ground  [1] 
after the little jump during this forest stage. The shot’s well 
exposed, with the light streaming through gap in trees to 
light up the cars [2] as they hit the bridge. Dave’s focusing 
is good [3]. Best of all, he’s captured the car’s nose rising 
off the track [4] by pre-focusing on bridge then firing like 
crazy before, during and after car has motored past. Finally, 
his composition is strong, with space to drive into and 
dramatic dust trails behind adding to the sense of speed.”

The Photographer’s Apprentice
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 [4] 

[1]

[3]
[2]

  Exposure: 1/500 sec at f/4.5; ISO400  
 Lens: 70-200mm f/4
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Name: Nigel Blake 
Camera: Canon EOS-1Ds Mk III

Nigel Blake, 55, is one of the UK’s foremost 
aviation photographers. He’s been shooting 
air shows since he was 12 and developed his 
photography skills in between stints as a model-
maker for the film industry. He went fully pro back 
in 2005, and since then he’s made a name for 
himself as an aviation and bird photographer, and 
has had his work published in numerous aviation 
and photography magazines. To see some of his 
great images, visit www.nigelblake.co.uk

THE PRO...

  “The sky’s the limit!”   
Learn how to shoot dramatic aviation images as 
top aviation pro Nigel Blake takes our Apprentice 
under his wing at the Duxford Air Show 

The Photographer’s Apprentice
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THE APPRENTICE…
Name: Vince Scott
Camera: Canon EOS 550D

Vince, a 45-year-old computer analyst from 
Newcastle, has been taking photographs at 
air shows for the past seven years. He came 
to us for help with his air show photography, 
and in particular with nailing sharp shots and 
getting exposure spot-on when shooting aircraft 
against bright skies. .

  “The sky’s the limit!”   
The Photographer’s Apprentice
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Technique assessment

Shoot in Raw
“When you’re tracking a fast-moving jet 
at five or more frames per second, and 
it’s going from front-lit to backlit in a 
matter of seconds, getting a good 
exposure can be a real problem,” says 
Nigel. “Shooting in Raw maximises your 

chances of getting a shot that you can 
use – or at least rescue in the editing 
stage – as Raw files contain much 
more tonal information than JPEGs, 
particularly when it comes to over- or 
underexposed shots.”

Use your histogram
“Vince was having problems with 
exposure,” says Nigel, “so I encouraged 
him to refer to his histogram. For most 
subjects, I try to expose my shots so 
that the histogram is pushed as far to 
the right as possible but without actually 

being clipped, as most D-SLR sensors 
tend to be at their most sensitive as 
this end of the tonal range. Rescuing 
detail in images where the histogram is 
stacked up at the left also tends to 
introduce noise.”

Off THE gRAPH

RAW TAlENT

Canon EF 600mm f/4L IS USM 

Canon EF 300mm f/2.8L IS USM

Canon EF 70-200mm f/2.8L IS USM

Canon EF 100-400mm f/4.5-5.6L IS USM

Canon EF 100mm f/2.8L Macro

Canon EF 28-80mm f/3.5-5.6 USM

Canon EF 20-35mm f/3.5-4.5 USM

Canon EF 1.4X and 2X extenders

Wimberley Gimbal Tripod Head Mk I

Gitzo GT3541LS carbon-fibre tripod

Various extension tubes, flashes etc

Nigel uses three full-frame cameras 

– two 1Ds Mk IIIs and a 1Ds Mk II – plus a 

raft of long lenses to allow him to fill the 

frame where necessary. When he’s on 

location, he limits his kit to the following:

Is Vince ready to  
shoot air shows?

KILLER KIT OF THE PROS #1
Kneepads
“If you plan to spend a lot of time 

scrabbling around on your knees so you 
can shoot from down low,” laughs Nigel, “a 

pair of builders’ kneepads can be a worthwhile 
investment. They can really save your knees 
from the hard tarmac, especially if you’re using a 
tripod or a heavy lens.”
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Once Vince had rattled off a few frames, Nigel took a look at his settings 
and offered some advice on how he could improve his hit rate
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Try different angles!
“Nigel showed me how I could reduce 

or even eliminate background clutter 

by adjusting my position or getting 

down low. In the past I tended to shoot 

every plane from a three-quarter angle 

at head height, but now I know better: 

even if you blur out the background by 

setting a wide aperture, some bloke 

wearing a hi-vis jacket will still be 

distracting!”

 Vince’s comment
“I used to photograph static aircraft to kill time 

before the main air display, but thanks to Nigel I 

now look at them differently. I used a long zoom 

lens to crop right in on this colourful Hunter, to 

hone in on the shape and detail and eliminate the 

distracting background. I used a narrow aperture to 

get as much of the fuselage in focus as I could and 

used the tail and the cockpit canopy to help frame 

the shot. I really like the contrast of the bright 

yellow against the dark blue clouds.”

 “Make the most of the conditions – if it’s really wet, 

for example, you can use water droplets on the 

aircraft canopy to shoot something a little bit different. 

Some of my best shots have come from those days 

when I’ve had to work that much harder and think 

more creatively.”  

“Aircraft fuselages are often highly reflective, so you 

can use this to your advantage by looking for abstract 

details, making the most of any reflections by adjusting 

your position constantly until you’ve got what you want.”   

“The devil is in the detail: once you’ve got your shot, 

look at it really critically and try to picture the things 

you can do to polish it – the composition, the background, 

and so on. Bright-red ‘remove before flight’ tags flapping in 

the breeze can add an extra element at slow shutter 

speeds, for example.” 

EXPERT INSIgHT

“With static shots, it’s often about isolating detail,” explains Nigel. “At air shows, 

it’s easy to get overwhelmed by all the colour and noise, but the trick is to hone in 

on what’s important and isolate it, to see the shot among all the potential.” With this 

in mind, here are Nigel’s three top tips for shooting static displays: 

Shooting statics
VINCE’S TIP
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Exposure: 1/200 sec at f/14, ISO200
Lens: 70-300mm f/4-5.6
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KIllER KIT Of THE PROS #3
Brolly
“If you’re lugging around thousands of 

pounds’ worth of kit and it starts to 

bucket down, you need to protect it. You 

can even sling it over your shoulder and 

keep shooting – with a long lens set at a 

wide aperture you 

won’t even be  

able to tell that 

it’s raining.”

Expose for skies
“When the action is unfolding fast,” 

explains Nigel, “you often haven’t got time 

to keep checking your histogram, so a 

rough-and-ready way of ensuring correct 

exposures is to use Evaluative Metering 

and then set exposure compensation to 

+1, or even +2 if the sky is really bright. 

Generally speaking, skies are brighter than 

mid-grey, but your camera’s light meter will 

try to make them mid-grey, resulting in 

dingy skies and silhouetted aircraft.”

KIllER KIT Of THE PROS #2
gimbal Head
“Handholding my 600mm lens and aiming it 

at the sky very few minutes is like lifting 

weights, and at slow shutter speeds 

camera shake is real problem. A good 

tripod head provides essential support, 

but when you’re panning unpredictable 

subjects it needs to be able to move quite 

freely, which is where a gimbal head 

comes in – it provides essential support, 

but also allows you to move the lens up 

and down as you pan.”

NIgEl’S TIP

The Photographer’s ApprenticeThe Photographer’s Apprentice The Photographer’s Apprentice
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Even if you’ve got top-of-the-range gear, photographing fast-moving jets with 
a long lens can be challenging. Here’s how Nigel guarantees great shots:

Exposure: 1/200 sec at f/16, ISO200
Lens: 150-500mm f/5-6.3 

“I was really chuffed with this 
shot. I took Nigel’s advice and 
waited for the B-17 Flying Fortress 
to begin its turn, using a shutter 
speed of 1/200 sec to blur the 
propellers. In total, I fired off 
about 30 shots of this particular 
aircraft, but most of them looked 
a bit flat, either because of the 
lighting or because the plane was 
too side-on. It all came together in 
this shot, though – I particularly 
like the way the sun is reflecting 
off the leading edge of the wings.”

 Vince’s  
comment

get propeller blur
“Shutter speed is critical when you’re shooting propeller 
planes, as if it’s too fast it will freeze the motion of the 
propeller, resulting in a really static-looking shot. Generally 
speaking, it needs to be around 1/200 sec or slower to get 
decent prop blur. This can make it tricky to get sharp shots, 
particularly if you’re using a long lens, but image 
stabilisation helps (set it to Mode 2, as this is specifically 
for panning), as does locking your arms into your chest and 
using them like a tripod. Even then, panning can be a 
lottery, so take as many shots as you can in the hope that 
one comes out – a technique I like to call spray and pray!”

NIgEl’S TIP

The Photographer’s Apprentice

Set AI servo mode 

“Canon’s AI Servo mode (the Nikon equivalent is Continuous AF) does a fantastic job of 

refocusing when objects are moving towards or away from you, making it invaluable in situations 

like this. Also useful is setting up your camera so that the exposure lock (* button) can be used 

to focus your shots, rather than half-pressing the shutter release. This keeps the shutter release 

button free to take the shots, and eliminates the risk of taking shots when you don’t mean to, or 

vice versa. Look for Shutter/AE lock in your Custom Function menu and set AE/AF no AE lock.” 

Shoot in continuous drive mode  

“Continuous drive mode is tailor-made for fast moving subjects like this. By shooting a 

series of frames you can be sure of getting the aircraft at the apex of its turn, or with the blurred 

propeller blades pointing up and down, rather than out to the sides.”  

Move with the sun 

“If you do your research you can work out where the sun will rise and set in 

relation to the airfield, and plan your shoot so that you’re never shooting directly 

into the sun. You can then, say, start at one end of the runway and move along 

to the far end as the sun moves round.” 

 Spend the weekend 

“If the air show takes place over two days, it’s a good idea to use the 

first day to work out what all the planes are doing, and get plenty of 

‘bankers’ in the bag. You can then review your shots overnight, see what 

works, and use the second day to target specific shots.”  

EXPERT INSIgHT

Stay focused!
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learn the flight paths
“Once the air display got underway, Nigel 

encouraged me to keep a close eye on each aircraft 

as it performed its first flypast, to determine where 

and how it turned, and when it might look at its best 

in terms of its angle of approach and the angle of 

the sun. Usually each aircraft will make the same 

approach two or three times, so by watching it 

closely first time around you maximise your 

chances of getting the perfect angle when it comes 

around again.”

VINCE’S TIP

Exposure: 1/250 sec at f/13, ISO200
Lens: 150-500mm f/5-6.3

The Photographer’s ApprenticeThe Photographer’s Apprentice
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 Vince’s comment
“The sky started to cloud over later in the day, but Nigel encouraged me 

to use this to my advantage, and to use the darker clouds as a backdrop 

to the action. I kept my shutter speed low for the propeller planes, and 

went for a frontal shot of this P-51 Mustang as it was banking away from 

us at the end of its run, rather than towards us. I love the moody clouds, 

the evening light just glinting off the silver fuselage, and the fact that the 

propellers are perfectly positioned.”



The Photographer’s Apprentice

 Vince’s comment
“I love the simple composition of this shot and the exposure is spot on, with 

plenty of detail in the underside of the planes and lots of colour in the moody 

blue sky. My one frustration is the fact that the propellers aren’t as blurred as 

I’d like them to be, but if I’d used a shutter speed much slower than 1/200 sec 

I’d have struggled to get it so sharp.” 

 

Exposure: 1/250 sec at f/14, ISO200
Lens: 150-500mm f/5-6.3

NIgEl’S TIP

The Photographer’s Apprentice

Time your bursts
“Once Vince had got his eye in I encouraged him to be 

more selective with his bursts and to time them to 

coincide with the peak of the action. When you’re 

shooting Raws in continuous drive mode, it’s all too 

easy to start shooting too early and risk the card 

buffering just when things are getting interesting.” 

Shooting skies
EXPERT INSIgHT

Making the most of the sky an essential 
element of air show shots, as Nigel explains: 
“I’m not really a fan of blue skies, or at least 
not completely blue. You need a bit if fluffy 
white cloud or a storm, or even some dramatic 
backlight, to add depth and interest, otherwise 
it all looks a bit flat. I also like what I call ‘big 
sky, small plane’ shots – with the right 
sky, these can be every bit as dramatic 
as frame-filling close-ups. And of 
course, you don’t have to limit your 
background to sky: using aircraft 
on the ground to frame shots or 
anchor a shot can be used 
to provide context or a 
sense of height.”
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“Vince has taken everything on board for this late-
afternoon shot of a Hunter, and his effort has really paid 
off: the yellow of the fuselage looks great against the blue 
storm clouds [1], the plane’s angle of attack makes it look 
really imposing and majestic [2], and the whole image has 
a timeless painterly quality [3]. Well done!”

Nigel’s verdict

Vince’s comment
“This was my favourite shot of the day. In the past I’d 
have been tempted to fill the frame and shoot more side-
on, but instead I tried to use the sky to add texture and 
depth, and shot much more front-on, which resulted in 
some lovely highlight detail on the nose and wings. And 
considering it was probably travelling at 500mph, it’s 
pretty sharp too!”  

The Photographer’s Apprentice
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  Exposure : 1/250 sec at f/16, ISO200  
 Lens: 150-500mm f/5-6.3



The Photographer’s Apprentice

Name: Don Bishop
Camera: Canon EOS 5D

Don has supplied breathtaking photos of steam 
trains to railway magazines for 14 years, and  
gave up his job as a BT sales consultant to 
become a full-time professional in 2006.  
He runs regular workshops and photo charter  
days for budding steam train photographers.  
Visit www.steamrecreations.co.uk for details.

THE PRO...

The Photographer’s Apprentice
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THE APPRENTICE…
Name: Chris Beaumont
Camera: Canon EOS 5D
Chris is a 54-year-old computer engineer who lives 
near Heathrow Airport. Although he has been a keen 
photographer for many years, he has only recently 
become interested in shooting steam railways. He’s 
been disappointed with his results, however, and 
wants to get more exciting shots.



The Photographer’s Apprentice

“Now my 
shots are back 
 on track!”

Do your attempts at shooting trains go off the rails?  
Learn how to get express results as top pro Don Bishop 
gives our Apprentice some essential trackside advice   

The Photographer’s Apprentice
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After taking a few dozen shots, Don showed Chris the best way  
to set up his camera to increase his chances of capturing the action

Is Chris ready to  
go full steam ahead?

Technique assessment

Switch to Manual
 “I advised Chris to switch to Manual mode,” 
says Don. “He’d been using Aperture Priority, but 
by relying on the built-in meter he had problems 
with overexposure, with the exhaust of the trains 
‘blowing out’. With so much white and black in 
steam train shots, it is best to set the exposure 
yourself before the train moves into view.”

Focus a third of the way in
“If you charter a train, you’re in control and it 
follows a set path, so you can also get focus 
right before it moves into your frame,” says Don. 
“Visualise where the train will be, and focus on a 
point about a third of the way along its length 
using one of the autofocus points. Switch to 
manual focus to lock on this position.”

SHOOTINg IN Av? STRugglINg wITH FOCuS?

KILLER KIT OF 
THE PROS  #1 
Hotshoe spirit level
“When shooting on inclined tracks 
and rolling hills it is hard to get the 
shot level using your eye alone. 
This spirit level (Jessops, £10) 
attaches to my camera’s hotshoe. 
You only need to line up the bubble 
for the horizontal plane – it doesn’t 
matter how the camera tilts 

forwards or 
backwards.”

Safety first
“Railways are dangerous places, and 

when photographing trains you 

must stay safe. Railways have 

their own safety guidelines, so 

make sure you know what 

they are and follow them. Do 

not trespass. Line-side 

permits are available at many 

of the heritage lines around 

the UK, but access to 

Network Rail mainlines  

is not permitted. If you’re 

shooting from the trackside you 

will be expected to wear an orange 

hi-vis jacket at all times.”

DON’S TIP
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Exposure: 1/20 sec at f/4, ISO400
Lens: 24-105mm f/4

 Chris’s comment
“The day didn’t get off to a great start, because as soon 
as we turned up at Llangollen station the heavens opened. 
While we waited for a break in the clouds, Don suggested 
we took portraits of the driver and fireman. By using my 
flashgun (fitted with a Stofen diffuser) to throw some ‘fill-in’ 
on their faces, you’d never know it was raining.”

EXPERT INSIgHT

RODS DOwN 

Shoot engines with ‘rods down’

RODS uP 
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“To convert the steam power into motion, coupling and connecting rods are used to turn the engine’s wheels. 

These shafts of metal are always moving, but look much more impressive in your photos if the rods are 

down, rather than up. If the train is moving slowly you can time your shot to ensure the rods are where 

you want them. If it is going faster, it is a matter of luck – but using your camera’s top continuous 

motordrive setting to take several shots will help.” 

“For the perfect steam engine 
shot, the wheels need to be in the 
correct position,” says Don  



The Photographer’s Apprentice
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 Chris’s 
comment
“Fortunately the rain 
stopped after an hour 
or so and we were able 
to head out with the 
train as planned to try 
and capture some of 
the classic ‘steam in 
the landscape’ shots 
I had hoped to take. 
I deliberately framed the 
shot to cut out some of 
the washed-out grey sky.”

Exposure: 1/200 sec at f/5, ISO400
Lens: EF 24-105mm f/4

The Photographer’s Apprentice The Photographer’s Apprentice
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KIllER KIT OF THE PROS #2 
Two-way radio
“The beauty of chartering a steam train is that you 

can get the engine to reverse and 

travel past the same spot 

again and again. You can’t 

rely on mobile phones, 

however. On days like 

this, I hire three radios 

– one for the driver,  

one for the guard, and 

one for me. This costs 

around £35.”
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“At steam railways you often have to wait ages 
for the next train to go past, and you can usually 
only photograph them going one way. When the 
train is travelling back down the track, the engine’s 
chimney or ‘smoke box’ will be at the back of the 
engine, and not at the front as it should be. Photo 
charters are great, because the train can be set 
up to pass you in the correct direction several 
times in a matter of minutes. Every pass allows 
you to perfect your technique and timing, and the 
position of the smoke is different every time.”

First attempt 
In this first shot, the composition works well, but 
the steam obscures part of the engine.

Second attempt 
By chartering the train we were able to try again. 
This time the steam looks perfect!  

Charter your own train! 

 Chris’s comment
“Nearly all of the photographs 
I took on the day were 
horizontal format, but I think 
this vertical shot works very 
well. The train is working hard 
as it climbs the hill, but luckily 
the exhaust is clear of the back 
carriage. The curve of the track 
does a brilliant job of leading 
the viewer’s eye into the middle 
of the shot.”

Exposure: 1/320 sec at f/5.6, ISO500
Lens: 75-300mm f/4-5.6

e

Canon EF 24- 

105mm f/4L USM

Canon EF 85mm 

f/1.8 USM

Canon 100-400mm 

f/4.5-5.6L IS USM

Sigma 17-35mm 

f/2.8-4 EX DG

Don uses his trusty 

Canon EOS 5D to 

make his living, but 

also carries around an 

old 20D, partly  

as backup and partly 

because he 

sometimes uses two 

cameras in tandem 

fitted to a Manfrotto 

long Plate 430 on his 

tripod. He also packs 

these zooms:

CHRIS’S TIP

The Photographer’s Apprentice
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EXPERT INSIgHT

“The best time to shoot steam 

railways is between late 

September and late April. It 

needs to be cold enough for  

the engine to produce the 

right amount of white exhaust. 

Without this steam, your shots 

can look a bit lifeless, so you 

also need to pick a vantage 

point where the engine is 

working hard – look for sections 

of track with a gradient.”

Maximise 
the steam

KIllER KIT OF THE PROS #4 
Stepladder
“A stepladder allows you to get a good 

vantage point, so you can see over 

hedges and other photographers. 

Also, on photo charters the train 

stops where you want it to along 

the track, so you won’t necessarily 

have a platform from which to 

board the train. These steps help 

me clamber on board to be ferried 

from one location to the next.”

KIllER KIT OF THE PROS #3 
Folding pocket secateurs
“To get the best views of the track, you often have 

to shoot over hedges. Sometimes it is necessary 

to do a bit of light pruning to 

ensure your lens has a 

clear line of sight. This 

mini multipurpose tool 

costs under £10, and 

stows away safely in  

my backpack.”

The Photographer’s ApprenticeThe Photographer’s Apprentice
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Exposure: 1/160 sec at f/5.6, ISO400 
Lens: 75-300mm f/4-5.6 

Chris’s comment 
“This was one of the last shots of 

the day – and it had started to 

rain again. However, the angle of 

the train meant that the wet 

carriage roofs reflected what 

daylight there was. The shot’s full 

of atmosphere, and just goes to 

prove that you shouldn’t pack up 

your kit when the going gets wet!”

use a hood in bad weather
“Although I didn’t think I’d need it, I was really glad 

that I had my lens hood with me. 

There wasn’t enough sun to 

make lens flare a problem, 

but the hood did a great 

job of keeping rain off 

the glass at the front 

of my zoom lens!”

CHRIS’S TIP

The Photographer’s Apprentice
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Don’s verdict
“I love this picture. It is exactly the sort of shot I had 
hoped Chris would capture during our day at llangollen 
Railway. Steam trains always look their best when they’re 
powering across a landscape, rather than stuck in a 
station, and despite the weather Chris has done a brilliant 
job. He has used the dips in the landscape [1] to lead the  
viewer’s eye towards the train, while the track creates a 
strong, dynamic, diagonal line across the frame [2]. The 
train’s exhaust is well positioned, so that you can see 
all the carriages within the frame [3], and you can just 
see the driver and fireman, who are in a perfect position 
peering off the footplate [4]. A great shot, Chris!”

Chris’s comment
“I shot this train from the same position four times. I 
set up the focus and exposure manually before the train 
moved into frame. I then fired off a burst of shots to 
ensure I froze the train in the perfect position. My first 
shot was slightly overexposed, and on my second attempt 
the exhaust had dipped down, obscuring some of the 
train. This shot was taken on the last run.” 

The Photographer’s Apprentice
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  Exposure: 1/250 sec at f/16, ISO200  
 Lens: 150-500mm f/5-6.3
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WHAT YOU’LL NEED Photoshop CS and above
WHAT YOU’LL LEARN How to capture a 
sequence of action images, how to batch 
process similar images in Raw, how to 
combine multiple images using layers, how to 
reveal the whole sequence using masks
IT ONLY TAKES Half a day

We all know that you need to use a fast 
shutter speed to ensure pin-sharp action 
shots. However, this method of ‘freezing’ 
the action can make the subject look quite 
static. One way round this is to pan with the 

How to…  
Shoot frame by 
frame action shots 
Thanks to the power of Photoshop’s layers and Layer Masks you can 
quickly combine multiple images to create a dramatic action sequence 

subject at a slower shutter speed, so that 
the background is blurred but the subject 
stays in focus. But this is a skill that usually 
takes a few attempts – not to mention plenty 
of practice – to get right. Even then, it’s a bit 
hit and miss. However, there’s another way 
to ensure sharp shots and convey a sense of 
movement at the same time.  Simply make 
a composite image from a sequence of 
frames of a moving subject, so that it looks 
like it’s travelling across a single frame. As 
a film optical effect, this would have been a 
highly complex process taking days to create 

but, with Photoshop CS, you can achieve the 
same effect digitally in one afternoon.
For this feature, we ventured out onto the 
mean streets of Bath with professional 
mountain biker Andrew Dodd to shoot our 
own frame-by-frame sequence (if you haven’t 
got a pro mountain biker to hand, someone 
running or jumping will work equally well). 
Over the next few pages, we’ll show you 
how we got our start images, and how we 
combined them using layers and Layer 
Masks to create an action shot with a 
difference. Ready? Then let’s get started.  

Start images  
and video at  
www.bit.ly/ 

dc180bonus

Bonus

MasterclassMasterclassMasterclass
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To combine a sequence of 
images convincingly, the 
background needs to be 
identical in every shot, so all 
the details line up when the 
images are merged. The only 
way to ensure this is to use a 
sturdy tripod. Equally useful 
when it comes to capturing 
fast-moving action is a ball 
head, which can be adjusted 
and locked in position much 
more quickly than a pan-and-
tilt one. The German-made 
Cullmann head (pictured) is 
compact but sturdy.

Buy a ball head

If you take a large amount of photos 
with the help of a tripod, a cable 
release is definitely a worthwhile 
investment. Not only does it 
eliminate the risk of camera shake 
when you press the shutter release, 
it also enables you to fire off a burst 
of shots at the precise moment 
that the action is taking place. If 
you’re shooting from a very low 
vantage point, it also saves you 
having to crouch down! You 
could even treat yourself to a 
wireless remote control.

Invest in a 
cable release
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Another device that saves you having 
to get down and dirty when you’re 
shooting from the ground up is a 
right-angle viewfinder. The Hoodman 
H-Rav (pictured) fits all Canon D-SLRs, 
can be rotated through 360° and 
enables you to view what’s in shot at 
1x and 2.5x magnification. For more 
details, visit www.hoodmanusa.com.

Find the right angle

Capture the action
Six top tips for shooting a sequence of action images
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When you’re shooting urban scenes, getting 
far enough away from your subject without 
setting up in the middle of a road can 
sometimes be a problem! That’s when a wide-
angle lens, such as the Sigma 12-24mm 
pictured here, can be worth its weight in gold. 
Our start images were shot using a Canon EOS 
40D at a focal length of 15mm (equivalent to 
around 24mm on a full-frame D-SLR). 

Use a wide-angle lens

A fast shutter speed is essential to freeze the action, 
especially when the subject you’re photographing is 
moving quickly across the frame. You may get away 
with a slower shutter speed when your subject is 
moving towards you. A fast continuous frame rate is 
also important as it gives you more frames to choose 
from for your final composite. We used a 40D, which 
will shoot a rapid six frames per second – fast enough 
to give us eight different shots of our mountain biker 
from one jump.  

Shoot in a continuous mode
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Create an action sequence

2Get synchronised
As all the start images were taken within milliseconds of 

each other, it makes sense to batch-process them. This means 
that the edits you make to one shot will also be applied to all 
the others. To do this, click Select All and then Synchronize. 
Click OK in the Synchronize Options dialog that pops up.

1Go for launch
First, launch your copy of Photoshop CS 

and select File > Open. Navigate to the folder on your 
bookazine Video Disc called jump_start, select all four of the 
start images and then click OK. The images will automatically 
open in Photoshop’s Camera Raw editor.

3Lighten the shadows
Our mountain biker is pretty well exposed, but the shot’s 

histogram is bunched up at the left, thanks to the dark shadows 
beneath the trees. To restore detail to these shadows so that 
they don’t print out as pure black, simply drag the Blacks slider 
down to 0. This will have the effect of pulling the histogram 
towards the right, so that its shadow end isn’t clipped.

4Boost colour
Next, drag the Clarity slider to +50 to boost contrast in the 

steps and the sky. Drag Vibrance to +25 to give the sky a subtle 
boost and Saturation to +10 to really bring out the red of the 
biker’s top and the phone box. Click Open Images to open all of 
the start images in Photoshop’s main editing window.

5Stack ’em up
Select the image jump_start2 and pick Select > All then 

Edit > Copy. Now select jump_start1 and use Edit > Paste to 
paste jump_start2 on top of jump_start1, as a new layer in the 
Layers palette. (Select Window > Layers if this isn’t visible.) 
Repeat this step with jump_start3 and jump_start4, so that all 
four start images are stacked up in the Layers palette.

6Mask ’em out
Now click ‘Layer 1’ to select it, then Alt-click on the Add 

Layer Mask icon in the Layers palette to add a black mask to 
that layer. Do the same for ‘Layer 2’ and ‘Layer 3’ so that the 
top three layers are completely masked out and only the 
‘Background’ layer is actually visible. Press Z to activate the 
Zoom tool and click Fit Screen in the Options bar.
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9Reveal the riders…
As a result of the transparent shape you painted on the 

mask in step 7, the only parts of ‘Layer 1’ that are visible are the 
bike and rider, which now sit on top of the ‘Background’ layer 
below. Because Layers 2 and 3 are still completely masked out 
at this point, the rider isn’t visible from either of these shots.

10…one by one! 
To reveal the bike and rider in ‘Layer 2’ and ‘Layer 3’, 

repeat steps 7 and 8 for these layers. If you’ve missed out any 
edges, you can still go back and paint them in by targeting  
that layer’s mask. Remember that you can also use the white 
sections in the mask thumbnails to ensure you haven’t missed 
any areas in the middle of these shapes. Go to Layer > Flatten 
Image and then File > Save.  

How we shot our action sequence...
Here’s our D-SLR technique for capturing a series of dramatic images

8Reactivate the mask
You won’t be able to see the brush strokes because white 

brush strokes on Layer Masks are transparent, but you will see 
a white bike shape appear in the Layer Mask thumbnail on the 
right when you release the brush. Don’t forget to paint over the 
rider’s shadow on the steps as well. Once you’re happy, simply 
Shift-click the mask to make it active again.

7Deactivate the mask
Click on the ‘Layer 1’ mask to select it, then Shift-click it to 

deactivate the mask, so you can see where the bike rider is. 
Now set the foreground colour to white (press D), and grab the 
Brush tool with a soft-edged brush of 300 pixels. Set the 
Opacity and Flow to 100% and paint over the rider and bike: 
make sure you don’t miss any areas out.

To make our final shot look as dramatic 
as possible, we used a 12-24mm 
wide-angle lens set at 15mm. We shot 
from low down at a slight angle, so that 
the steps would lead the viewer’s eyes 
into the image. We also shot side-on to 
ensure that there’d be a gap between the 
wheels of each bike image in the final 
composite, and shot in a continuous 
mode at six frames per second to give us 
a sequence of eight shots per jump.

Having this many images to choose 
from enabled us to select shots that 

would be equally spaced apart in our 
composite. We could have worked with 
all eight exposures, but this would have 
meant them overlapping, which wouldn’t 
have looked as clean.

We choose an aperture of f/5 to 
ensure adequate depth of field in every 
frame, and the ISO was set to 500 to 
ensure a high enough shutter speed of 
1/2500 sec to freeze the action. 

Finally, we pre-focused on the middle of 
the steps, then locked the focal point by 
switching the lens to manual.
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By using the strobe setting 
on your flash it’s possible to 
recreate the stunning shots 
of stop-motion pioneer 
Eadweard Muybridge. We 
show you how it’s done…  

MasterclassMasterclass

WHAT YOU’LL NEED Photoshop CS3 or above and 
a flashgun with a multi/strobe function
WHAT YOU’LL LEARN How to use the multi/strobe 
setting on your flash, how to create a stop-motion 
image of a golf swing, how to boost definition and 
contrast in Camera Raw, how to crop 
symmetrically and straighten a horizon
IT ONLY TAKES Half a day

Some events happen so quickly that they’re not 
visible to the human eye. In the case of a golf 
swing, for example, you might be able to make 
out the top of the backswing and the follow-
through, but the rest is a blur. Even if you set 
your camera’s fastest shutter speed of 1/4000 
or 1/8000 sec, you’d only be able to capture the 
swing at a single moment, resulting in a striking 
yet static shot. But there’s a solution: stop-
motion photography enables you to capture a 
sequence of images in a single frame. 

The technique was pioneered by British 
photographer Eadweard Muybridge (1830-1904), 
who was the first to show that all of a horse’s 
hooves leave the ground when it’s galloping. 
Muybridge subsequently used banks of cameras 
to freeze the motion of everything from gymnasts 
to figures walking up and down stairs. We’ll show 
you how to emulate Muybridge using little more 
than your D-SLR and a single flash.  

How to…  
Shoot a 
stop-motion 
sequence 

Start images  
and video at  
www.bit.ly/ 

dc180bonus

Bonus
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The next thing you need to decide 
is how many positions you want 
to record in your sequence. For 
the sequence to look effective, 
we reckoned we’d need to record 
around 30, which meant setting 
Multi mode on our flash and 
setting a frequency of 30Hz, or 
30 flashes per second. Using the 
Multi setting on your flash can 
appear fiendishly complicated if 
you’ve never tried it before, so it 
will save you hours of frustration 
if you take your instruction 
booklet with you. It’s actually 
quite straightforward once you 
get the hang of it!

Dial in the 
frequency

Firstly, you’ll need to shoot at night as your exposure will 
be around one second – if there’s too much daylight your 
images will be overexposed. For the shot to work, 

position your golfer symmetrically and ensure their swing 
doesn’t disappear out the top of the frame during either the 
backswing or follow-through. This can be quite tricky once it 
gets dark, so get set up while there’s still some light by 
positioning a ball on a tee at the bottom of the frame and 
zooming in (or moving closer) until the swing just fills the 
frame. This is also a good time to lock the focus, as your 
camera’s autofocus may struggle to find an edge when it’s 
dark. To do this, autofocus on your subject’s torso and 
then switch your lens to manual focus.

Set up your shot

A flash’s power is limited by the charge it 
can store up. For our shot, we needed to 
reduce the power output of each burst to 

1/64th of full power, which allowed 
us a maximum of 30 
bursts – just enough for 
our 1 sec exposure at a 
frequency of 30 flashes 
per second.

Set the power
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The biggest risk when shooting a largely 
static subject using a strobe is overexposure: 
while the swinging club is in a different 
position on the sensor each time the flash 
goes off, the golfer remains in the same 
place, and if he or she is wearing bright 
clothing, you run the risk of that clothing 
burning out – especially if you’re lighting it up 
with 30 or more bursts of flash. The answer 
is to get your subject to wear dark clothing, 
but not black, as black won’t stand out as 
well against a dark background.

Once you’re all set up, 
you’ve got two options: you 
can either set a shutter 
speed of 1 sec and release 
the shutter just as your 
subject reaches the top of 
their backswing; or you can 
set your D-SLR to bulb and 
open and close the shutter 
at the start and end of the 
swing. The swing lasts 
about a second, so both 
methods work, but by 
taking control you can be 
sure of capturing the full 
swing in all its glory! A 
remote shutter release is 
also essential to avoid 
jogging the camera during 
the exposure.  

Dress your golfer!

Fire away

You might think the steel shaft of a golf club 
would be highly reflective, but at night it 
reflects what’s around it, which isn’t a lot 
when it’s dark! A flash set to strobe will 
reflect off the shaft in some positions but 

not others. To ensure the 
club’s shaft and head are 

visible in every position, 
they need to be taped 
with white tape as 
neatly as possible.

Prepare your club

Before you even turn on your flash it’s 
important to set your exposure for 
ambient light. We wanted to expose our 
shot so that we could still see the dusky blue 
clouds in the background. We reckoned a golf swing 
lasted about a second, from the top of the swing to the 
top of the follow-through, so we set our shutter speed 
accordingly. We then set ISO to 200, to ensure grain-free 
shots while allowing a bit of leeway, and adjusted the 
aperture until the sky was a nice deep blue. An aperture 
of f/5.6 gave us enough depth of field to have our golfer 
sharp, while blowing out the background slightly.

Expose for the sky
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3Increase contrast and colour
To increase local contrast and make the subject stand out 

from the dark background drag Clarity to +40, and to boost the 
green of the grass and the blue of the sky, drag Vibrance to +40. 
Finally, to brighten up the image slightly and boost the overall 
contrast, click on the Curves tab and select Point.

4Brighten the sky
Select Linear from the drop-down menu and click on the 

diagonal line to create two points, one a quarter of the way up 
and one three-quarters of the way up. Leave the first point 
where it is, but drag the second point upwards, as in the image 
above. This will boost the overall contrast and colour saturation 
without darkening the deep blue clouds.

5Boost the blues
Click on the HSL/Greyscale tab and then select the 

Luminance tab. Drag Blues to +50 to lighten up the sky slightly 
and Greens to -30 to reduce the glare in the grass, then click 
on the Saturation tab and drag Blues to +10. Again, this will just 
help to make the most of the bruise-blue colouring of the 
clouds in the background. When you’re done, click Open Image 
to open it up in the main editing window.

6Add a Curves adjustment
Click the Create New Adjustment Layer icon at the bottom 

of the Layers palette and select Curves from the drop-down 
menu. Create another subtle S-curve to boost contrast and 
colour further still, and make the clubs stand out more against 
the night sky. Click on the ‘Background’ layer to select it.

Get the best from a strobe shot

1Evaluate the histogram
Launch your copy of Photoshop CS and go to File > Open to 

open masterclass_start.cr2 in the Camera Raw editor. You’ll 
notice the histogram is bunched up at the left. This is fine, as 
the background is supposed to be dark, but some of the 
shadows are clipped, meaning they’ll print out as pure black. To 
restore detail to these areas, drag the Blacks slider to 0.

2Tweak the exposure
Click on the triangle at the top right of the histogram to turn 

on the highlight clipping warning. Drag the Exposure slider right 
until red patches just start to appear. These patches indicate 
pixels at the highlight end of the histogram that will be clipped 
(those that contain no detail). Drag the slider back until the red 
patches just disappear again.



Sports & Action Photography Made Easy  159

Advanced projectsMasterclass

Over in a flash 
You don’t need a maths degree to understand strobe settings, but it helps!
The frequency of your strobe dictates how many bursts of flash 
you’ll get from your flashgun before it needs recharging. The 
greater the frequency (the higher the number of bursts per 
second) the fewer bursts you’ll get at a given level of flash power. 
This table summarises the maximum number of bursts at a given 
output and/or frequency on a Canon 
580EX flashgun. 

For our example shot, we wanted 30 
flashes over the course of a second, 
so reading down from the ‘20-50 
flashes per second’ column, you can 
see that we have to step down the 
flash power to 1/64 to get our 
maximum of 30 flashes. The 
disadvantage of using your flash on low 
power is that you need to position your 
flash closer – or increase the aperture 
or ISO – in order to light up your 
subject sufficiently. The advantage is 

that the lower the power of the flash, the faster the actual burst 
of flash is – ideal for freezing fast-moving action. In our golf shot, 
a burst of flash on 1/64 power lasts just 1/30,000 sec – plenty 
fast enough to clearly record every position of the club’s swing, 
and much faster than a typical max shutter speed of 1/4000 sec.

8Crop to centre
Holding down the Shift key to maintain the shot’s original 

proportions, click-and-drag the top-left corner in a bit, making 
sure not to crop out the heads of the clubs at the top of the 
frame. Next, let go of the Shift key and drag the bottom line of 
the crop box upwards to line it up with the grass.

10Sharpen and save
Finally, to sharpen up your image and give the clubs a 

really crisp edge, go to Filter > Sharpen > Unsharp Mask. Set 
amount to 100, Radius to 1 and Threshold to 1. When you’re 
done go to File > Save As to save your finished version as a 
PSD or alternatively, a TIFF file. 

7Check for symmetry
Grab the Crop tool and click-and-drag to select the entire 

image. If you look at the central crosshair of the cropping box, 
you’ll see that the golfer is pretty central, but an optical illusion 
makes him look as if he’s slightly too far to the right, so we 
need to crop in slightly to address this.

9Crop to straighten
The grass isn’t quite horizontal, so click just outside one of 

the corners to rotate the crop box until it lines up with the 
grass, and then drag the bottom line back down until it snaps 
into place. Toggle the crop box around with your cursor keys 
until you’re happy with the crop and then click the tick.

Flashes per sec 1 2 3 4 5 10 20-50 60-200

1/4 7 6 5 4 4 2 2 2

1/8 14 14 12 10 8 4 4 4

1/16 30 30 30 20 20 8 8 8

1/32 60 60 60 50 50 20 16 1 2

1/64 90 90 90 80 80 50 30 20

1/128 100 100 100 100 100 70 40 40
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WHAT YOU’LL NEED Photoshop Elements 6  
or above
WHAT YOU’LL LEARN How to get tack-sharp, 
flash-lit action shots; how to set second-
curtain sync on your flash; how to fine-tune 
exposure and colours
IT ONLY TAKES Half a day

Capturing motion-blur shots can be a lottery: 
it requires a combination of ultra-smooth 
panning and a shutter speed that will freeze 
your subject, but blur the background 
enough to give a sense of speed. Get either 
wrong, and the resulting shot looks like 

How to…  
Shoot flash-lit 
action images 
Firing a burst of flash at the end of a long exposure 
can freeze even the fastest-moving action. 
Discover the technique for your own images

it’s been taken on a trampoline! But all is 
not lost – with the help of a flashgun, you 
can add a burst of flash that will freeze the 
action, no matter how fast your subject is 
going. This is because a burst of flash lasts 
anything from 1/1000 sec to 1/40,000 sec, 
and the latter is fast enough to freeze the 
motion of a speeding bullet.
 Armed with our D-SLR and a flashgun, 
we went to the Manchester Velodrome 
for the Para-cycling World Championships. 
We’ll show you how we got this shot and 
how we boosted the motion blur to make it 
look more dramatic…  

Masterclass

Start images  
and video at  
www.bit.ly/ 
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Bonus
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Sports snappers often use predictive 
(or AI Servo) focusing in a continuous 
mode, but at close range, cyclists are 
so fast that it’s hard to keep your 
focus point on the subject. The way 
around this is to pre-focus on a point 
on the track, set your lens to manual 
(so it won’t hunt for a focal point 
later), then pan with your subject in 
frame until it reaches the right point 
on the track. It’s important to continue 
panning after you’ve taken the shot to 
ensure a smooth motion-blur effect.

Pre-focus your lens

MasterclassMasterclass

Indoor arenas can be quite dark, so getting exposure right is about striking 
a balance. Because your subject is moving so quickly, it may be just behind 
or just in front of your focal point when you release the shutter, so you need 
to set a reasonable aperture to ensure adequate depth of field. You also 
need a shutter speed that will give you the desired amount of motion blur, 
and as low an ISO as possible to minimise grain. For our shot, we set an 
aperture of f/7.1, a shutter speed of 1/30 sec and an ISO of 400.

Ensure adequate depth of field
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With shutter speeds as slow as 1/30 sec, it’s 
important to decide when your flash fires. With 
first-curtain sync it fires the instant the 
shutter opens; with second-curtain sync it 
fires right at the end. To give the impression 
that your subject is moving forward, you need 
to ensure that any motion blur is behind it. To 
do this, set second-curtain sync, which will 
freeze the action at the end of your exposure, 
after your subject has passed across the frame.

Set second-curtain sync

Custom flash
If your flash doesn’t feature second-curtain 
sync, you can set it in-camera using the 
relevant custom function (see your manual 
for details). If your flash does feature 
second-curtain sync, whatever you set on 
your flash will override your camera settings.

Masterclass

Some lenses with image 
stabilisation feature a 
panning mode, 
which will 
eliminate vertical 
camera shake 
without trying 
to correct 
horizontal 
movement. 
It’s important 
to set it to 
this mode if 
available for 
best results, and 
on many 
manufacturers’ 
lenses, this is  
marked as Mode 2.  

Set the right IS mode

With many sports, it can be difficult to get 
close to the action, but you don’t need to 
spend a small fortune on a long lens to fill 
the frame. Teleconverters magnify a lens’s 
focal length by a factor of 1.4x or 2x, and 
so will turn a 200mm lens into a 280mm 
or 400mm lens. Once you take into 
account the crop factor on many cameras, 
a 1.4x extender on a 200mm lens could 
give you an effective focal length of around 
450mm (1.6x200x1.4). They do reduce 
your lens’s maximum aperture (an f/4 lens 
will become an f/5.6 lens in the case of 
the 1.4x extender), but they produce really 
sharp shots and take up very little space 
in your camera bag.

Add an extension
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Exaggerate the blur

2Adjust the exposure
Click on the triangle at the top-right of the histogram to turn 

on the Highlight Clipping Warning. Drag the Exposure slider up to 
+0.25. This will brighten the biker and the background without 
adding unduly to the clipped highlights, which show up as red 
patches in the image.  

1Evaluate the image
Open masterclass_start.cr2 from the Video Disc in the 

Adobe Camera Raw editor. The histogram looks healthy, with a 
full tonal range, but the biker is slightly underexposed and the 
colours are a bit muted.

3Tweak the tones
The histogram doesn’t reach all the way to the left, 

indicating that there are no pure blacks in the image. To  
give the image a wider tonal range, drag the Blacks slider to 
+10. This will pull the histogram to the left slightly so that the 
darkest pixels in the image will now print out as pure black.

4Increase the contrast
This so-called remapping has the effect of boosting the 

contrast slightly. To boost contrast still further, drag the 
Contrast slider to +50 (any further will introduce clipping in the 
biker’s shirt). To help the biker stand out from the background, 
increase edge contrast by dragging the Clarity slider to +50.

5Brighten the colours
Finally, to brighten the blues, drag the Vibrance slider to 

+20 and make the reds richer by moving the Saturation slider to 
+10. Again, any further will start to introduce clipped highlights. 
Once you’re done, click Open Image to open up your edited 
version in Photoshop’s main editing window. 

6Blur the biker
To add motion blur, we need to blur a duplicate layer and 

then mask out parts of this layer to reveal selected areas of the 
sharp layer below. To do this, go to Layer > Duplicate Layer. Call 
this layer ‘Blur’, click OK, then go to Filter > Blur > Motion Blur. To 
add motion blur, set the Distance to 600 pixels. 
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9Reveal the rider
To mask out the blurred layer and reveal the rider below, 

gently click on the leading edge of the rider and his bike, taking 
care to remove the halo in front. Also spray over the logo on the 
track using strokes parallel to the track’s lines. As you spray, 
you’ll see a grey mask start to appear in the mask thumbnail.

10Boost colour and contrast 
Tweak colour and contrast by clicking on the Create A 

New Adjustment Layer icon at the bottom of the Layers palette 
and selecting Curves. In the dialog that appears, click on the 
diagonal curves line to create a subtle S-shape, as above. To 
save your image, go to File > Save As and select PSD or TIFF.  

Timing is everything...
...As these first- and second-curtain sync images demonstrate

8Add a mask
Click OK and then click the Add Layer Mask icon at the 

bottom of the Layers palette. Press D then X to change the 
foreground colour to black and then select the Brush tool from 
the Tools palette. From the preset picker, select a soft-edged 
brush of around 300 pixels and set Opacity and Flow to 50%.

7Set the direction
To make the blur look more realistic, we need to line it up 

with the direction the bike is travelling. Drag the line in the little 
circle until it’s roughly lined up, and then use the cursor keys on 
your keyboard to fine-tune it so that the lines on the track look 
as sharp as possible. We chose an angle value of -28. 

FIRST-CURTAIN SYNC
With the camera held still and the flash 
firing right at the start of a long exposure, 
the action is frozen at the moment the flash 
is fired, and the cyclist passes through the 
frame, registering as a blur.

SECOND-CURTAIN SYNC
The camera is held still again, but this 

time the action is frozen by a split-
second burst of flash right at the end 
of the exposure, after the cyclist has 

passed across the frame.
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 How to...
Improve exposure in 
Adobe Camera Raw
Enhancing your photos in ACR is more intuitive than you might  
think. Here’s a fairly typical case study that proves our point

Original shot
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WHAT YOU’LL NEED Photoshop CS or 
Elements 5.0 or later
WHAT YOU’LL LEARN How to use ACR to 
tweak tone, colour and contrast, how to 
appraise use a histogram
IT ONLY TAKES 5 minutes

Many people find the whole idea of 
shooting and editing in Raw a bit 

daunting but it doesn’t necessarily have 
to get too complicated. But once you get 
the hang of it, it’s surprisingly intuitive. 
If anything, it’s easier than using your 
standard image editor – partly because the 
most important controls can be found in 
one simple interface and partly because 
Raw images contain so much more 
information than JPEGs. A Raw file contains 

every last scrap of colour and tonal 
information captured by your camera’s 
sensor. This makes Raw files much more 
forgiving when it comes to fine-tuning 
exposure or boosting colour and contrast. 
In this tutorial, we’ll show you how to use 
the controls in ACR’s Basic tab to tweak 
a shot’s tones to perfection, and how to 
boost colour and contrast in seconds. 

Start images  
and video at  
www.bit.ly/ 
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3Boost the blacks 
Adjusting the exposure has shifted the histogram to the 

right and flattened it, weakening the shadows slightly. To deepen 
the shadows and improve contrast, press U to activate the 
shadow clipping warning too, then drag the Blacks slider to the 
right until blue patches start to appear. Now nudge it back to the 
left until they disappear.

5Correct the colours
The colours still look a bit flat, so drag Vibrance to +40 to 

boost the blues and browns and Saturation to +20 to boost 
reds and yellows. Vibrance affects only less-intense colours but 
Saturation boosts them all, even those that are already quite 
rich like the reds and yellows, so don’t be tempted to go any 
further or the shot will start to look garish. 

4Brighten it up
To brighten the image and bring out detail in the shadows 

without losing all texture in the clouds, move the Brightness 
slider to +40. This works on the midtones rather than the 
shadows or highlights, so the tonal extremes should be 
unaffected. The contrast is already quite strong, so leave 
Contrast and Clarity exactly as they are.

1Evaluate the exposure
Open Exposure_before.dng from the Exposure folder on 

your Video Disc. It’s a Raw file, so it will open in Adobe Camera 
Raw. If you look at the histogram you’ll see that the graph 
doesn’t stretch all the way to the right, indicating that our 
source file is underexposed and has no bright highlights. This is 
why the “white” of the helmet looks grey.

6Reveal shadow detail
As a final tweak, push the Fill Light slider to about +15 to 

reveal detail in the shadows without blowing out the highlights. 
Zoom in and scroll around the shot to check for areas of 
clipping or details that look flat – increasing the Clarity will 
boost midtone contrast and help offset the latter. Revisit the 
other sliders and tweak them as need be, keeping an eye on 
the histogram to judge the impact of your adjustments. 

2Tweak the tones
Press O to activate the highlight clipping warning, then drag 

the Exposure slider to the right until red patches appear on the 
bike rider’s crash helmet. Nudge the slider back to the left until 
they disappear. The shot now boasts a full range of shadows, 
midtones and highlights. Toggle the Preview on and off to see 
how the change has evolved. 
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WHAT YOU’LL NEED Photoshop CS5 or CS6
WHAT YOU’LL LEARN How to use ACR 
effectively, how to correct colour 
temperature and artefacts, how to remove 
noise using ACR, how to do all your image 
sharpening in ACR
IT ONLY TAKES 15 minutes

D-SLR technology is always improving, 
and one key area is the image quality 
of photos shot at high ISO settings. Not 
that long ago, shooting at anything over 
ISO800 on most D-SLRs would result in 
images too noisy and degraded to be 

considered usable. But these days on 
the latest cameras, it’s possible to shoot 
above ISO1600 – and even ISO3200 – 
and not have to worry too much about 
noise ruining your shots. But what if you 
don’t have the newest D-SLR or have Raw 
images with potential that are suffering 
from noise? Help is at hand! By utilising 
the power of Adobe Camera Raw (ACR) 
software, it’s possible to rescue noisy 
Raw images in a flash. Under the Detail 
tab are sliders to reduce both luminance 
(greyscale) noise, which makes an image 
look grainy, and colour (chroma) noise, 

which is visible as coloured artefacts. 
We’re using Photoshop CS5 and ACR 
version 6.2, which has more options 
under the Detail tab than previous 
versions, and produces better results 
when reducing noise in images suffering 
with pixels starting to ‘break up’, but the 
basics also apply to earlier versions of CS.
In this tutorial we’ll also show you how to 
correct the colour temperature of images 
that have been shot indoors under 
artificial lights, and how to do all your 
image sharpening without leaving the 
comfort of the ACR interface.

 How to…  
Clean up noisy Raws
Learn the best way to use Adobe Camera Raw for processing images and 
removing unwanted colour and luminance noise from your Raw images

Fix it in PhotoshopFix it in Photoshop

Start images  
and video at  
www.bit.ly/ 
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3Turn down the noise
First, you need to reduce the luminance noise of this 

image shot at ISO800. Click the Detail tab and zoom in to 
100% (Ctrl+Alt+0) so you can see the enhancements. 
Luminance noise is less tonally distinct than colour noise, so 
watch you don’t overdo noise reduction and end up blurring 
detail. We used the following settings: Luminance at 40, 
Luminance Detail at 50, leaving Luminance Contrast to 0.

5Clarity and vibrance
Click back on the Basics tab. Before you sharpen, adjust 

the Clarity slider – which adjusts midtone contrast. Set it to 
+20. While you’re there, set the Vibrance to +10 to boost the 
colours of the bicycles and clothing. The Vibrance slider 
minimises clipping as colours approach full saturation, by 
altering the saturation of lower-saturated colours without 
affecting the higher ones.

4Colour noise
Colour noise is generally more noticeable, so the ACR 

default colour noise reduction setting is 25, not 0. A good rule 
is to match the Colour noise slider with your Luminance setting, 
so for this image, set Colour noise to 40 and Colour Detail to 
50. Experiment with your own photos as the amount of noise 
can change depending on the D-SLR, lens and exposure.

1White balance correction  
First open the Noise_start.CR2 RAW file from the Video 

Disc in your version of Photoshop CS5 or CS6. As this track 
cycling photo was shot indoors under artificial lights, the white 
balance is a little bit off. To correct the colours here, adjust the 
Temperature slider to around 3750, and then drag the Tint 
slider down to -50 to get rid of the purple tint.

6Sharpen up
Always do your sharpening last, or further editing (including 

resizing) can introduce ugly artefacts! On the Detail tab are 
several Sharpening sliders that adjust edge definition. Now the 
clever bit: hold down Alt as you move each slider to see which 
parts of the image are affected. We set Amount to 40, Radius 
to 1.5, Detail and Masking to 30. Don’t overdo it, as it’ll add 
noise. Click Save Image in the bottom-left, and you’re done. 

2RAW basics
The two cycle wheels in the top-right corner are distracting, 

so grab the Crop tool, set mode to Normal from the drop-down 
menu and crop them off. To reduce the clipped highlights, set 
Recovery to 30. To brighten the riders and the dark Lycra, set 
Fill Light to 10 and set Blacks down to 0. To further lighten the 
cyclists, set Brightness to +60, keeping Contrast on +25.

Fix it in Photoshop
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WHAT YOU’LL NEED Photoshop Elements 
5.0 or 6 or Photoshop CS and above
WHAT YOU’LL LEARN   How to create a
sense of speed,  how to use the Zoom Blur
filter,  how to create a Layer Mask 
IT ONLY TAKES 15 minutes

Zoom blur is a fantastic in-camera 
technique, but it’s hard to get right and 
you’ll need plenty of time to 
experiment. So, if you’re photographing 
a moving vehicle, such as the scooter 
above, not only will you have to 
concentrate on your zoom skills, you’ll 

also have the challenge of travelling at 
the same speed in another vehicle while 
grappling with constantly changing 
backgrounds. It’s very rewarding when 
you get it right, but it can take a lot of 
trial and error beforehand.

We’ve made life a bit easier in this 
tutorial by using a simple but effective 
digital darkroom technique to create a 
similar effect. Not only will you be able to 
replicate the in-camera method without 
the time-consuming experimentation, 
you’ll also be able to control the intensity 
and impact of the end result.

With clever use of Photoshop’s Radial 
Blur filter and a Layer Mask, we’ll show 
you how to make static shots look 
action-packed. Frustratingly, layer 
masking in Photoshop Elements is limited 
to Adjustments Layers, so here we’ll 
show you a nifty solution that will allow 
you to make a fully functional mask in 
Elements. By following these simple 
steps you will be able to produce 
dynamic shots full of energy without any 
of the hassle of doing it in-camera. 

It’s an addictive and fun technique, so 
read on to find out more.

Do your action shots look too ‘frozen’? Fear not. You can inject a sense of 
speed into any photo in just a few steps using Elements’ Zoom Blur filter

Fix it in Photoshop

Original shot How to…  
 Add movement to 
static images

Start images  
and video at  
www.bit.ly/ 
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5Sharpen up
Now that you’ve effectively created your Layer Mask, 

highlight the white box and use the Brush tool from the Tools 
palette to start painting the areas you want to stay sharp 
(without the zoom effect). Ensure that your foreground colour is 
set to black and choose an appropriately sized brush. You can 
alter the Opacity settings to vary the intensity of the effect, 
especially around the edges.

2Zoom away
To apply the zoom effect, go to Filter > Blur > Radial Blur 

and then select the Zoom option from the window that 
appears. In the Blur Centre box, move the central point around 
so that the blur effect ‘zooms’ out from rider’s head. To 
establish the best location for your blur, select the Draft option. 
This will create the effect very quickly so you can check it’s in 
the right place and reposition if necessary.

Fix it in Photoshop

3Quality assurance
Once you’ve located the correct point and applied the 

amount of zoom you want – we set Amount to about 25, but 
it’s well worth experimenting with other settings for different 
pictures – select the Best quality option and click OK. It will 
take longer to generate the effect at this setting, but the 
resulting quality will be visibly better. 

4Create a new layer
Making a Layer Mask in Elements 6 is tricky, but here’s a 

workaround. Make a Levels Adjustment Layer (Layer > New 
Adjustment Layer > Levels), then click OK twice without making 
any changes. A new Adjustment Layer will appear alongside a 
white rectangular box. This is your Layer Mask. Drag this layer 
between the ‘Zoom Blur’ layer and the ‘Background’ layer. 
Highlight the top layer and then press Ctrl+G to group the 
‘Zoom Blur’ layer with the Adjustment Layer.

1Open the source file
First, open the zoom_start.jpg file from the Video Disc. 

You’ll be working on multiple layers in this tutorial, so you’ll 
need to create a duplicate layer. To do this, go to Layers > 
Duplicate Layer. It’s good practice to name your layers as you 
create them, so rename this layer ‘Zoom Blur’.

6Fine-tuning
If you make a mistake, change the foreground colour to 

white and paint back over the area again. It’s good to leave 
parts of the bike and rider blurred, especially around the edges, 
so don’t be too accurate with your brush work. Press 
Shift+Ctrl+Alt+E to create a compressed version of the image 
on a new layer, where you can make final tweaks – such as 
burning and sharpening – and you’re done. 
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 How to…  
 Zap ugly distractions

1Take down the power lines
Open the clone_start.jpg image in Photoshop or Elements 

and select the Clone Stamp tool from the Tools palette. Select 
a soft brush. As the cables are thin, choose a small brush size 
of around 30 pixels. Switch the Blending Mode to Lighten. This 
will enable you to remove only the pixels that are darker than 
the area you’ve cloned, leaving the snow and sky intact.

3Up close and personal
Now set the Opacity to 100% and tick the Aligned box. For 

neat cloning, you’ll need to get in really close to the area you’re 
working on, so zoom in to 100% using Ctrl+ or go to View > 
Actual Pixels. Hold down the Space bar to pan around and find 
the cables, starting from the top left-hand edge of the image. 

4The dark side
Clone out all of the cables in Lighten mode, then switch to 

Darken mode to remove any lighter pixels left behind (the Darken 
mode only removes pixels lighter than the area you’re cloning). 
Zoom in to 400% when removing the cables by the snowboarder, 
making individual clicks rather than brush strokes. 

Use the Clone Stamp tool to clean up your images and boost their impact
WHAT YOU’LL NEED Photoshop CS or 
Photoshop Elements 5.0 or later 
WHAT YOU’LL LEARN How to use the 
Clone Stamp tool to minimise distractions, 
how to remove unwanted objects from 
your shots, how to clean up your images
IT ONLY TAKES 2 to 3 minutes per image

The Clone Stamp tool is one of the 
most popular image-editing features in 
Photoshop and Photoshop Elements. 

However, it’s also one of the most 
abused and misused – and can easily do 
more harm than good. 

Used correctly, the Clone Stamp 
tool can transform your images by 
cleverly removing ugly distractions, 
such as people or birds, to make them 
look more professional and ‘clean’, 
while maintaining the original picture’s 
realism. Used incorrectly, you could ruin 
a photograph with over-eager cloning and 

end up with a heavily manipulated image 
that looks totally unrealistic. 

In this tutorial, we’ll show you how to 
use the Clone Stamp tool properly, how 
to choose the right brush size and how 
to set the best mode to work effectively 
with light and dark areas. You’ll learn how 
to clone sky and backgrounds to remove 
the distracting cables in this shot of a 
snowboarder. See this month’s Video 
Disc for a more detailed guide to cloning.

 

2Attack of the clones
Hold down the Alt key to turn the cursor into a crosshair. 

Click once to sample the sky close to the cable, which should 
match the sky ‘behind’ the cable. Now brush over the area and 
remove the cables completely. Keep resampling using the Alt 
key and continue brushing, and be prepared to use the Undo 
History palette if you make a mistake.

Start images  
and video at  
www.bit.ly/ 
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Use Photoshop Elements’ Adjust 
Colour Curves command to transform 
uninspiring photos into vibrant stunners

WHAT YOU’LL NEED Photoshop Elements 5.0 or above
WHAT YOU’LL LEARN How to boost your images’ tones and 
colours, how to use the Adjust Colour Curves command, what 
shape curve you need to boost tones and contrast
IT ONLY TAKES 5 minutes

Digital photographers sometimes complain that their photos 
look a little flat straight out of the camera, but this isn’t 
because there’s anything wrong with the camera itself – 
digital sensors just produce images with less contrast and 
saturation than traditional film. All these shots need is a 
helping hand to boost their contrast and colour.

Thankfully, there’s a simple solution: the handy Adjust Colour 
Curves command in Photoshop Elements. This makes it easy to 
fine-tune your images’ contrast and tones by adjusting 
highlights, midtones and shadows independently. You can also 
opt for one of the eight preset Styles provided, but we’d suggest 
building on those enhancements by tweaking the various sliders 
manually. Each time you move one of the four sliders, you’ll see 
the curve on the graph in the bottom-right corner changing 
shape. Follow our guide to find out how it’s done.

1Out of the starting gate 
Begin by launching Photoshop Elements and opening the 

curves_start.jpg image from your Video Disc. Elements has a 
fairly clever auto option to boost your shot’s tones. Try it by 
going to Enhance > Auto Contrast. However, to make more 
noticeable improvements with extra control, use Adjust Colour 
Curves. Go to Edit > Revert to undo the Auto Contrast.

2Pick a Style 
Now go to Enhance > Adjust Colour > Adjust Colour Curves. 

You’ll be greeted by the Adjust Colour Curves window and a 
display showing before and after images. There are a number of 
Styles: Backlight, Darken Highlights, Default, Increase Contrast, 
Increase Midtones, Lighten and Shadows. However, the last 
Style, Solarise, is rather an acquired taste…

Original shot

Expert tip Love those curves
By using Adjust Colour Curves and its Highlight, Midtone 
Brightness, Midtone Contrast and Shadows sliders, you’ll 
quickly get an idea of the shape of curve you need for 
different effects. This is handy should you ever upgrade 
to Photoshop CS and use the powerful Curves tool.

 How to…  
Boost contrast and 
colour in seconds
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4Take more control 
Use the four sliders on the right to fine-tune your 

enhancements. Nudge the Adjust Highlights, Adjust Shadows 
and Midtone Brightness sliders to the right and the Midtones 
Contrast slider to the left. The curve on the graph changes 
shape as your image becomes brighter and contrast increases. 
Click OK when you’re happy with the result. 

3Select Increase Midtones 
From these options, you could just select the Increase 

Contrast Style to quickly enhance the overall contrast of this 
image. However, we’re looking to boost the shot’s overall tones, 
as well as brightening up the jockeys’ colourful clothing and the 
green grass of the racetrack. For this reason, we think the 
Increase Midtones Style works best in this instance. 
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WHAT YOU’LL NEED Photoshop Elements 
5.0 or above
WHAT YOU’LL LEARN How to use 
Photoshop to throw backgrounds out of 
focus, how to trick Elements into providing 
a Layer Mask, how to blur selected areas 
to mimic shallow depth of field
IT ONLY TAKES 15 minutes

Backgrounds often ruin what is an 
otherwise perfect picture. Even if the 

subject is perfectly framed and focused, 
things in the distance can prove an 
insurmountable distraction. This is 
particularly true when shooting in a crowd 
– at a sporting event or carnival, for 
example – as spectators and clutter are 
often impossible to crop out of your 
composition. Throwing the background 
out of focus using the widest aperture 
that your lens allows is the obvious first 
step to fixing this problem. But doing this 

is certainly not a sure-fire solution to the 
issue – even if an advertising hoarding, 
for example, is out of focus, it can still be 
a significant distraction. The Photoshop 
solution is to create a completely blurred 
version of your problem picture. By 
skillfully combining this with the original 
using a hand-painted mask, the subject 
looks sharp and the backdrop believably 
blurred. Here’s how you can achieve the 
effect in just six simple steps.

Fix it in PhotoshopFix it in Photoshop

Original shot

 How to…  
 Blow out the 
background
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Ever wish you’d taken a shot with a wider aperture? Make it happen in 
Photoshop by using a blur filter and a painted mask
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3Create a ghost layer
Click on the half-moon icon in the Layers palette, and pick 

any of the Adjustment Layer options. We’ve chosen Levels. 
Don’t move any of the sliders – we’re simply going to use the 
mask that comes with this layer to control which parts of the 
pictures are sharp, and which are blurred. If you are using 
Elements 7 or earlier, you’ll need to click OK.

5Get out the paintbrush
Click on the white rectangle in the Levels layer. Press 

Alt+Delete, and the mask becomes black (and the original 
image is revealed again). Grab the Brush tool and select a 
soft-edged brush from the preset picker. Set Size to 500 pixels 
and Opacity to 100%. Set the foreground colour to white (press 
X). Paint over the background to reveal the blurring beneath.

4Cheat the system
There’s some jiggery-pokery needed to get the mask to 

work as we need it to. Drag the ‘Levels 1’ Adjustment Layer 
below the ‘Blur’ layer in the Layers palette. Now press the Alt 
key and hover the cursor between the ‘Blur’ and ‘Levels 1’ 
layer; when a double-circle symbol appears, left-click with the 
mouse. The ‘Blur’ layer icon will then move to the right. 

6Fine-tune the mask
As you get closer to the subject, you need to reduce the 

size of the brush (use the [ key as a shortcut), and the Opacity 
(press the 7 key to reduce to 70%, 4 for 40% and so on). Take 
your time creating the mask, so you can’t see the joins. 
Alt-clicking on the mask icon enables you to see (and paint on) 
the mask, and to highlight areas you might have missed. 

Fix it in PhotoshopFix it in Photoshop

1Create a copy
Open the image blur_start.jpg from the Video Disc in Full 

Edit mode. Check the Layers palette is visible (go to Window > 
Layers if it’s not). Right-click on the ‘Background’ layer icon in 
this palette, and choose Duplicate Layer. Rename this layer 
‘Blur’ in the window that appears. Click OK. 

2Use a filter to add blur
From the Filter drop-down menu at the top of the screen 

choose Blur, then Gaussian Blur. Set the Radius to the amount 
that makes the background look as out of focus as you want it 
– around 70 should do the trick. The main subject will also 
appear blurred, but don’t worry about this now. Click OK.
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2Click to start
Set Width to 10 pixels, Contrast to 10% and Frequency to 

57. Zoom into your image using Ctrl and +. Now carefully move 
your mouse to a starting point on the subject edge and click. 
Continue to move the mouse around the edge of the subject, 
letting Elements place points automatically. If it makes a 
mistake, just hit Backspace to remove a point.

1Set up Magnetic Lasso
Open up panning_start.jpg from your Video Disc and 

duplicate the ‘Background’ layer by pressing Ctrl+J. Now we’re 
going to select the main subject using the Magnetic Lasso tool. 
Press L to select it, making sure it’s set to New Selection in the 
Options bar (the first of four icons along the top).

WHAT YOU’LL NEED Photoshop  
Elements 6 or above 
WHAT YOU’LL LEARN How to cut out a 
subject with the Magnetic Lasso tool, 
 how to create motion blur with the Motion 
Blur filter,  how to tidy up edges with the
Blur and Eraser tools,  how to clone out
ghosting with the Clone Stamp tool
IT ONLY TAKES 1 hour

Panning is a great in-camera technique 
where you track a moving subject with 
your camera as you release the shutter. 

Recreate the effect of in-camera panning by blurring the background  
behind your subjects to create the appearance of dramatic movement

Get the movement and the shutter speed 
right and you’ll keep the subject sharp 
while the background falls into a dizzying 
blur; it’s great for creating a sense of 
movement and drama. However, it’s a 
skill that’s hard to master, so it’s good 
news that there’s a Photoshop alternative 
for those that haven’t got the patience to 
perfect it, or for those images where the 
necessary shutter speed wasn’t available 
because of particular lighting conditions.

Recreating a panning effect in 
Photoshop isn’t actually that difficult at 

all. There’s a filter dedicated to producing 
the right sort of look called Motion Blur, 
and all that’s required is to make sure it’s 
applied to the background and not the 
main subject itself, which does mean a 
bit of time making a selection to isolate 
the subject from the background. 
Photoshop Elements users can make use 
of the Magnetic Lasso tool for this, while 

Photoshop CS users can employ the 
Pen tool for even more accurate results. 
Then it’s just a case of applying the blur 
and cleaning up any ghosting.
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   How to…
Add go-faster blur  
to static subjects
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3Complete the selection
Work your way around the outside edge of the bike and 

rider, ignoring enclosed areas, like the space between the forks. 
You may need to click to place points manually if Elements 
doesn’t get it right. When you reach your start point, hover over 
it and a circle should appear. Click to complete the selection.

4Subtract from selection
With the selection still active, press L to select the 

Polygonal Lasso tool and set it to Subtract From Selection in the 
Tool Options bar (the third icon along). Now carefully draw new 
selections in the areas between each of the forks, completing 
the selection at the start point each time. Do the same with the 
other enclosed background areas.
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7Clean up edges 
Deselect with Ctrl+D. You can work over any edges that 

don’t look spot-on using the Blur tool (press R) on parts of the 
background that haven’t been blurred, or alternatively the 
Eraser tool (press E) for parts of the subject that have been 
blurred by mistake. The ghosting visible around the edge of the 
subject now needs to be removed. 

5Invert and Save
These areas will now be subtracted from the overall 

selection. As we actually want the background selected and not 
the subject, you’ll need to invert the selection using 
Ctrl+Shift+I. It’s a good idea to save at this point, just in case, 
so use Select > Save Selection and give it a name. You can 
reload the selection if necessary, via the same menu.

6Apply the blur
Go to Filter > Blur > Motion Blur. Set the Angle as horizontal 

on the dial and set Distance in pixels so the background 
becomes very blurry. The amount you’ll need will depend on the 
pixel size of the image – we chose 700 pixels for our image. 
Watch how the background blurs but the motorbike remains 
unchanged. Zoom in to look at the edges. Click OK. 

8Clone out ghosting 
Create a new layer and select the Clone Stamp tool, set to 

Aligned and Sample All Layers. Reload your selection with 
Ctrl+Shift+D, or via the Load Selection command. Select a large 
brush size and Alt-click to clone suitable areas from the 
background adjacent to any ghosting, before brushing over the 
ghosting to replace it. Work first on the left, then the right side 
of the subject. 

Expert tip Using the Pen tool in Photoshop CS
For those of you lucky enough to own 
a copy of Photoshop CS, you can use 
the Pen tool to make your cutouts; 
although quite fiddly, it’s much more 
accurate than the Magnetic Lasso 
tool. Press P to select the Pen tool 
and make sure it is set to Paths in the 
Options bar. Click to plot your first 
point, then click again to plot a 

second point along the edge and, 
keeping the mouse button depressed, 
drag to create a curve before 
releasing. Now Alt-click that last point 
and continue. Each time you plot a 
point you need to Alt-click it to prevent 
the following curve from being spring 
loaded. Join up the path and use 
Ctrl+Enter to turn it into a selection.

Fix it in Photoshop
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Get creative in Photoshop Elements, using layers and effects to make your 
subject look as though it’s jumping out of the photo’s frame
WHAT YOU’LL NEED Photoshop Elements 
5.0 or above  
WHAT YOU’LL LEARN How to select a 
subject quickly and accurately, how to 
make a subject leap out of the frame, how 
to add a 3D effect to the finished frame
IT ONLY TAKES 15 minutes
 
Some shots have such sharp resolution, 
strong contrast and vibrant colours 
that the subject seems to be leaping 
out of the frame. Thanks to Photoshop 
Elements’ pixel-pushing powers, you 
can exaggerate this effect in the digital 
darkroom. In this tutorial we’ll use some 

great techniques to make your friends 
and family literally appear to be climbing 
out of the shot! 

The 3D effects that we’re using here 
are simple to learn. They’re a really good 
way to produce eye-catching portraits 
that’ll stand out from the crowd – and 
have people admiring your creative 
image-editing skills at the same time! 

In the following walkthrough we’ll show 
you a quick and effective way to select 
the main subject so that it’s isolated 
from the other elements in the scene. 
You’ll also learn how to fine-tune your 
selection to perfection using brushes and 

keyboard shortcuts, before placing the 
cut-out subject onto a new layer. Then 
you’ll use the Marquee tool to create a 
photo frame that appears to be located 
behind the subject. 

Finally, you’ll discover how to give 
the 2D frame a border and a 3D edge, 
courtesy of Elements’ amazing Effects 
palette, which contains some great tools 
for adding artistic enhancements to your 
images. As a finishing touch, we’ll show 
you how to add a shadow to your main 
subject to help lift it out of the scene. So, 
let’s get started and give your images an 
extra dimension!

Fix it in Photoshop

Original shot

Fix it in Photoshop
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Add a dramatic  
3D effect to images
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3Select the frame
Target this new layer by clicking on its thumbnail in the 

Layers palette. Choose the Rectangular Marquee tool from the 
Tools palette and then draw a rectangle around the area that you 
want to remain visible inside the picture frame. Once you’ve 
made the selection, go to Select > Inverse to choose all the 
pixels outside the original selection.

5Add a shadow and border
Go to the Effects palette and click the Layer Styles icon. Set 

the palette’s drop-down menu to Inner Shadows and drag the 
Low layer style onto the white background in the main image. 
This adds a drop shadow to the edge of the frame. Double-click 
on the ‘Colour Fill 1’ layer’s FX icon. Tick the Stroke box, choose 
a white colour and set Size to 40. Click OK.

1Make a selection
Open frame_start.jpg from the Video Disc. Bring up the 

Layers palette, then drag the ‘Background’ layer thumbnail onto 
the Create A New Layer icon to duplicate it. To isolate the hurdler 
on the ‘Background Copy’ layer, choose Quick Selection from the 
Tools palette. Click Add To Selection in the Options bar, set Brush 
> Diameter to 30 and spray over the hurdler.

2Fine-tune the selection
If the Quick Selection tool selects part of the background, 

tick the Subtract From Selection box in the Options bar. Spray on 
the unwanted areas. If an area is too fiddly, pick the Selection 
Brush tool and spray to select areas manually. Hold down Alt to 
deselect sections as you spray. When you’re finished, press 
Ctrl+J to float the selection to a new layer.

Fix it in PhotoshopFix it in Photoshop

4Add a solid colour
Hide the ‘Background Copy’ layer by clicking on its eye icon, 

then click on the Create Adjustment Layer icon and choose Solid 
Colour from the menu that appears. Set the colour to white. This 
fills the inversed marquee selection with white. Next, drag the 
Solid Colour layer below the isolated athlete’s layer. She’ll look 
like she’s jumping out of the frame.

6Create a shadow
Ctrl-click ‘Layer 1’ to make a person-shaped selection. Click 

Create A New Layer. Select Edit > Fill Selection, then Black. Click 
OK. Press Ctrl+D. Drag the shadow layer below ‘Layer 1’. Go to 
Filter > Blur > Gaussian Blur to soften the edge. Set Radius to 23 
and click OK. Use the Move tool to take the shadow right and 
down. Erase the parts inside the frame. 
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1 Bumper crop 
Open resize_start.jpg in Photoshop Elements. To crop out 

the foreground, pick the Crop tool and type ‘9in’ in the Width 
field, ‘6in’ in the Height field and ‘300’ in the Resolution field. 
Click on top-left corner of the shot. Drag the cursor towards the 
bottom-right corner to select top part of the image. Drag in the 
corners of the marquee to crop in on the car. Click on the tick.

   How to…
Enlarge your 
photos Original shot

WHAT YOU’LL NEED Photoshop 
Elements 5.0 or above
WHAT YOU’LL LEARN How to 
zoom in on your subject by 
cropping out the background, 
how to enlarge a crop to create 
a high-resolution A3 image
IT ONLY TAKES 5 minutes
 

3 Keep it smooth
To resize your image without it pixellating, tick Resample 

Image followed by Constrain Proportions (this links width and 
height so that any change to one automatically alters the other 
in the correct ratio). Next, select Bicubic Smoother from the 
drop-down menu – this adds new pixels while ensuring that the 
edges in the shot remain smooth.

4 Go large
Now type 16 into the Width box – the height is 

automatically adjusted – you’ll notice that the width in pixels 
changes from around 2800 to 4800, thanks to the additional 
pixels the software has created. Click OK. To give the car nice 
crisp lines, zoom in and go to Enhance > Unsharp Mask. Set 
Amount to 150, Radius to 1.5 and Threshold to 5. Click OK. 

2 Size it up
Go to Image > Resize > Image Size. Select inches in the 

Document Size Width and Height drop-down menus. Your 
cropped image is now 9x6 inches at a resolution of 300dpi. 
This is the best resolution for printing. This will give you a 
high-quality print at this size, but if you try to print it out much 
bigger, you should note that pixels will appear.

Wishing you could zoom in on your subject 
but not having a long enough lens is a 
common problem. You can just make do with 
the lens you’ve got and crop in afterwards, but 
you end up with a much smaller image. If you 
then want to print this any larger than, say, A4, 
you run the risk of losing image quality. 

But all is not lost. Photoshop Elements lets 

you enlarge images without affecting quality, 
as long as the original is fairly high-resolution. 
This uses a process called interpolation, which 
involves creating additional pixels with tonal 
values based on information provided by 
surrounding pixels. Here’s a quick and easy 
way to create a high-quality A3 print from an 
original image that’s been severely cropped. 

Use Photoshop to resize your images and create high-quality A3 prints

Start images  
and video at  
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4Finishing touches 
You can also use the Sponge tool to boost the colour of 

skies, as well as the grassy foreground in this shot. In Saturate 
mode, increase the brush size to about 800 pixels, then make 
broad sweeping paint strokes from right to left to right across the 
sky, and then across the grass at the bottom of the frame. 

   How to…
Boost specific 
colours
WHAT YOU’LL NEED 
Photoshop Elements 7.0  
or above 
WHAT YOU’LL LEARN  
How to use the Sponge tool 
to increase or decrease 
selected areas and tweak 
tones to perfection 
IT ONLY TAKES 5 minutes

Original shot

Fix it in Photoshop

2 Remove distracting colours
First, desaturate parts of the background, such as the 

distracting orange jacket on the left and the red coat on the 
right. Now click and hold the mouse button, painting over the 
offending areas. Build up slowly. Each time you release the 
mouse button, then click and hold and paint again, you’ll strip 
more of the colour away.

1Change the tool settings 
Launch your version of Photoshop Elements and open the 

sponge_start.jpg image from your Video Disc. Select the 
Sponge tool from the left-hand tool bar – it’s in with the Dodge 
and Burn tools. Choose a soft brush with a Size of around 200 
pixels, then set Mode to Desaturate and Flow to about 10%.

Colours. The world is certainly a brighter place 
with them, but when photographing colourful 
subjects, what you see and what images you 
end up with can be really quite different. While 
there are lots of ways to boost saturation in 
Photoshop, some are too long-winded for small 
changes. Photoshop Elements offers a quick 
solution in the shape of the Sponge tool, which 
can be used to make targeted enhancements to 

specific parts of your images in just a few 
mouse clicks, without the need for layers.
This clever little brush is part of the Dodge and 
Burn toolset and enables you to enhance or 
diminish the colours of individual areas without 
affecting your whole image. It works by 
increasing or decreasing saturation, depending 
on whether you’re in Saturate or Desaturate 
mode. Here’s how to use it…

3Boost the yellow 
Now you can look at increasing the saturation of the main 

subject – the not-so-bright yellow classic car speeding through 
the frame. To do this, switch the Mode to Saturate and then 
paint carefully over the yellow car, once again building up the 
effect slowly. Drop the brush size down to about 100 pixels and 
paint over the orange and red gloves.

Use the Sponge tool to saturate/desaturate selected areas

Start images  
and video at  
www.bit.ly/ 
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WHAT YOU’LL NEED Photoshop Elements 6  
or Photoshop CS, or above
WHAT YOU’LL LEARN More advanced  
batch-processing methods
IT ONLY TAKES 10 minutes

There are lots of advantages to shooting in 
Raw, but the downside is that shots in this 
top-quality format take longer to process 
than their JPEG counterparts. The ability to 

 How to…  
Find a faster way 
to process images
Don’t waste time editing your shots one by one: use our high-speed 
method to manipulate a batch of Raw shots all at once
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tweak exposure, contrast and colour without 
losing quality might be a convincing reason 
to use Raw whenever possible, but the extra 
steps involved on the computer can be a real 
pain when you have lots of pictures that need 
processing quickly. Fortunately, there’s a way to 
speed things up by working on a group of Raw 
files simultaneously. Not many people realise 
that ACR is capable of processing a whole 
group of Raw images at the same time, even 

allowing you to apply the same adjustments to 
a sequence of images simultaneously. 

In this tutorial, we’ll be building on the basic 
principles of batch-processing, showing you 
some of the more advanced techniques that 
you can use to manipulate loads of photos at 
once when you have the chance, while switching 
quickly to make individual edits when that’s your 
best option. When you master these principles, 
you could save yourself hours at the computer.

Start images  
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2Multi-tasking with ACR
The files open in Adobe Camera Raw and are displayed on 

the left-hand side of the screen. If you click each in turn you 
can make individual changes, but you want to edit them all 
simultaneously. Click Select All. You’ll only see one picture in 
the central image area: if it isn’t representative of the group, 
select a better shot from the thumbnails, then click Select All.

3 Rescue highlights and shadows
The bright day has created a series of high-contrast 

portraits. The unprocessed files don’t show Lewis Hamilton’s 
face clearly enough, and some areas are too bright. The first 
step to correcting this is to adjust the Recovery and Fill Light 
sliders. Notice how the Histogram in the top right squeezes 
inwards, reducing the highlights and shadows.

5Standard settings
The Clarity and Vibrance sliders are almost always worth 

adjusting upwards. The Clarity slider improves apparent 
sharpness, while the Vibrance slider improves saturation in a 
much more subtle and controlled way than the Saturation 
slider. Remember, at this point you’re still making adjustments 
to all four of the images.

6Crop the lot
All the shots need some cropping. Because the 

composition of each photo is different, you can’t apply the 
same crop to all four. However, because you want to save these 
images as a group, it will look neater if they’re cropped to the 
same proportions. Click the on Crop tool and then choose an 
Aspect Ratio that suits the set – try 4 to 5. 

4 Brighten up the image
Although you have improved the contrast, the image  

now looks flat and Lewis Hamilton’s face is still too shadowy. 
Use the Brightness slider to lighten the image. Adjusting this, 
rather than the Exposure slider, ensures that you don’t blow out 
the highlights you’ve just rescued.

1Open several files together  
Launch Photoshop Elements and select File > Open. From 

here, you can choose images to process as a batch. It’s best 
to group together shots taken in the same lighting: for this 
tutorial, you can use the four Raw files supplied on the disc. 
Click the upper file, then hold down the [Shift] key and click the 
lowest file, selecting everything in-between. Now click Open.
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8Remove unwanted images
There may be some shots in your sequence that aren’t 

worth keeping: this is the perfect time to cull images that are 
out of focus or blurred. In this shot, Lewis Hamilton is looking 
away from the camera. If you press the [Delete] key on the 
keyboard, the shot is marked for deletion and will be moved to 
the Trash when you have finished.

7 Individual editing
Click on each of the images in the left-hand thumbnail list 

in turn. Crop each photo to maximise the impact of each shot 
and lose as many of the bystanders in the background as 
possible. At this stage, you can also fine-tune the Exposure and 
Contrast sliders so that they are perfectly suited to the 
particular frame you’re working on.

9 Select the images again
When you’ve made your final adjustments to the images 

individually and weeded out any shots that you don’t want, it’s 
time to save your sequence. To do this, first click Select All in 
the top left corner again, so that all of your chosen images are 
highlighted once more.

11Take action with the Photo Bin
Your selected images will now open in Photoshop 

Elements’ Full Edit mode. You don’t need to make any more 
adjustments – just save each of the images as JPEGs. Ensure 
the Photo Bin is open so that you can see thumbnails of your 
chosen images. Click on Bin Actions above the thumbnails and 
choose Save Bin as an Album from the drop-down menu. 

12Save your set
It’s worth creating a new folder to keep all your edited 

shots together. Choose the JPEG option from Format, then 
choose a quality setting of five or six to reduce the file size 
down to something sensible. Keep the Format Option at the 
Baseline Standard. 

10 Open the images to save
If you’re using Photoshop, you can use the Save 

Images option to save your files as JPEGs quickly and easily. 
With Photoshop Elements, however, this option is not available 
and Save Images only allows you to save your shots as DNG 
files. Press the Open Images button instead.
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THE CONTENDERS
1  Canon EOS 60D, £800 

The maximum burst rate of 5.3 frames per 
second isn’t particularly fast, but the articulated 
LCD comes in handy

2  Canon EOS 7D, £1,100 
Top dog for continuous drive mode, with 
a blistering 8fps, the EOS 7D boasts an 
impressive range of sporting credentials

3  Nikon D7000, £860 
Surprisingly compact, the D7000 boasts a 
39-point autofocus sensor and dual SD/HC/XC 
card slots for doubling up on memory

4  Nikon D300S, £1,065 
The venerable D300S is a tough, 
seasoned competitor, but it lags behind 
newer models in resolution

5  Pentax K-5, £780 
With a faster continuous drive rate and higher 
image resolution than the old K-7, the K-5 is 
small and light, but it still packs a punch

6  Sony A580, £530 
Increased image resolution, a new autofocus 
sensor and video capture facility make the Sony 

A580 a worthy update to the A550  
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Best SLRs 
 for action

After a good SLR for shooting sports and action?  
We test the stars of track and field photography
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We began our rigorous testing programme by 

putting the cameras through their paces at a 

local sports event. In order to assess the 

performance, we fitted each of the SLRs with 

their own manufacturer’s fast telephoto zoom 

lenses, typically 70-200mm f/2.8, and 

50-135mm f/2.8 in the case of the Pentax.

Particular attention was paid to metering 

accuracy, and each camera’s ability to deliver 

fast, precise autofocus for both static and 

moving targets. We used the cameras under a 

wide range of indoor and outdoor lighting 

conditions, and we shot test images across 

the entire sensitivity range. 

 We also looked for quick access to 

important parameters such as autofocus, 

metering modes, white balance and ISO, 

based on the need to adapt quickly to varying 

shooting opportunities in sports photography. 

In controlled lab conditions, we shot a series 

of charts that measure dynamic range, noise 

and colour accuracy using each camera in the 

test. We then fed the resulting images 

through Imatest Master and DxO Analyser to 

test the cameras’ performance. In addition to 

the charts tested by software we also shot a 

resolution chart that’s assessed by eye. This 

indicates how much detail the cameras are 

capable of recording in line widths per 

picture height (LW/PH). 

How we test SLRs Advice you can trust

Long telephoto shots are a 

keystone of sports photography, so 

camera shake is a danger even at 

relatively fast shutter speeds. To 

combat this, there are two rival 

systems. Canon and Nikon use 

optical stabilisation, based on a 

microprocessor-controlled group of 

elements within the lens. Pentax 

and Sony favour sensor-shift 

stabilisation, used first in 

camcorders, where vibrations are 

compensated for by the image 

sensor moving.

Our tests found optical 

stabilisation more effective when 

using long telephoto lenses, 

especially in panned shots. Many 

of the latest optically stabilised 

lenses automatically detect 

panning, and only apply correction 

in the opposite plane.

C
apturing the defining moment 
as sporting action unfolds 
before you demands an 
immediate response. It 

requires split-second timing on the part 
of the photographer, and a camera 
that’s ready to roll at the press of a 
button. SLRs are in a different league to 
compact cameras in this respect.

Autofocus speeds are much quicker, 
you can fit the ideal lens for the job, and 
there’s no time wasted fiddling around 
with motorised zoom mechanisms. 
You also benefit from the real-time 
immediacy of an optical viewfinder 
without lag or jittery frame rates when 
panning. But for serious sports shooting, 
some SLRs are much better than others.

Starting simple 
The phase-shift autofocus systems 
employed by SLRs usually react quickly, 
as well as doing a good job of tracking 
moving targets. Cameras such as the 
Canon EOS 7D and the Nikon D7000 
and D300S are particularly good at 
coping with erratically moving objects. 
With 19, 39 and 51 autofocus points 
respectively, these SLRs have the 
potential to keep locked on to relatively 
small objects if they stray away from the 
initially used focus point. Using relatively 
humble nine-point or 11-point autofocus 
sensors, there’s more danger that 
tracking will fail as objects fall between 
adjacent focus points.

Another issue is how many of the 
autofocus points are cross-type. A 
cross-type AF point can resolve detail 
in both vertical and horizontal planes, 
making it more successful at locking on 
to tricky targets. Some cameras only 
have a single cross-type AF point at the 
centre, whereas others have a larger 
set. For example, the Sony A580 has 
a total of 15 AF points, with the central 
three being cross-type. Frustratingly, it 
only provides 11 of its advertised 15 AF 

points during regular shooting with the optical 
viewfinder. The larger number of 15 points is 
only available in live view mode.

As for Nikon, nine of the D7000’s 39 
AF points are cross-type, as are 15 of the 
D300S’s 51 AF points. The Pentax K-5 
includes nine cross-type AF points, while in 
the Canon 60D (9 focus points) and EOS 7D 
(19 focus points), all AF points are cross-type.

Open wide
Lenses with large maximum apertures 
enable faster shutter speeds for freezing the 
action. However, the trade-off is that depth 
of field will be very small, especially with 
long telephoto lenses. This can be neat for 
blurring the background, but it puts increased 
demands on pinpoint accuracy in autofocus.

Shooting with large apertures isn’t always 
practical, either, because if you're shooting 
something coming towards you at speed, 

such as a racing car, you’re likely to end up 
with only the front or the back of the car sharp 
due to the shallow depth of field. 

The other option is to increase the camera’s 
sensitivity setting in order to deliver a fast 
shutter speed in gloomy conditions. Low image 
noise at high ISO settings is therefore a big 
bonus in SLRs for sports shooting.

Regardless of lighting conditions, the lens 
can have a massive bearing on autofocus 
speed. Lenses with ring-type ultrasonic motors 
typically focus much faster, and can track 
rapidly moving objects more effectively You 
also get the bonus of full-time manual focus 
override, without having to switch between 
autofocus and manual focus on the lens or via 
the camera.

Quick-fire
Even if you’ve got the reflexes of a cat and the 
timing of a concert pianist, it can still be hard 
to nail the definitive moment. Moreover, that 
‘moment’ can unfold over a few seconds. Just 
picture the changing emotions on the face of 
Kelly Holmes winning at the 2004 Olympics, 
or the brief passage of time when thrills turn 
to spills during a motor race. To get the best 
possible shot, or even a sequence of great 
images, a fast continuous drive is essential.

The EOS 7D leads the way with its 8fps 
(frames per second )burst rate, although the 

“To get the best 
possible shot, or a 
sequence of great 
images, a fast 
continuous drive is 
essential”

Shop smart Image stabilisation
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Nikon D300S and Pentax K-5 
almost match it at 7fps. The 
Sony A580 has a 7fps Speed 
Priority mode, but autofocus and 
exposure metering are only in play 
prior to the first shot.

One factor to be aware of is 
that most SLRs in this class have 
a buffer memory that can hold 
around 15 Raw files. If you’re 
shooting in Raw format, that 
means you’ll fill the buffer in a 
couple of seconds. Worse still, 
you may then have to wait for up 
to a minute for the buffer to clear 
to the memory card. Waiting time 
can be dramatically reduced by 

using the fastest memory cards 
on the market, down to about 
5-10 seconds for cameras that 
use CompactFlash cards and 
around 10-15 seconds for 
Secure Digital.

Things are much less critical 
if you’re shooting in JPEG modes 
because fast cards enable you to 
shoot for extended periods or 
even until the card is full, without 
suffering a slowdown in the 
continuous shooting rate.

Hand grip
A comfortable hand grip is  
all but essential for sports 
shooting, especially when 
you're using the camera with  
a big, heavy telephoto lens for 
long periods of time. It also 
helps to reduce camera shake.

LCD screen
Tilting or fully articulated screens 
are good for when you’re stuck in 
a crowd and need to hold the 
camera above your head. 
However, live view autofocus is 
generally too slow to track 
moving objects.

Memory slots
The two Nikon cameras on test 
have dual card slots, so you 
can double up on memory 
cards. The Sony also has two 
slots for MemoryStick or SD/
HC/XC, but they can’t be used 
at the same time.

With APS-C sensors, the Nikon, Pentax 

and Sony cameras tested have a crop 

factor of 1.5x, and the Canon cameras 

1.6x. This is beneficial for sports shooting, 

extending the effective focal length of lenses. 

A modestly sized, fairly lightweight, reasonably 

priced 70-300mm zoom gives an equivalent telephoto 

reach of 450mm, or 480mm on a Canon SLR.

This approaches a heavyweight 150-500mm zoom on a 

full-frame camera, but in a lighter package for more 

comfortable shooting over long periods. Fit a full-frame 

150-500mm lens to an APS-C camera for a near-telescopic 

750mm or 800mm effective telephoto reach. 

Under the hood 
Crop factor

Autofocus modes
The test cameras all feature 
single and continuous 
autofocus. The latter tracks 
moving targets well, but may 
not keep up with high-speed 
objects moving directly away 
from or towards the camera.

Direct-access controls
You often need to react quickly to 
changing conditions and opportunities 
in sports photography, so direct-
access buttons to parameters such 
as drive mode, ISO, white balance and 
metering are a big bonus.

Shooting modes
Shutter priority shooting mode 
works well in many types of sports 
photography, but customisable, 
user-defined modes enable you to 
tailor the camera to meet your 
specific requirements.

Menu options
Advanced menu options and 
custom functions are extremely 
useful to have, so you can make 
the camera perform and respond in 
exactly the way you want, for any 
given shooting condition.

Top-plate LCD
A secondary LCD is a handy 
reference for checking important 
shooting settings and camera 
information. All cameras in this 
group feature a top-plate LCD, 
apart from the Sony A580.

EQUIPMENT kNOW-HOW 

 SLRS EXPLAINED 
The key features to look out for in a camera for sports photography 
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Two steps forward, one step back

CANON EOS 60D £800

J
ust behind the EOS 7D, the EOS 60D is 
Canon’s second most advanced APS-C 
camera in its range, and it bristles 
with features. Like the EOS 7D, you 

get the clever iFCL (intelligent Focus Colour 
Luminance) metering system, 18Mp image 
resolution and a standard sensitivity range of 
ISO100-6400 (ISO12800 in expanded mode). 
These are all marked improvements on the 
preceding EOS 50D.
 The EOS 60D beats even the EOS 7D in 
having a fully articulated LCD. In a crowd 
at a major sporting event, this can be very 

“Control layout is 
intuitive, and shooting 
parameters are easy to 
get at and quick 
to adjust”

Around the back… Canon EOS 60D
The control layout keeps things simple

useful for framing shots in live view mode, holding 
the camera high above your head. But live view 
autofocus performance is very much slower, so the 
benefit is greatly reduced if you need to track  
moving subjects.

Performance
With iFCL metering, light readings are biased to 
the active focus point. This can work well in sports 
photography, where backgrounds’ relative darkness 
or brightness are usually insignificant.
 Control layout is intuitive, and combined with the 
excellent Quick Control menu, shooting parameters 
are easy to get at and quick to adjust. But the 
changes aren’t all good news. Compared with the 
EOS 50D, the EOS 60D’s continuous drive rate 
drops from 6.3fps to 5.3fps, and with a plastic 
rather than magnesium alloy shell, it feels less 
robust. The older camera’s capacity to fine-tune 
AF for individual lenses has been stripped out 
too. These factors worsen the EOS 60D’s sports 
shooting performance.
 However, image noise is remarkably low even 
at high ISO settings, given the number of pixels 
crammed onto the APS-C sized sensor. Autofocus 
is fast and accurate, even in very dull lighting 
conditions, making the EOS 60D an extremely  
good low-light performer.

Mode dial
Unlike the EOS 7D, 
the EOS 60D includes 
a beginner-friendly 
sports scene mode

Articulated 
LCD
The high-res 
1,040k LCD is 
fully articulated, 
which comes in 
handy for 
shooting around 
corners

Concentric 
controllers
The multi-controller 
and quick control dial 
are combined into 
space-saving, 
concentric controls

AF-On
A dedicated button for 
autofocusing – but you 
only get nine AF points

1
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IMAgE quALITY

BuILD quALITY
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This row of buttons gives quick access to vital shooting 
settings for AF, Drive, ISO, Metering

There are plenty of scene modes for beginners, but only one 
user-defined custom mode

Gear
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Power with control from Canon’s big gun

CANON EOS 7D £1,100

N
ow three years old, the EOS 7D broke 
new ground with features such as an 
18Mp image sensor and Canon’s iFCL 
metering. Many of its star attractions 

have filtered down to subsequent mid-range 
cameras such as the EOS 550D, 600D and 60D, 
but it remains the real powerhouse of Canon’s 
APS-C range.
 High-speed performance is based on dual 
DIGIC 4 processors, and the advanced autofocus 
system has 19 AF points, all cross-type. The 
central AF point has increased sensitivity for 
lenses with a maximum aperture of f/2.8 or wider, 

“The EOS 7D’s autofocus 
speed is blisteringly fast 
and accurate with 
superior lenses”

Around the back… Canon EOS 7D
Buttons galore give easy access to everything

and AI Servo (continuous) autofocus works well with the 
multi-point AF modes. The central AF point locks onto 
the target, with the camera switching to other AF points 
if it strays around the frame. Everything’s wrapped in a 
tough magnesium alloy shell, with environmental seals 
for shooting outdoors, whatever the weather.

Performance
The EOS 7D packs a class-leading continuous drive 
rate of 8fps, but Raw shooting can fill the buffer 
after just two seconds. In our tests, the EOS 7D 
nevertheless cleared a full buffer in 5.5 seconds 
using fast CompactFlash cards such as the Lexar 
Professional 600x or Transcend 600x.
 Autofocus speed disappoints with Canon’s 
consumer-level telephoto zoom lenses, but is 
blisteringly fast and accurate with superior lenses 
such as the L-series EF 70-200mm, with its ring-type 
ultrasonic motor. Top-quality lenses bring the best out 
in this camera, though the modestly priced Tamron 
AF 70-300mm f/4-5.6 SP Di VC USD lens works well. 
Image quality is natural, and similar to results from 
the EOS 60D, but images can lack a little punch and 
vibrancy compared with Nikon SLRs. 

Q button
The LCD-based Quick 
Control menu provides 
access to a wide 
range of controls

Raw JPEG
This button  
allows a quick 
change to the 
image file format

Quick Control dial 
Applying exposure 
compensation is 
immediate with the 
Quick Control dial

AF points 
Select individual AF 
points with this button, 
used in conjunction 
with the multi-controller

2
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There are no scene modes on the mode dial, but you can 
set up to three user-defined modes

The customisable M-fn button enables single- and 
multi-point AF options
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Better, faster, and with more options

NIKON D7000 £860

H
eading Nikon’s range of consumer-
oriented SLRs, the D7000 even 
beats the ‘professional’ D300S in 
certain respects. The image sensor 

has a higher resolution of 16.2Mp than 
the D300S’s 12.3Mp, the EXPEED image-
processing engine is a generation newer, and 
the standard sensitivity range is ISO100-6400 
instead of ISO200-3200. You also get 1080p 
rather than 720p movie capture.
 Build quality feels solid, based on a 
magnesium alloy body shell, but the downsized 
design is a little cramped for large hands. 

“With the D7000,  
sunny images were 
often too bright and 
highlights clipped”

Around the back… Nikon D7000
There’s a lot squashed in here

Control layout is more conventional than on the 
D300S, with a traditional mode dial including two 
user-defined custom settings.

Performance
The D7000’s 39-point AF system and RGB metering 

sensor should make it strong for sports photography, 
but we often had slight over-exposure in very bright 
conditions. Nikon’s Active D-Lighting (AD-L) is usually 
great for tricky exposures, reigning in highlights and 
boosting shadow detail, but with the D7000, sunny 
images were often too bright and highlights clipped, 
both with AD-L on and off.
 The autofocus system has many D300S-like 
options, downscaled from 51 to 39 AF points. But 
the standard 18-105mm kit lens delivers adequate, 
not racy, AF speed. Nikon’s keenly priced AF-S VR 70-
300mm f/4.5-5.6G IF-ED lens radically improves  
AF speed, and a fast lens such as the AF-S 70-
200mm f/2.8G ED VR II transforms the camera, 
especially in low lighting where it can otherwise 
struggle to lock onto targets
 Another disappointment is that, in 14-bit lossless 
compressed Raw mode, there’s only enough buffer 
capacity for ten shots. However, this stretches 
to 15 shots if you switch to the 12-bit compressed 
Raw option.

Drive modes
The handy drive mode 
dial comes complete 
with a safety lock 
button

WB, ISO, Qual
Dedicated buttons  
for these three 
essential controls 
are close at hand

Thumb grip
The thumb grip area 
feels a little cramped 
and uncomfortable

AE-L/AF-L
Typical of advanced 
Nikon cameras, the 
exposure/focus  
lock button is  
fully customisable

3
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As well as PASM and scene, you can set up two user-
defined modes on the mode dial

The AF button, tucked under the lens barrel, offers quick 
access to autofocus modes and AF point selection

Gear



There’s life in the veteran Nikon yet

NIKON D300S £1,065

T
he D300S is three years old, like the 
Canon EOS 7D, but it’s a fairly minor 
update of the original D300, dating 
back two more years. Image resolution 

is the lowest in the group at just 12.3Mp, 
lower even than on Nikon’s entry-level D3100. 
Despite this, Nikon markets the D300S as 
a professional camera, and it has many 
advanced features.
 Rock-solid build quality is allied with 3D 
Color Matrix II metering and a 51-point 
AF system with dynamic- and auto-area 
options. You can set the ‘dynamic area’ to 

“The D300S gave us  
more confidence than  
any other camera to 
shoot in JPEG mode”

Around the back… Nikon D300S
Controls are unconventional, but fast in use

include groups of 9, 21 or 51 AF points, the last 
of which also has a 3D tracking option. This works 
especially well when the target is a different colour 
to its background.
 The continuous drive rate is a fast 7fps, which you 
can boost to 8fps by fitting an MB-D10 battery grip 

with an EN-EL4a battery or a set of AA batteries. But 
the maximum drive rate plummets to 2.5fps in Raw 
quality mode if you select 14-bit rather than 12-bit 
colour depth.

Performance
The autofocus accuracy and speed proved excellent 
in our tests. With the Nikon AF-S VR 70-300mm 
f/4.5-5.6G IF-ED, the D300S locked onto targets more 
consistently than the D7000 in very dull conditions.
Metering was extremely accurate in any lighting 
conditions, another area in which the D300S wins 
over the newer D7000. Active D-Lighting works 
brilliantly to control dynamic range, delivering punchy 
images in Standard picture mode and really vibrant 
images in the Vivid setting. The D300S gave us more 
confidence to shoot in JPEG mode than any other 
camera in the group, avoiding the extra hassle of Raw 
files and post-processing for large numbers of shots 
taken at sporting events. WB, ISO, Qual 

Three quick-access 
buttons sit in place 
of a conventional 
mode dial

Metering
This dedicated 
rotary control 
switches between 
matrix, centre- 
weighted and  
spot metering

Autofocus
This enables you to 
quickly switch 
between auto-area, 
dynamic-area and 
single-point AF

Multi-selector 
You can customise 
the centre button to 
give a magnified 
view in playback, 
ideal for checking if 
your action shots 
are sharp

4
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Selecting drive modes is quick and easy with this dedicated 
dial, and essential settings are accessed via buttons on top 

Program, Aperture, Shutter and Manual modes are 
accessed via the mode button and the main command dial
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Small, but perfectly formed

PENTAX K-5 £780

I
n size, weight and control layout, the 
Pentax K-5 is virtually identical to the 
older K-7. The newer model also inherits 
a magnesium alloy shell with plenty of 

weather seals. Shooting modes such as TAv 
(Time & Aperture value) are also retained, so 
you can set the aperture and shutter speed 
you want to use, and the camera sets the ISO 
accordingly. You can achieve the same trick on 
the Nikon cameras in our test by shooting in 
manual mode with Auto ISO enabled.
 Sports-friendly improvements in the K-5 
include a 16.3Mp sensor, increased sensitivity 

“Many of the k-5’s clever 
tricks are better suited to 
general photography than 
sports action”

Around the back… Pentax k-5
Plenty of controls are shoehorned into the small K-5

range of ISO100-12800 (ISO51200 expanded) and a 
7fps continuous drive rate compared with the K-7’s 
5.2fps. A fast new autofocus system can detect 
colour information, and widescreen video capture 
goes from 720p to 1080p.

Performance
The K-5 is the smallest camera in the group, and 
handling feels cramped for big-handed users. Plenty 
of direct-access controls are packed in, but some 
buttons are small, fiddly and hard to use with cold 
fingers when you’re shooting outdoor sporting events 
in inclement weather.
 Many of the K-5’s clever tricks are better suited 
to general photography than sports and action. 
They include a sensor-shift stabilisation system that 
doubles as a self-levelling facility, auto HDR capture 
modes, in-camera cross-processing and effects 
filters. The stabiliser isn’t as effective as in-lens 
Canon and Nikon alternatives for long telephoto 
shooting, and while AF accuracy is good, the K-5 can’t 
track moving action as well as the Canon and Nikon 
cameras tested, even when fitted with a fast-focusing 
lens such as the smc PENTAX DA Star 50-135mm 
f/2.8 ED (IF) SDM.

Metering options 
Spot, centre-
weighted and matrix 
options are available 
from just beneath the 
mode dial

LCD
The k-5’s 
compact build 
means its 
three-inch 921k 
LCD takes up a 
large part of the 
rear panel

Four-way pad
Instead of a 
conventional four-way 
pad, switches double  
up as shooting 
parameter controls

AF button
The centre button 
activates the AF 
system, and an outer 
ring switches between 
single-point and 
multi-point AF

5
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The shooting modes found on the mode dial include 
Pentax’s Time & Aperture value and Sensitivity value

Compensation buttons for both ISO and exposure can be 
found sitting behind the shutter release

Gear
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Cheap at half the price

SONY A580 £530

S
elling for just £500, the Sony A580 
costs less than half the price of the EOS 
7D or Nikon D300S, and is significantly 
cheaper than all the other cameras 

in the group. Even so, compared with the older 
A550, image resolution is increased from 14.2Mp 
to 16.2Mp and the buffer size goes up from 14 to 
22 Raw files. There’s also 1080i movie capture, 
whereas the A550 had no video facility at all.
 In other areas, shortcomings of the A550 
carry through to the A580. The viewfinder is a 
pentamirror unit while all the other cameras on 
test have pentaprism finders. It’s the only camera 

“The A580 made a 
relatively hopeless job of 
locking onto race cars 
and tracking them”

Around the back… Sony A580
The Sony covers most of the essentials

without a secondary LCD on the top plate, and getting 
at important shooting parameters can be a long-winded, 
menu-based affair. But live view comes with the choice 
of contrast AF or faster phase-shift AF, and the tilting 
LCD works well for live view shooting at extreme angles.

Performance
Using a Sony 70-200mm f/2.8 G lens at the longest 
telephoto length, the sensor-shift stabiliser only gave 
us a disappointing two-stop benefit. And despite the 
fast-focusing abilities of the lens, the A580 made a 
relatively hopeless job of locking onto race cars and 
tracking them during panning in our motorsports 
tests. In conditions where the Canon and Nikon 
cameras nailed the action every time, the Sony often 
failed to focus, missing shots.
 There’s a 15-point AF system in live view mode, 
but only 11 points are available when using the 
viewfinder. We struggled to get good results using 
the 7fps Speed Priority mode because autofocus 
and exposure settings are locked prior to capturing 
the first shot in a sequence. The regular high-speed 
continuous drive mode fixes this, but the shooting 
rate drops to just 5fps. 

Viewfinder
The pentamirror 
viewfinder lacks  
the quality of 
competing SLRs’ 
pentaprism units

LCD
The tilting LCD is 
good for shooting 
from high or low 
angles in live 
view mode

Fn button
The Function menu 
via the LCD is used 
to access many  
vital parameters

Movie button
Movie capture is  
a new addition on 
the A580, with a 
maximum resolution 
of 1080i

6
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There’s no top-plate LCD for at-a-glance info on your 
settings, as featured on all the other cameras tested

There are plenty of scene modes for beginners, but no 
user-defined custom mode options for more advances users

Sports & Action Photography Made Easy  203



GearGear

204  Sports & Action Photography Made Easy

NIKON D300S

The D300S delivers vibrant shots  
with pleasant contrast. Autofocus 

speed and consistency  
are also rock solid.

With a result of 2,400 LW/PH, the 
D300S shows the restrictions of its 

12Mp sensor when compared with the 
other cameras in the test.

The D300S delivers detailed yet fairly 
smooth images up to ISO3200, but 

noise is quite noticeable at the 
expanded ISO6400 setting.

Image colour is pleasing and 
well-saturated in JPEg images direct 
from the camera, while raw images 

show a more natural tone.

IMAGE QUALITY IN FOCUS

IMAGE TEST VERDICT
Images can show unwanted 
colour influences, but generally 
overall saturation is good. The 
D300S has the lowest overall 
results for dynamic range.

24ISO200

CANON EOS 7D

The EOS 7D is incredibly responsive, 
tracking fast-moving targets with ease 
and delivering great results practically 

every time. A great performance.

The EOS 7D’s 18Mp resolution doesn’t 
give it a huge advantage over the 
Nikon D7000, managing a score 

of 2,600 LW/PH.

There’s practically nothing to choose 
between the EOS 7D and EOS 60D for 

high-ISO noise. Both cameras are 
equally impressive.

Colour detail and tone is reproduced 
well. However, for a more pleasing 

result both JPEg and raw files benefit 
form a slight boost in saturation.

IMAGE TEST VERDICT
While noise is apparent at 
the top end of the sensitivity 
range, the EOS 7D performs 
well, producing good tone 
and detail.

26ISO200
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Despite its 5.3fps drive rate and 
nine-point AF system, the EOS 60D 
keeps pace with the action, and it 
takes very natural-looking images.

With a resolution score of 2,600 LW/
PH the EOS 60D rates alongside the 
EOS 7D for resolution, but the clarity 

of JPEg detail is better.

Considering the high 18Mp 
resolution, the EOS 60D delivers 
surprisingly low-noise images at  
ISO settings right up to 3200.

raw and JPEg images lack saturation 
when compared with all but the 

Pentax K-5. They show rich detail and 
tone, however.

IMAGE TEST VERDICT
At sensitivity values above 
ISO3200, noise becomes an 
issue, but across the rest of  
the sensitivity range, tone and 
detail is reproduced well.

26ISO200

ISO3200 

ISO200 

NIKON D7000

Autofocus speed is transformed by  
a fast lens such as the Nikon 

70-200mm f/2.8, but the D7000 has a 
tendency towards over-exposure.

Scoring an impressive 2,600 
LW/PH, the D7000 is hot on the 
heels of the higher pixel-count 

SLrs in the test.

The D7000’s images are remarkably 
clean. Noise only becomes a real 
problem at the highest expanded 
sensitivity setting of ISO25600.

JPEg and raw images suffer from 
slight over-saturation, but this makes 
the images pleasantly vibrant. Colour 
detail and tone are reproduced well.

IMAGE TEST VERDICT
Detail in the highlights is easily 
lost due to a tendency to 
slightly over-expose. However, 
properly exposed shots show 
good colour and detail.

26ISO200

ISO200 

ISO3200 ISO3200 
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PENTAX K-5 SONY A580

Many of our shots from the K-5 are  
a little on the dark side. What’s more, 

stabilisation is disappointing and 
autofocus tends to be hit and miss.

Even with Sony’s fast-focusing 
70-200mm f/2.8 lens, the A580 

frequently fails to lock onto targets 
quickly enough or to track them.

Clocking in a score of 2,600 LW/PH, 
the K-5 produces a very respectable 
result for this test, in line with the 

Nikon D7000 and Sony A580.

The A580’s score of 2,600 LW/PH is 
on par with the Pentax K-5 and Nikon 
D7000 – a decent result that shows it 

captures detail well.

High-ISO noise is much less noticeable 
in images from the K-5 than the older 

K-7. The new camera is a big 
improvement in this respect.

raw and JPEg colour is the least 
saturated in the test, making images 

look washed out and in need of a 
colour boost.

The A580 produces images with 
slightly high saturation compared with 

the other cameras on test, but the 
results are very pleasant.

IMAGE TEST VERDICT
Both dynamic range and noise 
results put the Pentax K-5  
in the middle of the table, 
producing good, but not 
exceptional, results.

IMAGE TEST VERDICT
Colour and resolution are 
resolved well, and the Sony 
A580 is second only to the 
Nikon D7000 when it comes 
to low noise.

SLR benchmarks
See how each camera fared in our lab tests

Canon EOS 60D Canon EOS 7D

Pentax K-5 Sony A580

Nikon D7000

Nikon D300S
KEY

Under lab conditions, we shoot 
three charts with each camera to 
assess sensor performance with 
visual and computer analysis. 
Dynamic range and noise are 
measured with the DxO 
transmission chart. Images of this 

chart are processed in DxO 
Analyser. Colour error is 
measured using the X-Rite 
ColorChecker chart. We also 
shoot a resolution chart, 
indicating the detail each camera 
is able to record in LW/PH.

12

COLOUR ERROR Closest to zero is best

COLOUR ERROR RESULT:  The Canon EOS 7D and EOS 60D are the 
frontrunners here. The Nikon D300S and Pentax K-5 come bottom of the pile
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Sony has made great strides in 
controlling high-ISO noise in the A580. 

It's much more usable in  
low light than older Sony models.
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NOISE RESULT:  The Nikon D7000 leads the field at all but the highest 
and lowest settings. The Sony A580 also turns in a strong performance
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T
he EOS 7D is the powerhouse of 
Canon’s current range of APS-C 
cameras, and boasts dual DIGIC 
4 processors, advanced 19-point 

autofocus (all cross-type) and a faster 
continuous drive rate (8fps) than any other 
camera in our test. It also shares a class-
leading 18Mp image resolution with its 
cheaper cousin, the Canon EOS 60D. But 
for sports shooting, the EOS 60D reveals 
itself as a bit of a poor relation, and actually 
has a slower continuous drive rate than the 
preceding EOS 50D, as well as lacking some 
of the earlier camera’s advanced features, 
such as AF fine-tuning for individual lenses. 
The provision of only nine AF points is also 

a little disappointing when it comes to 
accurate focusing of fast-moving subjects.

Of the two Nikon cameras we looked 
at, the D7000 boasts a higher image 
resolution than the D300S, but the latter 
has superior build quality and handling, 
despite its unorthodox control layout. In our 
tests, the D300S also had better autofocus 
performance and metering consistency, 

along with its faster 7fps continuous drive 
rate. While the Canon EOS 7D maintains  
a clear lead, the Nikon D300S keeps hold of 
our runners-up spot for action sports SLRs.

The Pentax K-5 packs a wealth of 
advanced features and functions into its 
remarkably small yet well-built frame. The 
Sony A580 is rather less sophisticated, but 
it's much cheaper than the other cameras 
in the group. For nailing sports action, 
however, the K-5 and A580 are both poor 
relations to the Canon and Nikon cameras. 
Continuous autofocus is sluggish, especially 
on the Sony camera, and we found the 
sensor-shift image stabilisation systems 
less effective for long telephoto shooting. 

THE CANON EOS 7D DELIVERS 
A GOLD-MEDAL PERFORMANCE 
The mighty Canon EOS 7D powers across the finishing line 
in first place, leaving most of the competition eating its dust

How tHe 
cameras 
compare

Canon EOS 60D Canon EOS 7D Nikon D7000 Nikon D300S Pentax K-5 Sony A580

Contact www.canon.co.uk www.canon.co.uk www.europe-nikon.com www.europe-nikon.com www.pentax.co.uk www.sony.co.uk

Street price (body only) £800 £1,100 £860 £1,065 £780 £530

Sensor 18Mp CMOS 18Mp CMOS 16.2Mp CMOS 12.3Mp Live MOS  16.3Mp CMOS  12.2Mp CMOS

Focal length conversion 1.6x 1.6x 1.5x 1.5x 1.5x 1.5x

Memory 1x SD/HC/XC 1x CompactFlash 2x SD/HC/XC 1x CF, 1x SD/HC/XC 1x SD/HC/XC 1x MS, 1x SD/HC/XC 

Viewfinder 96% coverage 100% coverage 100% coverage 100% coverage 100% coverage 95% coverage

Image stabilisation Via lens Via lens Via lens Via lens Built-in sensor-shift Built-in sensor-shift

Video – max resolution 1080p, 24/25/30fps 1080p, 30/25/24fps 1080p, 24fps 720p, 24fps 1080p, 25fps 1080i, 50fps

ISO range (expanded) 100-6400 (12800) 100-6400 (12800) 100-6400 (25600) 200-3200 (6400) 100-12800 (51200) 100-12800

Autofocus points 9-point (all cross-type) 19-point (all cross-type) 39-point (9 cross-type) 51-point (15 cross-type) 11-point (9 cross-type) 15-point (3 cross-type) 

Shutter speeds 30-1/8000 sec, Bulb 30-1/8000 sec, Bulb 30-1/8000 sec, Bulb 30-1/8000 sec, Bulb 30-1/8000 sec, Bulb 30-1/4000 sec, Bulb

Max burst rate 5.3 frames per second 8 frames per second 6 frames per second 7 frames per second 7 frames per second 5/7 frames per second 

Buffer capacity (RAW) 16 shots 15 shots 10 shots 17 shots 20 shots 22 shots

LCD screen 3-inch, 1,040k, articulated 3-inch, 920k, fixed 3-inch, 920k, fixed 3-inch, 920k, fixed 3-inch, 921k, fixed 3-inch, 921k, tilting

Body (WxHxD), weight 145x106x79mm, 755g 148x111x74mm, 820g 132x105x77mm, 780g 147x114x74mm, 840g 131x97x73mm, 666g 137x104x84mm, 599g

Battery life (CIPA) 1,100 shots 800 shots 1,050 shots 950 shots 740 shots 1,050 shots

FEATURES      
HANDLING      
IMAGE QUALITY      
VALUE      
OVERALL      

“The EOS 7D has a clear 
lead, with the D300S 
keeping hold of our 
runners-up spot”
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SLr TEST 
rESuLTS
Your in-a-nutshell guide 
to the best SLRs for 
capturing sports 
performance2ND NIKON D300S

What’s good: Highly effective metering and 
autofocus, even in difficult conditions.

What’s bad: 12.3Mp image resolution is the 
lowest in the group.

Our verdict: Pro-quality feel and handling,  
and delivers punchy image quality.

6TH SONY A580
What’s good: Respectable image quality and 
some good features at a keen price.

What’s bad: Slow autofocus, pentamirror 
viewfinder, and no top-plate LCD.

Our verdict: Relatively cheap, but it can’t take the 
pace of high-speed sports.

5TH PENTAX K-5
What’s good: Fast 7fps continuous drive and a 
host of advanced features.

What’s bad: Stabilisation and autofocus tracking 
are disappointing with a telephoto lens.

Our verdict: Good all-round performance, but it’s 
not the best sports option at the price.

3RD NIKON D7000
What’s good: Advanced 39-point AF system and a 
higher resolution than the D300S.

What’s bad: Handling feels cramped, and it 
sometimes over-exposes sunny shots.

Our verdict: The D7000 ticks most boxes, but it’s 
overshadowed by the D300S.

1ST CANON EOS 7D
Many power features introduced in this camera, 
such as 18Mp resolution and iFCL metering, have 
now filtered down to cheaper SLRs in Canon’s 
current range. Even so, with its shooting speed 
and autofocus quality, the EOS 7D remains the 
most powerful APS-C camera for sports 
photography.

What’s good: Fast autofocus, continuous drive 
rate and image processing.

What’s bad: Mid-range Canon lenses don’t get 
the best out of the camera.

Our verdict: Spectacular performance when used 
with top-quality lenses.

4TH CANON EOS 60D
What’s good: 18Mp resolution, intuitive controls 
and a fully articulated LCD.

What’s bad: Average continuous drive rate; lacks 
some of its predecessor’s features.

Our verdict: An excellent SLR for general 
photography, but not ideally suited to sports.
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3 Velbon GEO E54
Price: £80  Web: www.velbon.co.uk

The 458g carbon fibre Velbon is just over half 
the weight of the aluminium Manfrotto, but it 
feels very solid. Its four-section leg extends from 
53cm to an impressive 1.67m, and spiral etched 
surfaces enable silky-smooth extension and 
contraction. The build quality of the clip locks 
feels a bit low, but overall, it’s a good weight-
saving buy at the price. 

5 Manfrotto 681B
Price: £55  Web: www.manfrotto.co.uk

Despite having only three leg sections, the 
aluminium Manfrotto extends from 65cm to 
1.61m. With just two clip locks, it’s also quick 
and easy to set up. It’s a bit on the heavy 
side at 800g, but it feels absolutely rock-
solid in use. The only niggle is that the leg 
sections are a bit rattly when the clip locks 
are released. 

4  Benro A38F
Price: £50  Web: www.kenro.co.uk

This four-section aluminium monopod weighs 
in at 580g, stretches from 48.4cm to 1.5m, 
and it supports loads of up to 18kg. It’s 
sturdy and well-built, with smoothly extending 
leg sections, and grub screws in the platform 
to help fix an optional head securely, but tall 
photographers may find the maximum height 
a little short. 

6  Benro C38T
Price: £99  Web: www.kenro.co.uk

At 610g, Benro’s new four-section carbon 
fibre monopod is surprisingly a little 
heavier than the aluminium A38F, but 
it extends to a greater height of 1.64m 
(53.5cm folded). Bucking the current trend, 
it features twist locks rather than clip 
locks. Without any weight-saving, it’s hard 
to justify the extra expense. 

2 Hama Alpenpod
Price: £9  Web: www.hama.co.uk

The Alpenpod doubles up as a spring-loaded, 
anti-shock hiking pole, and even comes with 
a compass and snow foot. Disappointingly 
though, it only extends from 67cm to a lowly 
1.41m, and the flip-over plastic camera support 
feels cheap and flimsy. It’s lightweight at 360g, 
but it feels more of a novelty item than a 
serious SLR support. 

1 Giottos MML3290B
Price: £39  Web: giottos-tripods.co.uk

Ideal for tall people, the aluminium Giottos 
tripod extends from 51cm to a freakish 
1.88m, and it weighs a hefty 660g. The extra 
height is enabled by five leg sections, and 
therefore the Giottos requires four clip locks. 
The downside is that it feels more prone to 
flexing than most of the other monopods 
in the group. 

MIGhTy MonopoDS
perfect for shooting sports with heavy telephoto lenses, monopods add stability, 
but don’t add to your load. Six of the best get put through their paces…
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Buy from your newsagent, or order online
www.myfavouritemagazines.co.uk/photo

Get the BiGGest and Best 
photoGraphy Buyers’ Guide!

Packed with buying advice and in-depth reviews of the latest  
SLRs and CSCs, plus essential accessories and lenses

also available on your tablet or phone!
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Sporty 
tele-zooms

See which lens is available for your camera with this 
handy key. C is a Canon mount, N is Nikon, 4/3 is Four 
Thirds, P is Pentax, S is Sony and Sg is Sigma

mount Key

Get closer to your subject without breaking the bank. 
Eight mid-range zoom lenses tried and tested

Gear Gear
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the contenderS
1 Canon EF 75-300mm f/4-5.6 III USM, £240 

2 Canon EF 70-300mm f/4-5.6 IS USM, £400 

3 Nikon AF-S DX 55-300mm f/4.5-5.6G ED VR, £290 

4 Nikon AF-S 70-300mm f/4.5-5.6G ED VR, £420

5 Sigma 70-300mm f/4-5.6 APO DG Macro, £180 

6 Sigma 70-300mm f/4-5.6 DG OS, £300 

7 Sony 75-300mm f/4.5-5.6, £195 

8 Tamron SP AF 70-300mm f/4-5.6 Di VC USD, £340

Ph
o
to

gr
ap

h
y:

 J
e
ss

e
 W

ild



Xxxxxxxxxx

1

2

7

5

64

Gear

Sports & Action Photography Made Easy  211



XxxxxxxxxxGear

212  Sports & Action Photography Made Easy

Gear

Kit anatomy Autofocus options
telephoto zooms are popular for shooting sporting 

action and wildlife, so the faster and quieter the 

autofocus, the better. Both Sigma lenses and the 

Sony lens in the group have autofocus systems 

based on conventional electric motors. they’re 

not especially quick and are clearly audible.  

 the next step up is a small ultrasonic motor, as 

fitted to both canon lenses and the nikon 

55-300mm. It’s a fair bit quieter, but still drives 

the autofocus mechanism through gearwheels, 

so there’s very little advantage in terms of speed. 

For top performance, the nikon and tamron 

70-300mm lenses use ‘ring-type’ ultrasonic focus. 

Based on two large rings that take up most of the 

diameter of the lens barrel, this system is 

near-silent and considerably faster in operation. It 

also offers full-time manual focus override in 

‘single’ or ‘one-shot’ autofocus mode. 

70-300mm lens is likely to be bigger than an 
APS-C format telephoto zoom, but there are 
some distinct advantages. Firstly, you’ll get 
more telephoto reach, equivalent to 450mm 
(480mm for Canon APS-C bodies), giving you 
greater telescopic power in a package that’s 
still fairly compact and lightweight. Secondly, 
because the image circle produced by the 
lens is cropped by APS-C cameras, you’ll only 
be using the central region, where image quality is at its best. You can expect greater 

sharpness into the corners of the frame, and 
better peripheral illumination, so vignetting 
(darkened image corners) is less of an issue. 
And if you ever decide to switch to a full-
frame SLR, you can carry on using the same 
telephoto lens.

mind the gap 
One thing that puts some people off going for 
a 70-300mm lens is the gap in focal length 
between a 18-55mm and larger lens. In 
practice however, this isn’t a major problem. 
Moving a few paces when composing, or 
a little creative cropping when using your 
standard zoom lens at its longest focal length, 
is all that’s needed to offset the missing 55-
70mm of zoom range. Even so, out of all the 
lenses in this group, Nikon bucks the trend. 
The Nikon 55-300mm gives the conventional 
long-end reach of a full-frame lens, but it’s 
the only one on test that’s actually designed 
for APS-C format cameras. As such, it picks 
up at the same focal length that a standard 

We use a two-stage testing procedure for 

all the lenses present in this group, which 

includes lab tests carried out under 

controlled conditions, in addition to  

‘real-world’ shooting.  

 Firstly, all lenses are fitted to mid-range 

cameras and used to take images of two test 

charts under studio lights. the results are 

processed using Imatest master, so that we 

can quantify optical performance in terms of 

sharpness, chromatic aberrations and 

distortion. overall quality is assessed at the 

centre, edge and corners of the images.  

 For real-world conditions, we use each of 

the lenses under varying indoor and outdoor 

lighting. overall handling is checked, as well 

as the smoothness and precision of zoom and 

focus rings, and switch operation.  

 We also test the speed and accuracy of 

autofocus systems, complete with operation 

of full-time manual override where  

available. For lenses that feature optical 

stabilisation, we check how many f-stops of 

benefit are delivered at which we can still get 

consistently sharp handheld shots. 

 once all these tests are complete, ratings 

are finally given for features, build quality, 

image quality and value for money, all of 

which are important factors to consider 

before making a purchase.

“you’ll get more telephoto 
reach, giving you greater 
telescopic power in a 
package that’s still fairly 
compact and lightweight”

B
uy any SLR that comes complete 
with a standard zoom lens 
and, chances are, your next 
purchase will be a telephoto 

zoom. A typical 18-55mm ‘kit’ lens offers 
a fairly generous wide-angle perspective 
on life, equivalent to about 28mm, but 
runs out of reach at the long end of the 
zoom range. That’s okay for portraiture, 
but when you want to close in on distant 
subjects, only a telephoto zoom will do.

Most of us use APS-C format camera 
bodies, so there’s something to be said 
for buying a telephoto zoom specifically 
designed for an APS-C format camera; 
the focal length is generally around 55-
200mm, so once you consider the crop 
factor or focal length multiplier, they’re 
equivalent to about 80-300mm. This 
effective zoom range is pretty much the 
same as conventional 70-300mm budget 
telephoto lenses, originally designed for 
full-frame cameras. 

But what if you upsize to a full-frame 
lens? The physical size of a full-frame 

how we test lenses Advice you can trust

Fast-moving targets moving towards you or away from you really put autofocus speed to the test. 
ring-type ultrasonic systems are generally best at keeping up with the action
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 FeatureS to looK For
Things to bear in mind when buying a telephoto zoom 

zoom runs out, while still offering the same 
maximum telephoto reach of other lenses in 
the group. But what price image quality? (find 
out on page 215).

The lenses in this group fall short of the 
fully professional qualities you’d expect from 
constant aperture 70-200mm f/2.8 lenses, 
which can cost around £1,500 or more. But 
they fall into one of two main categories, 
either being built to a rock-bottom budget 
or aiming a few rungs further up the quality 
ladder. Some of the older and cheaper 
lenses in the group were originally designed 
for 35mm film cameras. While they can still 
produce good results with D-SLRs, they tend 
to be lacking in features, and optical quality 
isn’t likely to be as good. 

For £300 or more, you can expect better 
optical quality and state-of-the-art technology 
which, in most cases, will include optical 
image stabilisation. It’s a great feature for 
shooting handheld, especially with zoom 
lenses, as camera-shake is more of a problem 
at long focal lengths.  

Stabiliser shakedown 
The rule of thumb is that, for consistently 
sharp handheld shots, you need a shutter 
speed that’s at least as fast as the reciprocal 
of the effective focal length. So, if the 
effective focal length of your telephoto zoom 
stretches to 480mm, you’d need a fast 
shutter speed of 1/500 sec. The largest 
available aperture at the longest zoom setting 
of a budget telephoto lens is normally f/5.6, 
so you may struggle to get sufficiently fast 
shutter speeds in anything other than bright, 
sunny conditions. Sure, you can increase 
your camera’s ISO setting to enable faster 
shutter speeds, but that’s likely to impact on 
image quality.  

The lenses that feature image stabilisation 
are signified as Canon IS (Image Stabilization), 
Nikon VR (Vibration Reduction), Sigma 
OS (Optical Stabilization) and Tamron VC 
(Vibration Compensation). Most boast a 
four-stop advantage, meaning that you can 
expect sharp handheld results when shooting 
at just 1/30 sec (at a focal length of 480mm) 
instead of 1/500 sec. With a three-stop 
stabiliser, you’d need to increase the shutter 
speed to 1/60 sec.

 Tamron doesn’t fit its VC system to the 
Sony version of its 70-300mm lens because 
Sony bodies have sensor-shift stabilisation 
built in. Sigma takes a different view, fitting 
optical stabilisers to both the Pentax and 
Sony versions of its 70-300mm OS lens, so 
you get the option of using either sensor-shift 
or optical stabilisation on these cameras. 
We’ve found that optical stabilisation generally 
produces more consistent results, so it’s 
worth having.

lens hood 
These are good for reducing 
ghosting and flare with a 
telephoto lens. They’re 
supplied with all the lenses on 
test here apart from the Canon 
models, where you have to buy 
them separately. 

the specified ‘minimum’ length of all the 

lenses in the group ranges from 122mm to 

144mm, which is reasonably compact.  

 however, the overall length of the lens often 

nearly doubles when you zoom to the maximum 

telephoto focal length and fit the lens hood, 

making them more of a handful. those lenses 

that lack internal focusing can further increase 

in length at short focus settings, especially if 

they have a close-focusing macro facility.  

 For example, the Sigma 70-300mm apo 

macro extends from 119mm to as much as 

249mm with the hood fitted, which is more  

than double.  

Watch out for...  Zoom expansion 

Stabiliser modes 
You’ll find that lenses which 
feature optical stabilisers often 
have multiple modes for 
normal or high-strength 
operation. Panning modes  
may be either manually 
switched or auto-sensing. 

mounting plate 
A metal mounting plate tends 
to be more robust, rugged and 
longer-lasting than the plastic 
variety. Unlike some APS-C 
format telephoto zooms, all  
the lenses in this group  
feature metal mounts. 

Internal focusing 
With internal focusing, the  
front element won’t extend 
throughout the focus range.  
It generally won’t rotate either, 
which makes filters like circular 
polarisers much easier to use. 

distance scale 
Some lenses don’t feature a 
focus distance scale. This is  
less of an issue than with a 
wide-angle lens, but can still be 
useful. It’s handy when setting 
flashgun power manually. 

Zoom/focus rings 
A large, comfortable zoom ring 
makes for easy operation. 
Despite the high dependence 
on autofocus, a smooth and 
precise manual focus ring can 
also come in handy. 
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CANON EF 75-300mm 
f/4-5.6 III USM  
£240

Is Canon’s big gun a better choice? A lightweight in many ways 

CANON EF 70-300mm 
f/4-5.6 IS USM 
£400

c
onsiderably larger and heavier than the 
Canon 75-300mm, this design was 
launched back in 2005. It’s not exactly 
state-of-the-art, and features a dated IS 

(Image Stabilization) system which only offers a 
three-stop benefit, unlike the four-stop systems 
fitted to many current lenses from Canon and other 
manufacturers. There’s also no automatic panning 
detection, so you have to manually switch between 
two modes for static or panning shots.  
 In most respects, build quality feels better 
than in Canon’s cheaper 75-300mm lens, and 
in addition the 70-300mm has a UD (Ultra-low 
Dispersion) element intended to boost contrast 
and resolution while reducing colour fringing. 
However, the USM autofocus is still only of the 
basic motor-based type, and the front element 
rotates during focusing. Unlike the cheaper lens, 
this one also suffers from appalling zoom creep.

performance
Sharpness is good throughout the entire zoom 
range, and is better at the 300mm focal length 
than with on competing lenses. Despite the UD 
element, however, colour fringing is still quite 
noticeable at long zoom settings. Autofocus speed 
is sluggish, especially at the 300mm end of the 
zoom range, with similar performance to Canon’s 
cheaper 75-300mm. We’d have expected ring-type 
USM to be fitted to this lens, considering its price. 
There’s no doubt it’s a better lens than the Canon 
75-300mm, but there’s still plenty of room for 
improvement. 

c
anon markets this lens as an ‘affordable 
telephoto zoom with a lightweight design’. 
Sure enough, it’s rather more compact, 
and 150g lighter, than the Canon 70-

300mm opposite, but it’s also quite lightweight in 
features. The USM autofocus is of the cheaper, 
motor-based variety that lacks full-time manual 
focus override. The front element also rotates 
during focusing, which makes the use of filters 
like circular polarisers a pain. There’s no image 
stabilisation and build quality feels a bit cheap.  

As with many Canon lenses, no lens hood 
is supplied and the official ET-60 hood costs 
about £20 extra to buy. Another omission is that 
there’s no focus distance scale. The original 
version of this lens was launched 20 years 
ago and even the current Mk III edition has 
been around for 12 years, having done little to 
transform itself for the digital age. 

performance
Despite its USM credentials, autofocus is 
ponderous and really struggles in dull lighting 
conditions. Sharpness is a pretty close match 
to Canon’s more expensive 70-300mm IS lens 
(opposite) in the 70-200mm region of the zoom 
range, but drops off more at longer focal lengths. 

Distortions are well controlled throughout the 
zoom range. Colour fringing is a real problem and 
very noticeable across much of the image frame 
when shooting at long focal lengths. As a no-frills 
option, the lens is fairly cheap, but not particularly 
good value.

OVERAll

FEATURES

BUIlD QUAlITY
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Tech focus…
the image stabiliser’s 
panning mode is 
designed for horizontal 
panning, during which 
stabilisation is only 
applied in the vertical 
plane. It’s best to 
switch the stabiliser off 
when the camera is 
being used on a tripod. 

21
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Tech focus…
canon boasts that 
the ultrasonic motor 
drives autofocus 
‘extremely quickly’ 
but we’ve enjoyed 
speedier focusing 
with some of 
canon’s lenses that 
feature a standard 
electric motor.
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In a minority of one for APS-C

NIkON AF-S DX  
55-300mm f/4.5-5.6G 
ED VR £290 

Powerful and quick on the draw 

NIkON AF-S  
70-300mm f/4.5-5.6G 
ED VR £420

t
his is the only lens in the group that’s 
specifically designed for APS-C format 
cameras, so it’s not compatible with full-
frame bodies. We’ve included it anyway 

because, unlike most APS-C format telephoto 
zooms that have a 55-200mm or 55-250mm zoom 
range, this one stretches all the way to 300mm.  
There’s some smart sophistication in places, like 
Nikon’s latest-generation Vibration Correction, 
which gives a four-stop advantage in avoiding 
camera shake. In other areas, it’s less refined 
and closer to the Canon lenses. For example, the 
front element rotates during focusing, and the 
AF-S autofocus is a motor-based ultrasonic system 
instead of the more advanced ring-type version 
fitted to the Nikon 70-300mm VR opposite. This 
lens lacks a focus distance scale, but at least a 
hood is included. 

performance
Autofocus is a little quicker than in the Canon 
lenses here, but still lacks the full-time manual 
override facility of ring-type ultrasonic systems. 
Handling feels assured and, despite it being an 
APS-C format lens, it’s still bigger and heavier 
than the Canon 75-300mm full-frame lens.  
Sharpness is very good throughout the zoom 
range and colour fringing is well controlled. Our 
only slight criticism is that the extra zoom range 
seems to push distortions up a bit. They’re most 
noticeable as barrel distortion at 55mm, changing 
to pincushion distortion in the central region of 
the zoom range. 

a
major step up from most lenses in the 
group, the Nikon 70-300mm VR has a 
much more professional feel to it. Build 
quality feels excellent and high-tech 

finery starts with ring-type ultrasonic autofocus 
(only matched by the Tamron on test). This 
has the potential to deliver very fast autofocus 
performance, complete with full-time manual 
override. You also get a focus distance scale, 
which is neatly mounted beneath a viewing window. 
Focusing is fully internal, so the front element 
neither moves nor rotates during focusing.  
Further benefits over the Nikon 55-300mm VR 
include a more sophisticated VR system. Both 
are rated at four stops, but this lens features 
dual-mode stabilisation, which adds an ‘Active’ 
setting (see right). One thing that’s shared by 
both is a rubber O-ring on the mounting plate. 
This gives weather-sealed protection against dust 
and moisture, similar to the system used in most 
Canon L-series lenses. 

performance
 Autofocus is super-fast and practically silent, 
and the manual override saves messing around 
with switches if you want to nudge the focus 
setting. Distortions are quite minimal and colour 
fringing is low. 

Our lab tests indicate that sharpness could be 
better at the long end of the zoom range, but, in 
real-world shooting, we got pin-sharp shots time 
after time, with excellent contrast and superb all-
round image quality. 

OVERAll
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IMAGE QUAlITY

VAlUE
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IMAGE QUAlITY

VAlUE

Tech focus…
the ‘active’ Vr mode 
is intended for when 
you’re shooting from 
a vibrating platform. 
this could be 
anything from an 
idling car to a light 
aircraft or helicopter. 

Tech focus…
the 55-300mm 
includes two ed 
(extra-low dispersion) 
elements plus an hrI 
(high refractive 
Index) element. 
Further attractions 
include a weather-
sealed lens mount to 
guard against dust 
and moisture.
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Stabilisation replaces macro facilitiesThis Sigma takes you near and far 

SIGMA 70-300mm  
f/4-5.6 DG OS 
£300 

SIGMA 70-300mm f/4-
5.6 APO DG MACRO 
£180 

c
ompared with Sigma’s 70-300mm APO 
lens, this newer model ditches the macro 
facility but adds a four-stop optical 
stabiliser. That’s great news for Canon 

and Nikon users and good news for Pentax and 
Sony photographers as well. We find that optical 
stabilisation gives better and more consistent 
results than sensor-shift stabilisation, especially 
when shooting at long telephoto focal lengths.  

In common with the APO lens, the OS model 
only has a basic electric autofocus motor, instead 
of Sigma’s HSM (HyperSonic Motor) system. 
Sigma has missed a trick here, as its motor-based 
HSM usually works well and its ring-type HSM is 
excellent. The front element both moves out and 
rotates during focusing. A focus distance scale is 
printed on the lens barrel and comes complete 
with a depth of field indicator marked with f/11 and 
f/22 calibrations. 

performance
Whereas the Sigma APO lens has three SLD 
(Special Low Dispersion) elements, the OS lens 
has only one. We’d therefore expect chromatic 
aberrations to be a problem but, as it turns out, 
the OS lens performs even better, turning in 
some of the lowest colour fringing test scores in 
the group. There are decent levels of sharpness 
throughout nearly the whole zoom range, only 
dropping off noticeably at the 300mm end. For 
dull-day shots, contrast is pretty good, and much 
better than with the Sigma APO lens. All in all, it’s a 
much better buy for the money.

y
ou’d normally reach for a telephoto zoom 
when you want to shoot distant objects, 
but this Sigma is also designed for close-
up work. In the 200-300mm zoom range, 

you can engage the lens’s macro switch which 
shortens the closest focus distance from 
150cm to 95cm, enabling a 0.5x maximum 
magnification factor. 

Other attractions include three SLD (Special 
Low Dispersion) lens elements intended to 
minimise chromatic aberrations, but it lacks optical 
stabilisation and the autofocus motor is a basic 
electric unit. The front element both moves out 
and rotates during focusing. At least build quality 
feels pretty robust and the lens barrel features both 
focus distance indication and an additional scale 
for magnification factor. 

performance
The Sigma APO turned in good results in lab tests, 
with respectable sharpness and reasonably low 
distortion. Aided by the SLD elements, colour 
fringing is also quite low throughout the zoom 
range. Autofocus speed from the electric motor isn’t 
quick, but it’s no slower than with the Canon lenses 
that feature ultrasonic motors. The lack of image 
stabilisation makes handheld shooting a challenge 
on Canon and Nikon bodies, although it’s less of an 
issue in Pentax or Sony versions of the lens, where 
you can use in-camera sensor-shift stabilisation. The 
Sigma APO’s main flaw is that it produces images 
with a marked lack of contrast in images taken 
under dull lighting conditions. 

OVERAll OVERAll
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IMAGE QUAlITY
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BUIlD QUAlITY

VAlUE

IMAGE QUAlITY

Tech focus…
With a 0.5x or 1:2 
magnification  
factor, a small object 
will appear at half life 
size on the image 
sensor. this enables 
massive enlargements 
when viewing images 
on screen or printing 
them out. 

Tech focus…
When using optical 
stabilisation on pentax 
or Sony bodies, you 
need to switch off the 
camera’s sensor-shift 
stabiliser, otherwise 
the two systems 
can end up fighting 
each other. 
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SONY 75-300mm 
f/4.5-5.6 
£195 

Bigger, better and more refined Cheap, but not overly cheerful 

TAMRON SP AF  
70-300mm f/4-5.6  
DI VC USD £340 

t
amron still offers one of the cheapest 
70-300mm zoom lenses on the market, at 
£135, but it’s a very basic and lacklustre 
affair. By comparison, this much newer 

design is stuffed with high-tech extras. It’s 
Tamron’s first lens to feature USD (UltraSonic 
Drive) autofocus. Matched only by the Nikon 70-
300mm lens in this group, this ring-type system 
gives super-fast and practically silent performance, 
along with full-time manual focus override. There’s 
a focus distance scale at the back end of the 
lens under a viewing window, and focusing is fully 
internal, so there’s no movement or rotation of the 
front element. 

Its heavy-duty build helps to keep things steady 
during handheld shooting, aided by Tamron’s 
four-stop optical stabiliser. Sadly, the stabiliser is 
omitted in the Sony-fit version of the lens. At least 
the Sigma 70-300mm OS gives Sony users the 
choice of using optical or sensor-shift stabilisation. 
Build quality feels robust, although the zoom ring 
feels a little jerky and there’s no weather seal on 
the mount.

performance
Lab tests are a little disappointing, suggesting a 
lack of sharpness and poor colour fringing control 
at the 300mm end of the zoom range. In practice 
however, fringing is normally only noticeable 
around extremely high-contrast edges towards 
the corners of the frame, like dark tree branches 
against a very pale sky. Image quality is still sharp 
and punchy at 300mm.  

t
his is the only lens apart from the Sigma 
70-300mm APO that manages to duck 
under the £200 barrier. Despite being 
more expensive than the Sigma, however, 

the Sony lens feels a lot more basic. It lacks the 
Sigma’s unusual macro facility or even a focus 
distance scale. Indeed, there are no switches at all 
on the barrel, so AF/MF switching has to be done 
via the camera body. 

Autofocus is based on a basic electric motor 
which is slow, noisy and causes unpleasant 
vibrations in the lens itself. By contrast, manual 
focusing is quite precise, although the focus ring 
is awkwardly situated right at the front of the lens. 
Focusing isn’t internal, so the front element rotates 
and moves out. Build quality isn’t great, reflected 
by the fact that this lens is the most lightweight in 
the group. 

performance 
Sharpness isn’t great at 70mm, peaks to a 
respectable level at 135mm, but then drops 
alarmingly at 300mm. Pincushion distortion  
is quite apparent in the longer end of the  
zoom range and, at 300mm, colour fringing is 
very noticeable. 

As well as its slow autofocus performance, 
there’s a lot of hunting in dull lighting conditions, 
and the lens often fails to lock onto targets. 
Overall, performance is disappointing and the Sony 
75-300mm is proof that it’s not always best to 
stick with the camera maker’s own-brand glass 
when buying lenses. 

OVERAllOVERAll

BUIlD QUAlITY

IMAGE QUAlITY

VAlUE

FEATURES FEATURES

BUIlD QUAlITY

IMAGE QUAlITY

VAlUE

Tech focus…
the front element of 
this lens is the smallest 
in the group. It has a 
correspondingly small 
filter thread of 55mm, 
whereas most 
competitors are 
between 58mm 
and 67mm. 

Tech focus…
tamron uses two 
ultrasonic autofocus 
classifications. uSd 
refers to ring-type 
systems, as used in 
this lens, whereas 
pZd (piezodrive) 
designates ultrasonic 
motors that drive 
autofocus through 
gearwheels. 
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IMAGE qUALITY IN FOCUS

There’s very little apparent distortion 
at any zoom setting. The 70-300mm 

beats Nikon’s 55-300mm 
 lens in this respect.

There’s a touch of colour fringing 
towards image corners at 300mm, 
but all Nikon’s recent and current 
bodies tune this out automatically. 

Despite disappointing lab results at 
300mm, sharpness and contrast are 
extremely good throughout the entire 

zoom range in real-world shooting. 

Image teSt VerdIct
Image quality is absolutely 
superb, and the Nikon does 
especially well to eke out every 
last drop of contrast under 
gloomy lighting conditions. 

NIkON AF-S 70-300mm 
f/4.5-5.6G ED VR 

70mm

70mm

22ISo200

Fairly low considering the extra-large 
zoom range, distortion is noticeable 
at mid-range zoom settings, where 
there’s some pincushion distortion. 

Chromatic aberrations are barely 
noticeable at any focal length 
throughout the zoom range,  

making it a strong performer.

Best at its shortest 55mm focal 
length, sharpness gradually  

reduces throughout the zoom  
range and is worst at 300mm.

Image teSt VerdIct
APS-C format cameras need to 
use the entire image circle of 
this lens, but, even so, corner- 
to-corner performance is 
particularly impressive. 

NIkON AF-S DX 55-300mm 
f/4.5-5.6G ED VR 

55mm

55mm

22ISo200

Barrel distortion is the worst in the 
group at 70mm, and there’s 

noticeable pincushion distortion 
between 200mm and 300mm. 

Not quite as poor as Canon’s non-IS 
75-300mm lens, but colour fringing  

is still often noticeable at the  
300mm end of the zoom range. 

Test results are excellent for 
sharpness at the centre of the 

frame, but less impressive towards 
the edges and corners of images. 

Image teSt VerdIct
The Canon 70-300mm hardly 
sets the world alight in terms 
of image quality, but 
sharpness at the centre of 
images is very good indeed. 

CANON EF 70-300mm 
f/4-5.6 IS USM 

70mm

70mm

22ISo200

Distortion is well controlled  
overall, and is the lowest in the 

entire group at the shortest  
end of the zoom range. 

There’s very little colour fringing at 
the shorter end of the zoom range 

but it can be quite extreme  
between 250mm and 300mm. 

Very good through most of the 
zoom range, but sharpness is 
disappointing at 300mm and 

hampered by a lack of stabilisation. 

Image teSt VerdIct
Sharpness drops off at 
300mm where colour fringing 
also becomes very noticeable, 
particularly towards the 
corners of the frame. 

CANON EF 75-300mm
 f/4-5.6 III USM 

75mm

75mm

22ISo200
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Image teSt VerdIct
The Tamron may not look 
super-special based on lab 
data, but real world image 
quality is excellent in all sorts 
of different lighting conditions. 

No glaring distortions at any focal 
length setting throughout the 

zoom range. Pincushion distortion 
is most noticeable at 300mm. 

Very high contrast edges near the 
corners of the frame produce a little 
colour fringing that’s noticeable at 

the longest zoom setting.

Plenty of contrast and, despite 
poor-looking resolution figures  

at 300mm, images appear  
very sharp and detailed. 

TAMRON SP AF 70-300mm 
f/4-5.6 DI VC USD 

700mm

70mm

22ISo200

Image teSt VerdIct
Sharpness could be better at 
edges and corners of the frame, 
especially towards the longest 
end of the zoom range, but 
overall image quality is good. 

Well controlled throughout the 
range, but the lens shifts from mild 
barrel distortion to slight pincushion 
distortion as focal length extends. 

Despite only having one SlD 
element, instead of the APO lens’s 
three, colour fringing is basically a 

non-issue at any zoom length. 

Outright sharpness isn’t as good as 
with Sigma’s cheaper APO lens, but 
in practice optical stabilisation helps 

produce sharper handheld shots.

SIGMA 70-300mm 
f/4-5.6 DG OS 

70mm

70mm

22ISo200

Image teSt VerdIct
The Sigma looks good on 
paper, but image quality is 
flawed by disappointingly 
low-contrast images in less 
than bright lighting conditions. 

There’s almost no distortion at all at 
70mm, although pincushion distortion 

is visible from mid-range  
to long focal length settings. 

Colour fringing is only an issue at 
300mm and, even then, you need 
some very high-contrast edges in 

scenes to make it a problem. 

Impressive, particularly at the 
centre of the frame through most  
of the zoom range, though there’s  

a bit of a drop at 300mm.

SIGMA 70-300mm 
f/4-5.6 APO DG MACRO 

70mm

70mm

22ISo200

Image teSt VerdIct
A lack of sharpness and 
noticeable colour fringing make 
this Sony lens’s image quality 
the least impressive of any 
lens in the group. 

There’s not too much in the way of 
distortion at any zoom setting. It’s 

only really pincushion distortion 
that’s noticeable at 300mm. 

Not too bad at wider and mid-range 
zoom lengths, colour fringing 

becomes a real problem at 300mm 
across most of the frame. 

Mediocre at 75mm, it musters a 
respectable level of sharpness in the 

middle of the zoom range, but is 
downright disappointing at 300mm. 

SONY 75-300mm
 f/4.5-5.6 

75mm

75mm

22ISo200
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the lab tests showed the two canon lenses had the edge when it came 

to sharpness. the scores produced by the canon lenses were followed 

closely by the nikon 55-300mm. When it came to centre sharpness at 

the widest focal length, the canon 70-300mm just had the edge over 

the canon 75-300mm, with the Sigma apo 70-300mm also doing well. 

distortion from all lenses was handled well, with the Sigma 70-300mm 

showing little sign of distortion wide angles. despite the sharpness 

performance of the canon 70-300mm, it suffered from the greatest 

degree of distortion at 70mm, but this was easily corrected when 

processing. Fringing was most noticeable in images taken with the Sony 

75-300mm and the canon 75-300mm at 300mm, while the least 

fringing was seen in the Sigma 70-300mm. the canon 70-300mm 

f/4-5.6 IS uSm came out top in the lab tests, despite issues with 

fringing at 300mm. 

Lens benchmarks
See how each lens performed in our lab tests

 0.18 1.47 3.18 

 0.5 0.28 2.42

 0.25 0.28 1 

 0.63 0.75 2.09

 0.28 0.27 1.04

 0.11 0.05 0.61 

 0.89 1.6 3.6 

 0.26 0.19 0.37

wide mid tele

FrIngIng  Low scores are better

Sigma 70-300mm 
f/4-5.6 DG OS

Sony 75-300mm 
f/4.5-5.6

Tamron SP AF 70-300mm 
f/4-5.6 Di VC USD

Sigma 70-300mm f/4-5.6 
APO DG Macro

Nikon AF-S 70-300mm 
f/4.5-5.6G ED VR

Nikon AF-S DX 55-300mm 
f/4.5-5.6G ED VR

Canon EF 70-300mm 
f/4-5.6 IS USM

Canon EF 75-300mm 
f/4-5.6 III USM

Shooting at f/8, we measured fringing in pixels at the centre point of 
each lens. The perfect result in this test would be 0%

hoW the 
lenSeS 
compare

Nikon AF-S DX 
55-300mm  
f/4.5-5.6G ED VR

Nikon AF-S 
70-300mm 
f/4.5-5.6G ED VR

Sigma 70-300mm 
f/4-5.6 APO DG 
Macro

Sigma 70-300mm 
f/4-5.6 DG OS

Sony 75-300mm 
f/4.5-5.6

Tamron SP AF 
70-300mm  
f/4-5.6 Di VC USD

contact www.canon.co.uk www.nikon.co.uk www.nikon.co.uk www.nikon.co.uk www.sigma-imaging-uk.com www.sigma-imaging-uk.com www.sony.co.uk www.tamron.eu.uk

price £240 £400 £290 £420 £180 £300 £195 £340

mount options         Sg      Sg      

Image stabiliser None 3-stop 4-stop 4-stop None 4-stop None 4-stop (   only)

autofocus motor Ultrasonic (motor) Ultrasonic (motor) Ultrasonic (motor) Ultrasonic (ring-type) Electric (motor) Electric (motor) Electric (motor) Ultrasonic (ring-type)

min focus distance 31cm 31cm 24cm 30.3cm 31.2cm 35cm 29cm 44cm

Filter size 58mm 58mm 58mm 67mm 58mm 62mm 55mm 62mm

Included accessories None None Hood, pouch Hood, pouch Hood, pouch Hood Hood Hood

dimensions (dxl) 71x122mm 77x143mm 77x123mm 80x144mm 77x122mm 77x126mm 71x122mm 82x143mm

Weight 480g 480g 480g 480g 550g 610g 460g 765g

FEATURES        

BUIlD QUAlITY        

IMAGE QUAlITY        

VAlUE        

OVERAll        

Canon EF 75-300mm  
f/4-5.6 III USM

Canon EF 70-300mm  
f/4-5.6 IS USM

SharpneSS  High scores are better

We measured sharpness by dividing line width by picture height to give a 
good impression of performance across the lens

2400300 1200900600 1500 1800 2100

Sigma 70-300mm  
f/4-5.6 DG OS

Sony 75-300mm 
f/4.5-5.6

Tamron SP AF 70-300mm
f/4-5.6 Di VC USD

Sigma 70-300mm 
f/4-5.6 APO DG Macro

Nikon AF-S 70-300mm 
f/4.5-5.6G ED VR

Nikon AF-S DX 55-300mm 
f/4.5-5.6G ED VR

Canon EF 70-300mm 
f/4-5.6 IS USM

Canon EF 75-300mm 
f/4-5.6 III USM
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dIStortIon  Closer to zero is better

Here, we measured distortion for each lens at an aperture of f/8. The 
perfect result would be 0%

-1

Sigma 70-300mm 
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Tamron SP AF 70-300mm 
f/4-5.6 Di VC USD
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f/4-5.6 APO DG Macro

Nikon AF-S 70-300mm 
f/4.5-5.6G ED VR

Nikon AF-S DX 55-300mm 
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F
or action sports and wildlife 
photography, which are food and 
drink for telephoto zoom lenses, 
you need speed. The ring-type 

ultrasonic autofocus system fitted to 
the Nikon 70-300mm is remarkably 
responsive, super-fast, practically inaudible 
and supremely accurate.  
 Couple this with an extremely effective 
Vibration Reduction system that easily 
lives up to its four-stop claims and 
features an ‘Active’ mode for enhanced 

and it also has a highly effective four-stop 
stabiliser. Its build quality isn’t quite as 
good as the Nikon lens’s, but it feels 
reassuringly robust nonetheless. It’s just 
a shame that Tamron took the decision 
to omit the stabiliser from the Sony-fit 
version of the lens, as we generally find 
that optical stabilisation works far better 
than sensor-shift systems, especially when 
used for telephoto shooting.  
 By contrast, Sigma includes stabilisation 
on the Pentax and Sony versions of its 
70-300mm OS lens, giving the choice of 
using optical or in-camera stabilisation.  
Compared to some of the latest lenses, 
both Canon models look a bit dated and 
lacking in features. Their optical quality 
isn’t particularly great either. The Sigma 
70-300mm APO and Sony 75-300mm are 
the also-rans of the group. 

anti-shake, and the Nikon looks a top 
performer. That performance is fully 
backed up by superb optical quality that 
delivers stunning images time after time.  
 By contrast, the Nikon 55-300mm is a 
bit of a poor relation, with its downgraded 
motor-driven autofocus system and single-
mode stabiliser. Even so, its optical quality 
is very impressive. 
 The Tamron 70-300mm is the only lens 
in the group to match the Nikon 70-
300mm’s ring-type ultrasonic autofocus, 

the dIgItal camera VerdIct

NIkON LEADS THE PACk  
It’s not just fancy features that put the Nikon  
70-300mm ahead. It simply takes the best photos

CANON EF 70-300mm £400
What’s good: Three-stop stabiliser works fairly 
well, good sharpness at image centre. 

What’s bad: Ultrasonic motor-driven auto- 
focus is sluggish, image quality could be better. 

our verdict: Better than Canon’s older 
75-300mm but not very good value for money. 

NIkON AF-S 70-300mm £420
What’s good: Superb image quality, super-fast 
autofocus, very good build quality. 

What’s bad: Doesn’t score very highly in lab 
tests for sharpness at 300mm. 

our verdict: Feels more like a pro lens than 
anything else here, but at a reasonable price. 

NIkON AF-S DX 55-300mm £290
What’s good: Extra-large zoom range, four-stop 
stabilisation, very good image quality. 

What’s bad: Autofocus speed is a little slow, 
noticeable distortion at middle of zoom range. 

our verdict: A good choice, so long as you’re 
not planning to move up to a full-frame camera. 

TAMRON SP AF 70-300mm £340
What’s good: Fast ring-type ultrasonic 
autofocus, four-stop vibration correction.

What’s bad: Could be sharper at 300mm,  
VC not available in Sony-fit version. 

our verdict: Serious technology and very good 
optics make this a great value buy. 

ZOOM lENS 
BEST BUYS
We recommend the 
best budget telephoto 
zoom lenses for each 
of the main camera 
brands on the market

SIGMA 70-300mm DG OS £300
What’s good: Four-stop stabiliser is available in 
each fitting option, including Pentax and Sony. 

What’s bad: It’s a shame Sigma didn’t fit its 
ring-type ultrasonic autofocus system. 

our verdict: A good buy at the price, especially 
for Pentax and Sony shooters. 



NEW

LO
OK

Six of the great new-look features you 
will find in your bigger & better  

Digital Camera magazine…

Take your camera skills to the next 
level with the world’s leading magazine 

for SLR & CSC users!

Britain’s best-selling 
photography magazine

60            D i g i ta l  C a m e r a        JULY 2016 

www.digitalcameraworld.com

why shots work

I m a g e  a n a ly s I s

A
d

ri
an

 D
en

ni
s

#3
Taking a diFFerenT view

research  and experimentation can yield great documentary results

a distinguished press 
photographer for the 
AFP agency in London, 
Adrian Dennis had to 
‘think different’ when 
covering the Queen as 

she inspected a cadet Guard of Honour 

at Berkhamsted School in this, her 90th 

birthday year. “Because many of the ‘royal boys’ 

[the photographers that make their living 

shooting these kind of events] had filled the 

main areas allocated to the photographers, 

I chose a different position,” Adrian explains. 

“I’ll usually try and do this if I’m allowed – 

mainly because I can’t see the point of 

shooting the same picture as 15 other guys, 

but also I didn’t necessarily think theirs was 

the best angle.” He had to park half a mile away and wheel 

all his photographic gear in, but he says the 

effort was worth it.http://portfolios.afp.com/photographer/

adrian-dennis.htmlthe eyes have it1   Not knowing exactly where he would be in 

relation to Her Majesty, Adrian lugged in three Canon  

SLRs and four lenses (24-70mm, 70-200mm, 

300mm, and 500mm). “I was adamant I was going to 

use the 300mm lens on my latest body, the amazing 

Canon EOS-1D Mk II. It’s a great combination: the 

autofocus and sharpness is incredible.” Earlier, 

Adrian had quizzed a cadet officer who told him the 

best place to stand. “The allocated photographers’ 

position was too head-on and wouldn’t lend itself to 

seeing the cadets in the background.”2   Being in a better position also enabled him to get 

the eye contact between the cadet and HRH. “I want 

my picture to give a clue to what the Queen is doing 

1

2on that particular day, whereas the ‘royal boys’ are 

looking for a timeless, ‘clean’ portrait of her. To keep 

everything sharp at 300mm, Adrian kept a high 

shutter speed of 1/2,000 sec at f/4, ISO 250. 
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Dried fl owers are 

creative fl owers, 

particularly with 

innovative lighting

LOndOn-based 

enthusiast 

photographer 

Polina Plotnikova 

is on a roll this 

year. Already she’s 

won a Food Photographer of the Year 

category and received a Commended 

gong in the Garden Photographer 

of the Year for her still-life work – 

including this image, ‘The Last 

Dance’. It’s a great example of her 

simple but highly creative approach 

to still-life photography in the studio. 

“This image is part of an ongoing 

project on dried fl owers,” she 

explains. “It’s an orchid – I love 

orchids – and I dried it out to reveal 

the interesting lines and shapes it 

makes when dead.

“I am very much a studio-based 

still life photographer. Other genres 

are fun, but this is the one that suits 

me best. If I can produce two images 

a month that I am happy with, that is 

great, although that might not seem 

particularly productive to other types 

of photographers.”

www.polinaplotnikova.com 
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1  “I shot the 

orchid against 

a Bowens softbox, 

placed behind it as 

backlighting. The 

background is just 

ordinary baking 

paper. I do 

sometimes use art 

paper from art 

shops, but this had 

such a nice, fi brous, parchment 

feel, with a lovely pattern.”

2  The second source of light is another 

Bowens fl ashlight, used with an umbrella in 

front. “In other words, the orchid is between 

two fl ashlights,” Polina explains. 

3  “Usually I know in advance whether 

I will convert an image into mono or not. 

I do also shoot in colour to be on the safe 

side. In terms of Photoshop, I did the 

minimum to this image – cropping, 

curves, correction, contrast,

sharpening, and the black-and-white 

conversion.”

lighting set-up

3

WB

AF SET

2

1
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  On your  
Video Disc
Here’s how to get the most from the packed disc that 
accompanies Sports & Action Photography Made Easy

Important
About copyright
Please note that all the images on your video 
disc are copyright. They are not ‘royalty-free’ or 
‘library’ images. They are supplied solely for 
your own private use, so you can work along with 
our tutorials. They must not be sold on, 
redistributed in any form (whether as-supplied or 
edited), made available on any server or website,  
or used for any commercial purpose.

224  Sports & Action Photography Made Easy

Digital 
Edition 

This digital edition does not include a disc  

like the print edition does. Instead, you  

can download your bonus  

videos and images via  

www.bit.ly/dc180bonus



 

Your free Video Disc includes step-by-step 
videos that will take you through practically 
every Photoshop tutorial in this book. You 
can listen and watch to see exactly how each 
image is edited and transformed – and you 
can read along on the accompanying pages in 
the book too, should you want. Furthermore, 
we provide you with all the ‘start’ images you’ll 
need to complete the step-by-step projects in 
this book. You’ll find our little ‘On the disc’ 
sticker on the page to remind you. Note that 
not all the tutorials in this book will be 
accompanied by source images: some don’t 
require our images to follow a project.

To access the files on this disc, first insert 
the DVD into your drive of your computer. 
Whether you’re using a Mac or a Windows PC, 
the disc should work equally well.
 
Getting going
The first item that should appear on your 
screen is the disclaimer window; here you’ll 
need to click on ‘I agree’. Please remember 
that this disc has been scanned and tested at 
all stages of production, but – as with all new 
software – we recommend that you run a virus 
checker before use. We also recommend that 
you have an up-to-date backup of your hard 
disk before using this Video Disc. Future 
Publishing does not accept responsibility for 
any disruption, damage and/or loss to your 
data or computer system that may occur while 
using this disc, or the data and programs on 

it. Consult your network administrator before 
installing software on a networked PC.

There are several video lessons along with  
their source files on this Video Disc, arranged 
in the order they appear in the bookazine. For 
your convenience, we have stored the videos 
and corresponding images together on the 
interface so you can access them as-and-
when you need them. See above for a guide  
to finding your way around the disc.

Our video tutorials are in Flash format and 
we recommend that you install the latest 
version of Adobe’s Flash Player, available free 
at www.adobe.com/flashplayer.

Questions and queries
If you have a query about using your disc’s 
interface or its content, please visit our reader 
support website at www.futurenet.com/
support, where you can find solutions to many 
common problems. In the unlikely event of 
your disc being defective, please e-mail our 
support team at support@futurenet.com 
for assistance. If you would prefer to talk to 
a member of our reader support team, you 
are invited to call 01225 822743, quoting 
disc reference ‘PMZ05 Sports & Action 
Photography Made Easy’ when you get in 
touch. (You’ll pay normal UK national call 
rates.) Please note that we can only provide 
basic advice on using the interface and disc 
content. We cannot give in-depth help on your 
applications, hardware or operating system.

Expert tip 
Starting the disc 
interface manually
If the disc interface doesn’t load 
automatically when you insert the disc, 
here’s what to do. 
PC users: Click on the Windows Start 
button and click Run. Now click Browse 
and go to the CD directory in My 
Computer. Look for a file called PMZ.exe 
and double-click on it. Click OK in the Run 
dialog, and the interface should open. 
Mac users: Double-click the disc icon 
to view its contents, then double-click 
‘PMZ.app’ to launch the interface.

1Welcome to the disc
After the disc interface launches and 

you’ve accepted the terms of use, you’ll be 
presented with this Welcome screen. Many of 
the chapters in this bookazine have their own 
tab; click on the tab to access the tutorials 
and start files covered in that particular 
section. There’s also a Support tab at the top 
right; click here for information on contacting 
our disc support team should you experience 
any problems. 

2Viewing the videos
After clicking your chosen tab, you’ll be 

presented with a pictorial list of tutorials in the 
same order in which they appear in the printed 
bookazine. Click on the tutorial of your choice 
and the video will launch in the main interface. 
Click the play icon to start the video and pause 
to stop it. You can also skip back and forward 
through the video by moving the slider. Once 
you’ve finished viewing the video, simply click 
the Back button to go to the main Videos tab.

3Accessing the images
All tutorial images are stored alongside 

their corresponding video. To the right of the 
video you will see an option called ‘Click here 
to download the start image for this tutorial’. 
Select this link and you’ll be asked to choose 
where to save the images to – we recommend 
the Desktop, for easy access. Once the files 
have downloaded, you can then open them 
the software specified in the associated  
video/printed tutorial.

How to… Use the disc interface

On your Video Disc

Sports & Action Photography Made Easy  225 

Digital 
Edition 

This digital edition does not include a disc  

like the print edition does. Instead, you  

can download your bonus  

videos and images via  

www.bit.ly/dc180bonus
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Your companion 
Video Disc

Here’s your jam-packed Video Disc with 2 hours of exclusive  
video guides and all the images you’ll need for our projects

For instructions and details of the disc contents, turn to page 224. 
To remove your disc sleeve without tearing this page, slide your finger under the 
disc sleeve from the top and gently ‘roll’ the glue loose. Repeat from underneath 

to release the second dab of glue if necessary.

If your disc is missing, ask your newsagent. If they can’t help, or if your disc is damaged, 
please email support@futurenet.com and we’ll be delighted to send you a replacement.

Digital 
Edition 

This digital edition does not include a disc  

like the print edition does. Instead, you  

can download your bonus  

videos and images via  

www.bit.ly/dc180bonus





Visit www.myfavouritemagazines.co.uk/photo 
for more information
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Like this? Then you’ll also love…

Sports & Action Photography is the 
all-in-one guide to shooting and editing 
great images that capture the energy of 
movement – in words, pictures & videos!

228 

pages plus 

2 hours  

of video!

Improve your sports and action images with our easy-to-follow 
guide to taking better shots of anything that moves!

2 great ways to learn!
reaD our GuIDes • waTCh The VIDeos
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